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1 Introduction

Le logiciel Aladin est un atlas interactif du ciel. Il permet aux utilisateurs de visualiser des
images digitalisées du ciel et d'y superposer des informations issues de catalogues ou de bases de
données astronomiques.

Aladin est distribué sous deux formes: une version allégée « Aladin Lite » destinée aux
navigateurs Web, et une version plus compléte « Aladin Desktop » pour un usage classique de
bureau. Ce manuel concerne Aladin Desktop uniquement.

Aladin Desktop permet d'accéder de facon interactive a la plupart des données images et
catalogues astronomiques fournis par les grandes agences, les centres de données, instituts et
projets locaux et notamment a Simbad/CDS, NED/NASA, VizieR/CDS, MAST/STScI/NASA,
CADC, SkyView/HEASARC/NASA, ESAC/ESA, JAXA, SDSS/SLOAN, SkyBot/IMCCE,
C’est-a-dire a la totalité des données disponibles dans ce que I’on nomme « Observatoire
Virtuel ».

Aladin est un logiciel dédié aux professionnels de 1’astronomie. Il peut étre également utilisé par
des enseignants, des étudiants, des amateurs. Il est gratuit, et le titulaire des droits est I’Université
de Strasbourg/CNRS (voir mention légale). Il a été traduit en plusieurs langues dont I’anglais, le
francais, I’italien, 1'allemand, l'iranien, le russe, le chinois, le japonais, 1’espagnol, ...

Aladin est couramment utilisé pour :
» La visualisation et la vérification des données images et catalogues ;
» L’exploration des données astronomiques disponibles ;
» La préparation de missions d’observations ;
» La génération de cartes de champs.

Aladin est développé par le Centre de Données astronomiques de Strasbourg (CDS). Il est
compatible avec la plupart des configurations informatiques de bureau et notamment Windows,
Linux et Mac. Il ne nécessite pas de ressources informatiques importantes a moins qu’il n’ait a
manipuler de tres grands catalogues (plusieurs centaines de milliers d’objets)

Créé en 1999, Aladin supporte les standards de I'International Virtual Observatory alliance
(IVOA) (ou « Observatoire Virtuel »), il est interconnectable avec d'autres outils de visualisation
et d'analyse (TOPcat, CASSIS, DS9, SPLAT,...). Tous ces points forts lui permettent d'étre un
puissant outil d'exploration et d'intégration de données.

L’adresse du site Web d’Aladin est la suivante : http://aladin.cds.unistra.fr.


http://aladin.cds.unistra.fr/

2 Installation

4 & 2 B8

Aladin.jnlp  Aladin.exe Aladin.dmg Aladin.tar

La méthode d’installation d’Aladin dépend de votre configuration matérielle. Dans tous les cas,
cela ne vous prendra que quelques secondes.
Installation

Aladin ne requiert que quelques mégaoctets d’espace disque pour son installation et 256
mégaoctets de mémoire vive suffisent pour la plupart des travaux.

Tout systeme
URL : http://aladin.cds.unistra.fr/java/nph-aladin.pl

Cette URL utilise la technologie WebStart propre au logiciel écrit en Java. Si vous avez déja
installé Java', un simple clic sur cette URL effectuera I’installation et le lancement de
1’application.

Note technique : Suivant votre systéeme de sécurité, il est possible que vous ayez a enregistrer le
fichier de lancement (extension « Aladin.jnlp »), puis a indiquer explicitement (généralement via
un menu contextuel bouton de droit?) que vous voulez ouvrir ce fichier avec « Java Web start ».

Alternatives spécifiques pour chaque Systéme d’Exploitation

Windows
URL : http://aladin.cds.unistra.fr/java/Aladin.exe

Si vous travaillez sous Windows, la méthode la plus rapide et la plus simple est de simplement
recopier le fichier « Aladin.exe » dans un de vos dossiers, ou méme sur votre bureau. C’est tout !
Ou presque... il n’est pas impossible que vous ayez a convaincre votre anti-virus qu'Aladin n’en
est pas un.

Mac
URL : http://aladin.cds.unistra.fr/java/Aladin.dmg

L’installation sous Macintosh se présente sous la forme d’un classique paquetage « dmg ». Vous
le téléchargez, vous l’ouvrez, et vous copiez le fichier « Aladin.app » dans votre dossier
« Application ». C’est tout! ou presque... Il vous sera probablement nécessaire d’autoriser

'http://www.java.com
’Dans le cas d’un Mac, il peut étre nécessaire de maintenir la touche Ctrl appuyée pour voir apparaitre le bouton de
lancement de I’exécution.
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I’exécution d’Aladin dans le centre de sécurité de votre Mac. Un rapide tour sur votre moteur de
recherche favori vous donnera la solution propre a votre systéme spécifique.

Linux et autres systemes Unix
URL : http://aladin.cds.unistra.fr/java/Aladin.tar

L'installation sous Linux se présente comme un fichier archive « tar ». Vous téléchargez le
fichier, vous décompactez les fichiers via la commande « tar xvf Aladin.tar » ou tout autre
utilitaire équivalent. C'est tout !

A noter : Aladin peut étre utilisé sur des données stockées localement. Cependant il est préférable
de disposer d’une connexion Internet, méme de faible débit (> 200Ko/s) pour pouvoir accéder
également aux bases de données astronomiques.

Pour plus de détails sur I’installation d’Aladin ou pour accéder a la derniere version en test,
veuillez-vous référer a la page Web suivante :
http://aladin.cds.unistra.fr/java/nph-aladin.pl?frame=downloading
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3 Prise en main

Pour vous donner un bref apercu des potentialités d’Aladin, voici un scénario typique de
visualisation de données images et catalogues autour d’un objet astronomique :

Lancement d’Aladin

Recherche d’une image astronomique de I’objet M51
Recherche des données Simbad autour de cet objet
Chargement du catalogue Gaia autour de cet objet
Visualisation des données (déplacement, zoom...)
Consultation des mesures et des données originales
Sauvegarde

A==

Nous allons suivre pas a pas ce scénario.

Lancement d’Aladin (1)

Le lancement d’Aladin dépend du type de configuration matérielle dont vous disposez. Sous
Windows et Macintosh, un double-clic sur I’icéne d’Aladin va démarrer 1’application. Sous
Linux et autres stations Unix, il vous sera peut-étre nécessaire de passer la commande : Aladin

& Aladin v12.0 = [m] >

File Edit Image Cstalog Overlay Coverage Tool View Interop Help =il=)

Available data — 29750 Frame [[@2&3
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Chargement des données (2, 3 et 4)

La méthode la plus simple pour charger une image d’un objet astronomique dans Aladin consiste
a cliquer dans le panneau central pour charger un fond de ciel — par défaut le DSS couleur - puis

Wl ENE M51 X




a indiquer le nom ou la position de 1’objet central dans le champ de saisie intitulé « Command ».
Dans notre exemple, il s’agit de « M51 ».

Pour choisir un autre fond de ciel que celui par défaut, il est
nécessaire d’ouvrir 1’arbre des collections des données (« Data
Discovery Tree ») qui est visible sur la gauche de la fenétre
Aladin, puis de double-cliquer sur le relevé du ciel désiré. Dans
I’exemple ci-contre, GALEX GR6/7 en couleur. De la méme
facon, vous pourrez charger les données Simbad depuis la
branche « Data base », ainsi que le catalogue Gaia dans la branche
« Catalog/VizieR/I-Astrometrical Data/Gaia DRS3.../Gaia DR3
Source... ». Au vu de la grande quantité de collections décrites
dans I’arbre, il est souvent plus pratique de simplement saisir un
mot clé dans le champ « select » en dessous de 1’arbre - par
exemple « Gaia» - pour ne garder dans celui-ci que les
collections concernées.

Available data — 29750

A chaque sélection d’une collection dans I’arbre apparait en
regard une fenétre proposant les différents modes d’acces
possibles. Le double-clic sur le nom de la collection dans I’arbre
est un raccourci pour utiliser le mode d’acces par défaut. Dans notre exemple, « dans la vue »
si mfle que les données ne seront chargées que sur le champ de vue courant.

=8 Gaia DR3 Part 1. Main source (Gaia Collaboration, 2022) - ... ... £

Année pub.réf. 2022 Nb de fg.: 1811 709 771

[] progressif ! [+] dans la vue par région &MOC [ par ¥match CDS [ custom [ par critéres TAP
[]sSMOC couv. [ ] carte de densité
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Visualisation des données (4)

La visualisation des données se fait dans la fenétre principale d’Aladin. Elle se compose
principalement de 4 éléments :

1. L’arbre des collections (« Data
tree ») : affiche 1’ensemble des
collections de données disponibles
(>20 000 collections d’images, de
cubes, de catalogues).

2. La pile («Stack»): présente
I’ensemble des données chargées
sous forme d’un empilement de
« plans ». L’ceil de 1’observateur
se trouve en haut de la pile et va
voir «en transparence »
I’ensemble des plans activés.

1. La vue (« View »): affiche la
portion de I’image visible en
fonction des plans de la pile et du
zoom et superpose a cette image des symboles graphiques correspondants aux objets
astronomiques des tables et catalogues chargés.

) 303D Uniarwind dp GaraabauraiCNR - cevelucssd by (06, ALL RAGHT RERERVED Tosslraizian D B



2. Les mesures (« Measures »): affiche les parametres des objets astronomiques
sélectionnés dans la vue au moyen de la souris (magnitude, parallaxe...)

Activation dun plan : L’activation ou la désactivation
d’un plan se fait en cliquant sur le logo de chaque plan de la : aiz
pile. Il est également possible de modifier la transparence VGRE/AIS ol
de ceux-ci au moyen de la petite réglette en bas de chaque
logo. Enfin la permutation des plans via la souris (cliquer/glisser/déposer) permet de changer
’avant-plan afin de faciliter la lecture de la vue.

Réglage du zoom : La maniére la plus immédiate d’ajuster le coefficient du zoom consiste a
utiliser la molette de la souris en ayant le pointeur de la souris positionné « dans la vue ». Si vous
ne disposez pas d’une souris a molette, vous pouvez utiliser la réglette juste au-dessous de la pile.

Centrage sur un objet particulier : Le centre de la vue fait
apparaitre un réticule (petite croix de couleur magenta). La méthode
la plus simple pour pointer et zoomer sur un objet particulier consiste
a placer le réticule sur 1’objet en question (par un simple clic souris),
puis a zoomer au moyen de la molette de la souris. La vue va
automatiquement se centrer sur 1’objet.

Consultation des mesures et données originales (6)

La vue fait apparaitre en superposition de 1’image les objets issus des catalogues et des tables —
dans notre exemple Simbad et Gaia. Chacun de ces objets peut étre sélectionné au moyen de la
souris, soit en cliquant dessus, soit en les englobant dans un rectangle de sélection (cliquer hors
de tout objet — déplacer — relacher).

Les objets sélectionnés apparaissent entourés d’un petit carré vert. Les mesures qui leur sont
associées s’inscrivent sous forme d’une table dans le panneau des mesures. Certaines valeurs
apparaissent soulignées en bleu comme un « lien Web » .

En cliquant sur un des liens, Aladin ouvrira votre navigateur et affichera des informations
additionnelles. Le premier lien est généralement utilisé pour afficher 1’enregistrement complet
original, dans notre exemple 1’enregistrement Gaia de la premiére source fourni par le service de
catalogues VizieR.

La sauvegarde (7)

Aladin propose plusieurs options de sauvegardes afin de conserver la vue courante sous forme
d’une image ou d’un fichier pour une publication scientifique, etc. Par le menu « Fichier =>



Enregistrer la vue courante => PNG » vous obtiendrez un fichier image correspondant a la vue
courante facilement utilisable dans la plupart des outils bureautiques.

Apres cette découverte rapide de 1’outil, voyons plus en détail les possibilités de traitement
qu’offre Aladin.

4 Apercu des possibilités de traitement

Aladin travaille principalement
sur 3 types de données: des Image &
images, des catalogues et des
surcharges graphiques qu’il
visualise dans une ou plusieurs
«vues ». Pour chacun de ces
éléments, Aladin dispose d’une
série d’outils.

Catalog

Définitions au sens R
d’Aladin Graphi cal

» Une image astronomique ove F|a_‘\/-
représente un champ de vue )
du ciel. L’image
astronomique est généralement fournie avec des informations relatives a son origine et a sa
calibration (position dans le ciel, taille du pixel, type de projection,...). Aladin supporte deux
types d’images
astronomiques. Celles issues
d’un tableau rectangulaire
de pixels au sens classique

d’une image, mais
également les  images
astronomiques générées

dynamiquement a partir
d’un « relevé progressif » ou HiPS pour Hierarchical Progressive Survey ;

» Un catalogue astronomique est une table, ou plusieurs tables, dont chaque ligne représente
des informations sur un objet ou « source » astronomique (identificateur, position dans le ciel,
caractéristiques physiques...). De maniere similaire aux images, Aladin supporte non
seulement les tables c1a551ques mais également les tables generees dynarmquernent a partir
d’un HiPS catalogue ; - :




Nous allons

Une collection de données (« data collection ») est un ensemble homogene de données
(images, tables, spectres, etc ) regroupées sous un unique titre et accessible de maniere
homogeéne ;

Une couverture représente la région couverte par
une collection de données. Elle est représentée par
un MOC pour Multi-Order Coverage map. Un MOC
peut non seulement décrire une couverture spatial,
mais également temporelle, voire les deux
simultanément ;

Une surcharge graphique (« graphical overlay ») est un ou plusieurs éléments graphiques
(trait, cercle, polygone...) auxquels sont associées des positions dans le ciel ;

Une vue (« view ») est une projection d’une portion d’une image sur laquelle peut étre tracés
des symboles associés a chaque source des catalogues et/ou des surcharges graphiques ;

Les coordonnées dans le ciel sont classiquement un couple d’angles (R4 — ascension droite,
DEC — déclinaison)® permettant de se positionner sur la sphére céleste. Aladin ne manipule
pas la notion de distance a 1’observateur, uniquement la représentation sur la sphere céleste.
Une date représente sans surprise un moment déterminé dans 1’échelle du temps.

brievement décrire les différentes Image

opérations qu’Aladin offre pour manipuler les images,
les catalogues, les surcharges graphiques et les vues. Loupe Ctrl+G

Contraste des pixels... Ctrl+M

Opérations sur les images

Aladin  gere  plusieurs  catégories  d’images
astronomiques : en couleur ou en niveau de gris, en
prévisualisation ou en acces aux vraies valeurs des
pixels, de petite ou grande taille de I’image, et s’il
s’agit d’'une image classique ou d’un HiPS. Suivant la
catégorie, différentes opérations seront ou non
possibles.

Table de pixels

Mesure photométrique

Graphe de coupe

Créer une image RVE...

Convertir I'image RVB en niveaux de gris
Créer une image mosaigue...
Créer une image séquence animee...

Extraire un spectre d'un cube...

Rééchantillonner...

P . Calibration astrométrique...
Les opérations les plus courantes sont les suivantes :

» Ajustement de la dynamique des pixels
(contraste) ;

» Mesures photométriques par polygones ou
cercles ;

» Opération de rotation, et de symétrie (haut / bas,
droite / gauche) ;

» Génération d’images composites (couleur a
partir de 2 ou 3 autres images, de mosaiques, de
cubes, ...);

» Rééchantillonnage d’une image en fonction de la solution astrométrique d’une autre
image ;

» Calibration astrométrique d’une image (par parameétres ou par correspondance sur un
catalogue ou une autre image) ;

Symétrie

Opérations arthmeétiques...
Convolution...

Mormalisation des pixels (div. by avg)
Conversion Bitpix...

Extraction des pixels...

Dupliquer le plan image

Extraire une portion de l'image...

3ou bien « Longitude » et « Latitude » suivant le référentiel spatial utilisé.
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» Calcul sur les pixels (addition, soustraction, multiplication, division, convolutions,
normalisation) ;

» Extraction d’une sous-image ;

» Etc.

Opérations sur les catalogues

Catalogue

de Crée un graphe de points, une série temporelle

Aladin gére deuX types Corréler les catalogues sélectionnés
catalogues : les catalogues « HiPS », Ajouter une nouvele colonne..
cad dont les sources vont étre s i}
téléchargées au fur et & mesure en cracnerdons s coslogues harass et

Alt+U

Créer un nouveau filtre...

fOl'lCtiO[l de la taille du Champ de Filtres prédéfinis t Dessine des cercles proportionnels 3 la luminosité des objets
. . : - . | Affiche uniquement les objets brillants (magnitude < 12}
vue, ou les tables ClaSSIqueS' SUlVant Fusionne les catalogues sélectionnés en un plan... T e s (i 7
, . s, , . Crée un nouveau plan avec les objets sélectionnés )
la catégorie, différentes opérations S et e pes d objes ,
nformation sur les colonnes... Trace le mouvements nranres des étailes

seront possibles, notamment :
» Manipulation des mesures associées aux sources (sélection, filtrage, tri, pointage....) ;
» Paramétrage de la représentation graphique des sources en fonction des valeurs des
mesures (ex : cercles proportionnels a la magnitude, fleches de mouvement propre,
ellipses d’erreur....) ;

» Corrélation des sources de deux catalogues ;
» Tracage d’un graphe de nuage de points sur deux grandeurs d’un catalogue ;
» Calcul de nouvelles colonnes de mesures ;
» Génération de sous-tables ;
Graphigue
Opérations sur les surcharges graphiques JEEE L T

. . . L dist - Outil de calcul de dist Alt+D
Aladin manipule plusieurs catégories de surcharges oo aRrse e dnes A

graphiques. Suivant cette catégorie diverses opérations sont
possibles :

» Extraction de contours ;

» Outils graphiques de mesures (photométries,

phot - Mesures photométriques
deszin - Dessin @ main levée
marg - Positicnnement de repéres

spectre - Extraction depuis un cube

distances) ; Créer un nouveau plan "Drawing”  Alt+N
» Outil de positionnement de marques (balises) ; v Info Alt+0
> Tragages a main levée s Table des couleurs Alt+R
» Surcharges de texte ; Fléche de la cible AltsT
» Graphes de coupe de I’image le long de segments de Constellations Alt+C

droite ou dans la 3°™ dimension dans le cas d’un _ )

be Grille de coordonnées Alt+G

cube. , ) ; Grille HEALPix Alt+W

» Superposition d’une grille de coordonnées, ou des o
A ans grille

constellations ;

» Déplacement, rotation. e

Réticule large

Sans réticule

Opérations sur les couvertures

Aladin manipule les couvertures sous la forme de MOC (« Multi-Order Coverage »). Il s’agit
d’une méthode permettant de décrire une couverture spatiale (cad une région du ciel
éventuellement complexe), ou une couverture temporel (cad une liste de périodes temporelles),
soit les deux simultanément. Cette technique permet d’opérer des opérations logiques (unions,
intersections, etc) de maniére extrémement efficace et rapide.
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Pour obtenir le MOC d’une collection de données, soit celui-ci a été précalculé et il s’agit
simplement d’y accéder sous la forme d’un produit dérivé de la collection, soit Aladin peut le
générer depuis la collection elle-méme, qu’il s’agisse d’images, de source de catalogues.

Couverture
| Chargement de la couverture (MOC) du relevé courant

Chargement pour d'un MOC specifique...

Génération d'un MOC spatial 3 partir de... b Des objets sélectionnés
Génération d'un MOC ternporel 3 partir ... b Des catalogues sélectionnés...
Generate a Space-Time MOC based on ... > L'image courante, la carte HEALPix ou le HiP5...

A . Une collection d'images...
Opérations logiques...

. i . La carte courante de probabilités...
Ajustement de la résclution...
Du MOC spatio-temporel actuel

Filter a table by MOC... Un découpage rectangulaire...

Aide & propos des MOC...

Opérations sur les vues

» Superposition des catalogues, surcharges graphiques et éventuellement surcharges
d’autres images par semi transparence ;
» Zoom et déplacement ;

Vue
> Visualisation de plusieurs vues cote a cote (2,4,9 ou —
16 vues simultanées) ; Plein €cran FIT
> Synchronisation de vues (méme échelle, méme Lzl -
orientation) ; Irmage suivante Tab
» Génération de vues « temporelles » ; Cadres
» Génération de vues «vignettes » autour d’objets
intérét ; Créer une vue par image g
d’intérét ; p g F
» Visualisation plein écran. Supprimer les autres vues
Supprimer toutes les vues verrouillées
. . . Vue verrouillée
Ces différentes opérations sont réalisables au moyen d’une
interface graphique classique. Comme habituellement dans Filtre temporel
ce type de logiciel, plusieurs alternatives sont Créer une vue temporelle
proposées répondant aux différentes habitudes de travail : ,
A Mord en haut, Est 3 gauche
1. la barre de menu en haut de la fenétre ; o
Uniformiser I'échelle Alt+5

1. les barres d’outils (listes de boutons a cliquer) ;

2. des menus contextuels accessibles par clic droit ou
CTRL clic (Mac) ;

3. des raccourcis clavier (combinaison de touches).

Unifarmiser I'échelle et I'orientation  Alt+0)

A noter : il est également possible de réaliser ces opérations par des commandes scripts qui sont
décrites a la fin de ce manuel (cf. 7.1)

Nous allons découvrir plus en détails les différents éléments qui composent cette interface
graphique, leurs modes de fonctionnement, etc.

12
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5 L’interface graphique dans le détail

Aladin offre une interface graphique riche et sophistiquée permettant de réaliser en quelques clics
la plupart des fonctions de bases. La fenétre principale concentre 1’ensemble des fonctions pour
la sélection et la visualisation des données :

» L’arbre des collections des collections de données ;

» Laoules vues;

» La pile;

» Le panneau des mesures.

Plusieurs autres fenétres permettent divers controles, dont les principaux sont :

VVVVVVVVVVVYY

Le controle de la dynamique des pixels (contraste) ;
L’extraction de contours ;

L’édition des filtres appliqués sur les catalogues ;

Le calcul des corrélations entre catalogues ;

Le calcul et I’ajout de nouvelles colonnes sur les catalogues ;
Le contréle de la calibration astrométrique ;

Le controle du rééchantillonnage d’images ;

Les opérations arithmétiques sur les images ;

La génération de HiPS (relevés progressifs) ;

La génération de MOC (couvertures spatiales et/ou temporelles) ;
Les sauvegardes ;

La gestion des préférences de I’utilisateur (configuration) ;
La console de commandes pour I’utilisation du mode script.

Nous allons maintenant passer en revue les différents éléments de I’interface, présenter leur role,
leurs interactions...

5.1 La fenétre principale

Aladin regroupe dans une unique fenétre la plupart des éléments nécessaires a la sélection, la
visualisation et a I’exploitation des données. Elle integre une barre de menu, un arbre des
collections des données sur la gauche (« data discovery tree ») et son systéeme de filtrage
(« Filter »), un bandeau de commande, des barres de boutons (« toolbox ») et des réglettes
d’ajustement (« sliders »), au centre le panneau principal des vues (« views »), la pile a droite
(« stack ») surmonté d’une zone d’information, un panneau en bas pour les mesures
(« measures ») et un panneau multi-usage en bas a droite (« Graph »).

14
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Astuce : Les proportions relatives des différents éléments peut étre modifiées au moyen de la
souris lorsqu’elle est située a la frontiere des différents panneaux. Lorsque le curseur affiche le
symbole associé au changement de proportion, cliquez/déplacez/relachez pour modifier les tailles
respectives des panneaux. Ces proportions seront reproduites d’une session a I’autre.

Visite guidée

Menu : Aide => Visite guidée d’Aladin...
Raccourci:  F1

Pour aider a la découverte de la fenétre principale, Aladin vous suggere une « visite guidée » que
vous trouverez dans le menu « Aide ». Une fois la fonction activée, utilisez votre souris et
survolez les différents éléments de la fenétre principale pour faire apparaitre une description du
composant pointé.

5.1.1 L’arbre des collections

L’arbre des collections des données (« Discovery Data Tree ») permet la découverte, la
visualisation, I’exploration, le tri, le filtrage et enfin le chargement de I’ensemble des collections
des données disponibles et compatibles avec Aladin. Ainsi, cet arbre contient la description de
plusieurs dizaines de milliers de collections issues des différentes agences et archives
astronomiques, centres de données — et en premier lieu le Centre de Données astronomiques de
Strasbourg — de projets de recherche, etc. Ceci représente la quasi-totalité des données
astronomiques publiques disponibles via Internet.

15



B Collections La structuration de cet arbre est dynamique. Elle est
fonction des données disponibles et de la responsabilité
éditoriale du Centre de Données de Strasbourg, notamment
pour l’ordonnancement de ses diverses branches.
Actuellement, le premier niveau de branches se subdivise en
3 catégories : en jaune les collections retenues et triées par
Radio le CDS, en bleu toutes les autres collections.

Gasdines Les branches jaunes sont hiérarchisées par le CDS selon
trois criteres: 1 - par types de données: « Image »,
« Catalog », « Cube », 2 — par serveurs spécifiques trés
utilisés : « Data base », et 3 — destiné a la vulgarisation :
« Qutreach ». Chaque collection au sein des branches jaunes
n’apparait généralement qu’une seule fois selon la sélection
du CDS.

Les branches bleues reprennent la subdivision par type de
données, puis par serveurs d’origines. Une méme collection
(ou similaire) peut apparaitre plusieurs fois car fournie par
plusieurs centre de données simultanément. A I’utilisateur
de vérifier et de choisir la meilleure origine suivant son
besoin.

L’ouverture ou la fermeture des branches s’effectue par le
petit triangle sur la gauche de chaque ligne. Celui-ci opére
sur un seul niveau de profondeur contrairement a 1’action
sur 1’icone situé en dessous de I’arbre qui déploiera ou repliera la branche concernée dans la
totalité de sa profondeur IEEl. D’autre part, I’ordre d’apparition des branches ainsi que des
collections peut étre modifié au moyen e I’icéne de tri situé sous 1’arbre Hl, soit globalement,
soit pour une branche particuliére en fonction de la sélection courante.

Accés rapide Fichier
. . . . . Relevés images... Ctrl+!
Le menu principal « Fichiers» permet d’ouvrir et =
y , . R . R Baszes de données (Simbad, MNED, ...} Ctrl+D
d’accéder directement a certaines branches spécifiques de -
Catalogues (VizieR, ...) Ctrl+T

I’arbre des collections. Ce menu offre également 1’acces
au mécanisme de filtrage de cet arbre.

Relevés cubes...

Rechercher une collection de donnée... Ctrl+E

Filtrer les collections disponibles...

Filtrage de I’arbre

La méthode la plus efficace pour retrouver une collection particuliére consiste a filtrer I’arbre des
collections, soit par un mot clé, soit par des contraintes plus complexes prenant en compte les
diverses propriétés connues pour cette collection.

. L , N
Le petit formulaire situé sous I’arbre permet d’activer |-

ces fonctions de filtrage. Deux niveaux de filtrage
peuvent étre utilisés. Le plus simple consiste a saisir un
mot clé dans le champ « sélect. ». L’arbre fera désormais uniquement apparaitre les collections
correspondantes au mot clé saisi. Le nombre de ces
B Collections collections pour chaque branche s’affiche sur la droite de
E chaque ligne, et la totalité des collections retenues apparait
au-dessus de ’arbre.

—toutes les collections —
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Pour réaliser un filtrage plus poussé, il est nécessaire de
créer une « regle de filtrage dédiée » au moyen de 1’icone

LEL — toutes les collections —
— toutes les collections —
Colar surveys

Large catalogs
Log missions

situé a droite du formulaire [ZE. Ces regles pourront étre
sauvegardées et réutilisées d’une session a ’autre au
moyen de la liste déroulante qui suit le champ « dans » du
formulaire. La création de ces regles de filtrage est décrite
en détail dans la section 5.4 - Le filtrage de 1’arbre .

L’ic6ne « filtre » en bas a droite est de couleur verte lorsqu’une régle de filtrage est active. Un
clic sur cette icOne supprime son action et restitue 1’arbre dans son état original.
filtre

Tri de I’arbre

Un petit logo permet de trier 'arbre suivant différent criteres. La représentation du
petit logo apparait sous l'arbre, mais aussi dans la fenétre d'acces. Elles font presque la
méme chose, mais pas tout a fait.

Celle de tout en bas est général pour tout I'arbre, et donc limité aux propriétés
globales triables.
4 En revanche celle de la fenétre d'acces s'applique a la branche concernée , et
permet souvent plus de tris. VizieR est un bon exemple car ils est possible de trier
par popularité, voir I’exemple ci-dessous :

Collections sélectionnces: 23349
| Vunion [ ] Pintersection

®  Default Chmre
Regime
Sime

Populaty

k!

L
L4
r
r
L
L
r
| 3
4
v
r

Date
Coverage

ldentifier

La fenétre d’accés (« Access window »)

La sélection d’une feuille de I’arbre au moyen de la souris permet de désigner une collection
particuliere. Apparait alors en regard la « fenétre d’acces » de la collection retenue. Celui-ci
fournit un bref descriptif (titre, description, propriétés de couvertures, volumes, ...) ainsi que
I’ensemble des différents moyens d’acces a cette collection et a ses produits dérivés tels qu’une
carte de densité, une couverture spatiale (MOC) ou d’autres collections associées.
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Tycho-2 Catalogue (Hog+ 2000) - The Tycho-2 main catalogue... ...
Fro
Con

5% Année pub.ref. 2000 Nbdefig.: 2539913
[ progressif par céne par région &MOC par ¥match €05 [] par aitéres TAP
[15MOC couv. [ carte de densité

Charger @ B L_-] 0 =

Note : Le survol par la souris d’une autre entrée dans 1’arbre fera dynamiquement évoluer le
contenu de la fenétre et sa position sur 1’écran pour rester en regard a droite. Si vous souhaitez
temporairement suspendre ce comportement afin de pouvoir conserver le contenu et déterminer

s

manuellement sa position, cliquez sur I’icone « épinglette » en bas a droite

Raccourci : Le mode d’acces le plus logiquement utilisé étant déja pré-coché c’est celui-ci qui
sera choisi en cas de double-clic direct sur la feuille de 1’arbre.

Certains modes d’acces nécessitent des informations supplémentaires pour pouvoir charger les
données. Ce peut étre la désignation du champ de vue (« par cone »), la sélection d’une région
particuliere ou d’un MOC spécifique (« par région ou MOC »), la pré-sélection d’une autre table
(« par Xmatch CDS »), voire la saisie de criteres particuliers (« par critéres » ou « custom »). La
boite de saisie qui apparait lorsque la coche « par cone » est sélectionnée permet notamment de
désigner le champ de vue concerné en indiquant ’objet astronomique (ou la coordonnée
long/lat), ainsi que le rayon du cone d’interrogation. Par défaut cette boite reprend le cone
couvrant le champ de vue courant. Il est
cependant possible de modifier ce défaut, soit P
en saisissant directement au clavier la cible et []couverture [ Jcarte de densite

le rayon souhaités, soit en utilisant 'icone .gor | (2045 36.32547 430 43 55.1662 3. 145 &

«cible» €. Vous pourrez ainsi désigner
directement dans la vue au moyen de la souris (cliquer/glisser) le cercle de la requéte (cf. 5.2.1).

par région ou MOC par ¥match CDS [ ]

Note : Certains parametres sont prédéfinis de maniere permanente, mais peuvent étre modifiés
temporairement pour la session Aladin en cours via 1’icone O .

Lors d’une désignation multiple dans ’arbre des collections, soit en sélectionnant plusieurs
feuilles (touche CTRL et/ou MAJ activée), soit en sélectionnant une ou plusieurs branches, le
formulaire présente les modes d’acces et produits dérivés collectifs pour les collections
désignées. Il peut étre par exemple possible de demander 1’union ou [I’intersection des
couvertures spatiales des collections sélectionnées.

HST-B indudes the following filte

H5T-5D55g incudes the following Selected collections: 3 x
WV indudes the following filte CD5HF,
E Load ,?
s the fo aq

indudes the ’rn:nlin:n'.-'-.'irul_
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Repérage des collections présentent dans le champ de vue

Le chargement de données active la vue d’Aladin et entraine de ce fait la coloration automatique
de certaines feuilles et branches de 1’arbre -

en vert ou en orange. Ce code de couleur
indique quelles sont les collections de
I’arbre qui disposent (couleur verte) ou non
(couleur orange) de données dans le champ
de vue courant (spatialement et/ou

temporellement).

ry
L’activation de l’icone « vue » I en

dessous de 1’arbre permet de cacher
temporairement les collections qui ne
disposent pas de données dans le champ de
vue (couleur orange). La modification du
champ de vue en zoomant ou en se
déplacant a une autre position se répercutera
au bout d’une ou deux secondes sur I’arbre.

Note technique : Cette fonctionnalité s’appuie sur la disponibilité d’une description de la
couverture de chaque collection sous la forme d’un MOC. Celle-ci n’est malheureusement pas
toujours existante. Les collections n’en disposant pas apparaitront toujours en couleur blanche et
ne pourront étre filtrées. Un petit symbole d’alerte vous y rendra attentif.

Pour pallier ce probleme, Aladin peut générer temporairement et uniquement sur le champ

de vue courant les MOC manquants au moyen de la petite icne « scan » en dessous de
I’arbre, et ceci apres avoir sélectionner les collections concernées. Cette opération est lourde car
elle interroge réellement les serveurs de ces collections. Elle ne peut donc étre utilisée que sur un
nombre limité de collections et sur un champ de vue relativement petit.

5.1.2 Lapile

La pile (« stack ») représente 1’ensemble des données charg
affichées dans une vue. La pile est structurée comme u

plan entraine 1’affichage d’information decrlvant le plan d
Simultanément, s’il s’agit d’une image classique, le champ de vue correspondant peut s afflcher
temporairement en superposition de la vue courante.

Pile et vue associée

Dans le cas le plus simple, la pile ne contient qu’une image avec quelques plans catalogues et/ou
surcharges graphiques centrés sur la méme zone du ciel. Il est alors possible de créer une vue
affichant I’image et les symboles graphiques en superposition.
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Pour créer une vue pour un plan, il y a deux méthodes :
> Soit en cliquant sur la coche ¥ a gauche du logo du plan ;
> Soit en « cliquant/glissant/déposant » le logo du plan depuis la pile vers la vue.

L’activation d’un autre plan dans la méme vue se fait en cliquant sur son logo & . La
proportion de grisé dans le logo indique le niveau de semi-transparence. Lorsque le logo est
totalement grisé, le plan est totalement activé.

Astuce : 11 est possible de créer une vue uniquement basée sur un plan - catalogue, sans image de
fond. Pour cela vous devez utiliser la méthode de création de la vue par
« cliquer/glisser/déposer » décrite ci-dessus.

Un autre plan image du méme champ pourra étre inséré dans la pile afin de comparer ces deux
images, soit par semi transparence (voir section correspondante), soit alternativement en cliquant
sur la coche de I'une puis ’autre image, soit encore en créant un plan composite (fausses
couleurs ou plans alternants (blink)).

Il est également possible de charger simultanément dans la pile des plans images et/ou catalogues
ne concernant pas la méme position dans le ciel. La visualisation des deux zones du ciel pourra se
faire soit alternativement en activant ’un puis I’autre des plans images concernés, ou
simultanément en utilisant plusieurs vues affichées c6te a c6te (cf. 5.1.3).

Structuration hiérarchique

Afin de faciliter I’organisation de la pile, il peut étre souhaitable de regrouper certains plans au
sein d’un dossier, voire d’un sous-dossier. La création d’un dossier se fait soit par le menu
principal « Edition », soit en utilisant le menu contextuel de la pile (clic droit ou CTRL clic).

Cacher
Menu ConteXtUEI Réticule sur la position initiale du plan

Parcourir les objets du plan

La pile dispose d’un menu contextuel accessible en utilisant le A

Sélectionner tous les objets des plans sélectionnées

pour Mac). Ce menu regroupe 1’ensemble des fonctions spécific — peselectionnerles objets !
par exemple leur suppression, ou encore 1’affichage de leurs proy  crée un grsphe de points

Crée un nouveau plan avec les objets sélectionnés

7~ - S
Sélection e
_'.r.‘r.‘lll’nEI E_-r.‘ ans vIides/ errones
L . , . . . Supprimer tous les autres plans
La sélection d’un plan dans la pile se fait en cliquant sur son  s,pprimertous s plans )
(activation du plan). Le plan sélectionné apparait avec un Créer s motavemis i e ple 2

sélectionner plusieurs plans simultanément en maintenant la tC insererles plans sélectionnés dans un nouvesu dossier |
s’agit d’un groupe de plans consécutifs. Certains éléments d "= dosersclectionns 1
Envoie a toutes les applications SAMP
Envoie les tables sélectionnées ... 4
Envoie les images sélectionnées a ... )
Fusionne les catalogues sélectionnés en un plan...

Information sur les colonnes...

Propriétés..,



contextuel, ainsi que les boutons de la barre d’outils seront activés ou au contraire inhibés en
fonction de la nature du ou des plans sélectionnés. Par exemple s’il s’agit d’un plan image, le
bouton « contour » sera activeé.

Propriétés
Bouton : prop. :;
Menu : Edition > Propriétés
Raccourci : Ctrl + Entrée
Script : set..., status ...

’ . e 5 . . e -
L’affichage des « propriétés » d’un plan se fait soit L meks 060

Propriétés du plan "CDS/1/350/gaiaedr3" ~

par le bouton « prop. », soit par le menu principal

. PlandiD: [CDS/I/BSO/gaiaedr3|
« Edition => Propriétés » soit encore par le menu _ | T SRR =]
contextuel de la pile (clic droit ou CTRL clic). La LLLLLELTTEL
N ., L N 1 f . 1 AV Forme par défaut: |microdot L=
fenétre qui s’ouvre présente a la fois les propriétés P
génériques: nom du plan Origine des données.” https./fvizier.u-strasbg fr/viz-bin/votable? source=[92F 35092
K I > 8 R N T Fgaiaedr38-c=22+47+36.7632000+92058 +03+02. 988000&-0ut. ade-
mais egalement les propriétés spec1f1ques a la : J_DEJ8o¢ Form=dmé-out meta=Dhil &-out.max=9999958-c rm-=87
~ , &-out= VizieR, *Mime(image/fits), *&-mime=TSV&
nature du plan. Cette fenétre permet également de ‘
o . L . able Information sur les colonnes... Rapport techn...

modifier certaines de ces propriétés. Par exemple il
sera possible de changer le symbole graphique “* 2000 machoch | Aeses
utilisé pour tracer les sources d’un catalogue ou o
encore d’ajuster I’angle de rotation d’un champ de 1700800900002 02202300
vue instrumental. La fenétre des propriétés permet o
, . . . . 5 Facteur d'échelle i
également de visualiser, voire de recopier, I’adresse CoT

. X i . 0 50 100150 200 250 300
Web utilisée par Aladin pour obtenir les données. 100

Niveau d'opacité =l
| 1 | | 1
0 20 40 60 80 100

Contréle de la transparence

Appliquer Fermer Q

Certains plans peuvent étre affichés en semi

transparence sur ’image de fond. Ce peut étre un plan catalogue ou qui contient un champ
instrumental (« Fol ») ou encore un plan «image» au-dessus d’une autre image. Lorsque cela est
possible, le logo du plan en question est muni d’une petite languette. Celle-ci peut étre tirée a
droite pour augmenter le niveau d’opacité du plan, ou au contraire tirée a gauche pour la
diminuer.

Astuce : Afin de disposer d’une réglette plus large, le niveau de transparence peut également étre
contrdlé soit par la réglette « opac. » située sous la pile, soit directement dans celle présentée
dans la fenétre des propriétés.
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Diverses astuces

» En bas a droite de la vue, une icone symbolise I’ceil de I’observateur Elllil. Cet élément
peut étre cliqué afin de cacher d’un seul clic tous les plans graphiques et n’afficher que
I’image de fond. Un deuxiéme clic sur I’ceil rétablira la configuration précédente.

» Pour aider au repérage, un double-clic sur le logo du plan (désactivation/activation) va
entrainer un bref clignotement des données associées pendant quelques secondes.

» Un plan catalogue sur le haut de la pile sera par défaut projeté systématiquement sur
toutes les images de méme champ situées en dessous de lui. Dans le cas du multivue (voir
section suivante) il peut étre intéressant de restreindre la projection d’un plan catalogue a
une image particuliére. Pour cela il
suffit de placer dans un méme
« dossier » le catalogue et I’image
concernée. Puis via les
« propriétés » associées au
« dossier », sélectionner « portée :
locale » : le dossier apparait alors
comme une enveloppe fermée et les
catalogues qui s’y trouvent ne sont
plus tracés sur les autres images.

5.1.3 Les réglettes de controle

Sous la pile se trouve une série de réglettes. Elles
permettent divers controles : —
> J2000 : Ajustement de I’époque de la vue. Si [
les sources du plan sélectionné disposent de
mesures de mouvement propre, les objets [
seront visualisés a I’année indiquée. Par
défaut c’est I’année de I’image courante si elle est connue, qui est prise, sinon 1’année

2000. Un clic sur le titre de la réglette le réinitialise a sa valeur originale ;

» Taille : modifie le facteur a appliquer a la taille des surcharges graphiques des plans
sélectionnés ;

» Dens. : Modification de la densité. Dans le cas d’un plan HiPS catalogue, 1’action de cette
réglette changera temporairement 1’ordre HiPS* sélectionné pour le champ de la vue, et de
ce fait, modifiera la densité des sources qui y apparaissent. Dans le cas d’un plan de
couverture, le changement de densité modifie 1’ordre maximal d’affichage du MOC
utilisé pour visualiser cette couverture.

» Cube : Choix de I’image courante d’un cube. Dans le cas d’une sélection d’un plan cube,
ou HiPS cube, I’action de cette réglette permet d’ajuster la « tranche » du cube a afficher
dans la vue ;

J2000

*Dans ce contexte, I’ordre d’un HiPS ou d’un MOC représente le niveau de précision utilisé pour I’affichage (cf.
6.2). Il s’agit de la surface du losange HEALPix associé a cet ordre.
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» Opac. : Modification de I’opacité. Lorsqu’un plan est visualisé en superposition d’un
autre plan, cette réglette agit sur le niveau de transparence du premier plan. Cette fonction
est également possible via la petite réglette directement présente sous le logo de chaque
plan dans la pile ;

» Zoom : Modification du facteur de zoom de la vue.

Note technique : certaines de ces réglettes peuvent ne pas a étre présentes dans votre interface.
Vous devrez alors les ajouter en utilisant vos préférences utilisateurs (cf. 5.21).

DSS2.FPOSSII J

5.1.4 La vue I-a bel Pixel

Le panneau de la vue (ou des vues) est 1’élément :
principal de I’interface Aladin. La vue affiche . B ’
une représentation des données activées dans la b R H Ie
pile. En général, il s’agit d’une image sur L w
laquelle sont dessinés en surimpression des . & Y. 1
symboles graphiques représentant les sources " '

-

des catalogues. Des éléments d’information .2 : Qri en-
situés sur les bords fournissent des informations : :
complémentaires : un titre (label), un réticule
(reticle), une échelle (scale), la taille du champ
dans le ciel (size) ainsi que son orientation par
rapport au nord.

Position des objets dans la vue

Pour tracer les objets astronomiques a leur position précise, Aladin se base sur la solution
astrométrique associée a I’image, par exemple une projection tangentielle centrée. En général les
images, notamment celles encodées dans le format FITS, ou les relevés progressifs (HiPS) sont
fournies avec une solution astrométrique. Si ce n’est pas le cas - par exemple pour une image
JPEG - il est possible de calculer sa propre solution astrométrique (menu : Image => Calibration
astrométrique — cf. 5.14). 1l peut arriver que les objets ne se superposent pas exactement a
I’image soit parce que leurs positions sont imprécises, soit parce que la solution astrométrique est
incertaine.

Activation des plans

Icone : @

Script : show ..., hide ...

Les plans qui s’affichent dans la vue sont ceux qui ont été activés dans la pile en cliquant sur
I’icone correspondante. Une fois activé, un double-clic sur ce logo fera brievement clignoter les
données afin de les repérer plus aisément. Il est possible de régler le niveau de transparence,
voire de cacher temporairement 1’un ou 1’autre des plans, voire méme I’image de fond (cf. 5.1.2).

Passage a I'image suivante

Menu : Vue => Image suivante
Raccourci:  Tab
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Lorsque la pile contient plusieurs images, il est possible de passer rapidement d’une image a
I’autre en activant simplement le plan image correspondant. Automatiquement, tous les plans
graphiques (catalogues et dessins) superposables a I’image seront activés. L’utilisation du menu
« Vue => Image suivante » ou encore la touche « T4AB » effectue la méme opération. Cette
fonctionnalité est particuliérement pratique lorsque la vue est visualisée en pleine écran ou en
simple fenétre (cf. ci-dessous).

Image en semi transparence

Icone : E

Script : set ... opacity=[0..100]

Il est également possible d’afficher une image en semi transparence sur une autre image. Ceci est
notamment pratique lorsque I’image a afficher en transparence est plus petite que I’image de
fond. Pour activer la semi transparence d’une image, il est nécessaire d’utiliser la petite réglette
qui apparait sous le logo du plan image projetable. Lorsque la réglette est totalement tirée a
droite, I’image du dessus cachera totalement la portion correspondante de I’image du dessous.

Il peut étre utile de permuter les plans images dans la pile pour modifier les images en avant-plan
et en arriere-plan.

Réticule

Menu : Graphique => Réticule classique/large
Script : coordonnées ou nom d’objet

Le réticule permet de repérer une position particuliere
dans la vue. En général il s’agit de la derniere position
cliquée. Le réticule peut étre tracé soit sous la forme
d’une petite croix de couleur magenta, soit comme
deux droites se coupant transversalement. Il est
également possible de ne pas 1’afficher (menu
Graphique => Réticule). Les coordonnées du réticule
s’affichent dans le champ « Command » du « bandeau
de commande ». A ’inverse, la saisie d’une position,
voire d’un nom d’objet, dans ce champ entraine le
déplacement du réticule a la position correspondante.

Astuce : 11 n’est pas nécessaire de cliquer dans le champ, vous pouvez directement saisir votre
cible au clavier méme si le curseur se trouve toujours dans la vue principale.

Les 5 actions dans la vue

Les actions opérées par la souris dans la vue sont :

Select: sélection des surcharges graphiques dont les sources de catalogues ;
Dépl. (« pan »): déplacement du champ de vue ;

Zoom : agrandissement / réduction du champ de vue ;

Rotation : changement de ’orientation de la vue ;

Filtrage temporel : restriction d’affichage en fonction du temps.

VVVVY
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Les 2 premiers modes sont exclusifs, et par défaut, c’est le mode « Select » qui est activé. Avant
d’opérer une action a la souris, jetez un coup d’ceil a la barre d’outils pour vous assurer que vous
étes bien dans le mode souhaité.

Astuce : Lorsqu’il n’y a aucun objet a sélectionner, le mode Dépl. (« pan ») se substituera au
mode Sélect par défaut.

Sélection d’objets

Bouton : select
Souris : cliquer ou cliquer/déplacer

Lorsqu’Aladin visualise des objets graphiques (sources de catalogues astronomiques ou
surcharges graphiques), il est possible de sélectionner certains de ces objets lorsque le mode
« Select » est activé. Si ce n’est pas le cas, cliquer sur le bouton « select » en haut de la barre des
boutons. La sélection d’un objet se fait en cliquant dessus ou en créant un rectangle de sélection
englobant 1’objet ou les objets concernés (cliquez en dehors de tout objet, puis glissez et
relachez). Les objets sélectionnés sont entourés d’un petit carré vert. S’il s’agit de sources
astronomiques, les mesures associées apparaissent dans le panneau des mesures sous la vue
(cf. 5.1.8).

Les objets sélectionnés - lorsqu’il s’agit de surcharges graphiques et non pas de sources de
catalogues - peuvent généralement étre déplacés. Pour cela, il est nécessaire de cliquer/glisser
I’un des petits carrés verts de contréle qui se sont affichés lors de la sélection. De plus, s’il s’agit
de champs instrumentaux (cf. 5.2.3 - FoV), les coins vont permettre d’effectuer une rotation.

Glissement/déplacement

Bouton : dépl.

Menu : Edition => Déplacer le champ de vue...
Raccourci :  Alt+Z

Souris : cliquer/déplacer bouton du milieu

I est possible de faire glisser I’image en utilisant le bouton « dépl. » puis en cliquant/glissant
I’image dans la direction souhaitée.

Astuce: L'utilisation du bouton central de la souris permet d'effectuer directement un
« Glissement/déplacement » tout en restant en mode « Sélect ».

Zoom
Réglette : zoom
Menu : Edition => Zoom...
Raccourci:  F2,F3 - F4 (zoom pointé)
Souris : molette
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Script : zoom ...
Aladin permet de zoomer rapidement sur n’importe quelle portion de 1’image.

Le facteur de zoom peut étre modifié de différentes facons :

« En manipulant la molette de la souris avec le pointeur dans la vue ;

+«» En utilisant la réglette sous la pile ;

« En utilisant le menu principal « Edition => Zoom » ;

+« En utilisant le menu « zoom pointé » puis en cliquant dans la vue (maintenir la touche Maj
appuyée pour « dézoommer »). Pour revenir rapidement au mode par défaut (« select »)
déplacez le pointeur de la souris hors du panneau de la vue.

Si I’image dispose d’une calibration astrométrique, un accroissement du zoom centrera I’image
sur la position courante du réticule (sauf si la vue a été « verrouillée » — cf. ci-dessous). Il est
ainsi trés aisé de zoomer sur un objet particulier en déplacant le réticule sur I’objet (simple clic),
puis on utilisant la molette de la souris.

Zoom & déplacement « dans le contexte »

Les opérations de zoom et de déplacement peuvent étre également effectuées via la souris et la
molette au moyen du « graphique de zoom » contextuel qui apparait en bas a droite. Dans le cas
d’une visualisation d’une image classique celui-ci présente la totalité de 1’image sous la forme
d’une vignette, et en superposition un cadre bleuté represente la reglon actuellement visible dans
la vue. Pour les relevés progressifs (HiPS), la :

vignette est remplacée par une représentation
totale de la sphere céleste en projection AITOFF
sur laquelle est localisé le champ de vue
actuellement visible.

Historique des déplacements

Ry L historique des différentes cibles interrogées est conservé et accessible par le
menu déroulant qui s’affiche dans le « graphique de zoom » contextuel décrit
dans le paragraphe précédent. Ces positions sont mémorisées d’une session a 1’autre. Par défaut,
il s’agit de toutes les cibles ayant fait 1’objet d’une interrogation sur un serveur. Il est également
possible d’ajouter manuellement la position courante du réticule en cliquant sur le sigle a gauche
de ce menu déroulant.

Rotation

Vue : :

Souris : Ctrl + cliquer/glisser

Type d’images :  HiPS uniquement

Script : northup ..., unnorthup ...

L’opération de rotation permet de faire tourner 1’image dans la vue. La méthode la plus facile
consiste a utiliser la souris comme pour un déplacement de la vue, tout en maintenant appuyé la
touche Ctrl. 1l est également possible de faire pivoter directement 1’indicateur des directions
Nord-Est, et cela sans avoir a maintenir la touche Ctrl.
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Pour annuler la rotation et réorienter I’image le Nord vers le Nord, cliquez sur I’icone
« Nord » situé en dessous de la vue. '

Restriction d’utilisation : La rotation n’est possible que sur les relevés progressifs (HiPS). Les
images classiques ne pourront étre que réorientées temporairement le Nord en haut via 1’icone
« Nord », mais sans possibilité de choisir un autre angle de rotation.

Filtrage temporel

Menu : Vue => Filtre temporelle
Script: ISODATE1 ISODATE=2

A toute vue, il peut étre associée une fenétre temporelle sous la forme d’'une date de
début et une date de fin®. Des lors, seules les données tombant dans I’intervalle de temps
seront tracées (sources de catalogues, portion de couverture spatio-temporel (STMOC). Les
données sans estampilles temporelles seront également affichées.

En cas d’application d’un filtrage temporel, ’intervalle de dates concernées s’affiche a coté de la
taille du champ de la vue (en bas au milieu).

201 8=-06-07 ... 2022

Au moyen de la souris, il est possible d’ajuster dynamiquement la
fenétre temporelle associée a la vue en utilisant les controles de la & 1392 x 13.0%"
réglette temporelle (crochet ouvrant et fermant) qui apparait dans le
panneau de repérage d’Aladin. La suppression de la fenétre
temporelle et donc du filtrage associée, s’effectue en cliquant sur la
petite croix apparaissant a gauche de la borne temporelle supérieure,
ou plus simplement, en double-cliquant dans 1’intervalle temporel
délimité par les 2 crochets. 1954-04-27 .., 1984-09-16

+1 8l

Grille de coordonnées

Icbne : grille

Menu : Graphique => Grille de coordonnées
Graphique => Grille HEALPix

Raccourci : Alt+G

Script : grid ...

L’activation d’une grille se fait soit par 1’icone « grille » se situant sous la vue, soit par le menu
« Graphique => Grille de coordonnées » pour une grille en longitude / latitude ou « Grille
HEALPix » pour une grille HEALPix (cf. 6.2). Le pas de la grille est fonction du facteur de zoom
courant pour n’afficher qu’un nombre raisonnable de secteurs. Le référentiel de la grille est le
méme que celui utilisé pour afficher la position courante sous la souris. Il n’est pas possible
d’afficher simultanément plusieurs grilles dans des référentiels différents.

> Le référentiel temporel est TCBou Temps Coordonnée Barycentrique
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Dans le cas d’une grille en longitude / latitude,
lorsque la vue est tres large, la grille peut
apparaitre partiellement tronquée si la solution
astrométrique de I’image courante ne peut étre
utilisée pour calculer une position tres éloignée
de I’image (ex : plaque de Schmidt digitalisée).

Vues multiples ou « multivue »

Afin de comparer facilement plusieurs images, il
est pratique de créer simultanément plusieurs
vues. Le panneau principal peut ainsi se
subdiviser en 2, 4, 9 ou 16 sous-panneaux.
Chacun de ces panneaux peut afficher une image
différente et des objets graphiques en [1=0055:
superposition. Ces images peuvent concerner des R
régions différentes du ciel et/ou la méme région
du ciel. Il est également possible d’utiliser
plusieurs panneaux pour une méme image, par exemple pour visualiser plusieurs détails de celle-
ci.

Restriction : A noter que dans le cas des HiPS, cette derniere fonction n’est possible qu’apres
avoir dupliquer le plan HiPS autant de fois qu’il y a de vue.

Nombre de vues

L= 00 g5 2z ik

Icone : multivues multviz

Menu : Vue => Cadres — 1 cadree, 2 cadres ...
Raccourci : Maj-F1, Maj+F2, Maj+F3, Maj+F4
Script : mview ..., cview ...

La modification du nombre de vues « visibles » s’opeére soit par le sélecteur « multivues » situé
en bas a gauche sous le panneau des vues, soit par le menu « Vue => 1, 2, 4,9, ou 16 cadres ».
Dans le cas ou il y aurait plus de vues utilisées que de panneaux disponibles, une barre de
défilement apparait a droite de la fenétre principale permettant d’accéder aux autres vues. Il est
possible de gérer plusieurs milliers de vues (cf. 6.7 — création de vues vignettes). Seules les vues
visibles utilisent réellement de la mémoire (RAM).

Affectation des vues

L’affectation d’une image a une vue se fait en glissant/déposant le logo du plan correspondant de
la pile dans le panneau choisi.

Il est également possible de créer en une unique manipulation autant de vues qu’il y a d’images
dans la pile au moyen du menu « Vue => Créer une vue par image ».

Astuce : 11 est possible de glisser/déposer une image JPEG, PNG, FITS depuis votre

environnement de travail (Bureau Windows, Desktop Linux...) et/ou depuis votre navigateur
Web vers une vue particuliere.
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Vue courante

La vue courante est entourée d’un bord bleu, c’est-a-dire celle sur laquelle va s’opérer les
fonctions de zoom par exemple. Il suffit de cliquer sur une vue pour qu’elle devienne la vue
courante. En maintenant la touche Maj enfoncée, il est possible de sélectionner plusieurs vues
simultanément, par exemple pour indiquer celles qui doivent étre supprimées.

Il est possible de visualiser la vue courante (bord bleu) en « monovue » en revenant a un unique
panneau. Les autres vues ne sont pas supprimées pour autant et sont toujours accessibles via la
barre de défilement verticale qui apparait a droite de la fenétre ou en revenant en mode multivue.
La vue courante peut également étre visualisée en plein écran (menu « Vue => Plein écran ») ou
en mode simple fenétre (menu « Vue => simple fenétre ») — voir ci-dessous.

Uniformisation des vues

Icéne : unif. i

Menu : Vue => Uniformiser...
Raccourci :  Alt+S, Alt+Q

Script : match ...

En multivue, il est possible d’uniformiser 1’échelle, voire I’orientation d’images différentes mais
concernant la méme région du ciel. Cette opération est accessible soit par le menu « Vue =>
Uniformiser [’échelle », resp. « Vue => Uniformiser [’échelle et [’orientation ». Soit, dans le
dernier cas, par le bouton « unif. ». L’uniformisation des échelles ne s’applique que pour les
images classiques. Elle ne modifie pas les pixels, mais se contente de choisir automatiquement le
centre et le facteur de zoom le plus proche pour visualiser la méme zone du ciel. En revanche,
I’uniformisation de I’échelle et de 1’orientation reprojette les images soit en se basant sur la
position des 4 coins de chaque image classiques, soit en utilisant la méme projection HiPS pour
les relevés progressifs. Ainsi les champs sont identiques mais les pixels sont déformés. Les vues
« uniformisées » sont automatiquement sélectionnées, repérables par leur bord bleu. Si leur
orientation a également été alignée, le bord des vues concernées apparait en rouge.

Vue verrouillée

Menu : Vue => Vue verrouillée
Script : lock ..., unlock ...

Lorsque I’on double-clique dans une vue, toutes les autres vues concernant la méme région du
ciel vont se centrer automatiquement sur la position cliquée. Idem si I’on clique dans les mesures
(cf. 5.1.8). Pour inhiber ce changement de zoom il est possible de verrouiller une vue pour
qu’elle conserve toujours le méme centre (Menu « Vue => Vue verrouillée »). Une vue
verrouillée fait apparaitre un petit cadenas dans son coin bas gauche . .

Déplacement et copie

Il est aisé de déplacer une vue d’un panneau a un autre panneau en effectuant un simple
cliquer/glisser/déposer a la souris en ayant au préalablement positionné le pointeur de la souris
sur le bord de la vue a déplacer. Le curseur change de forme pour signaler que la
copie/déplacement est possible. Le maintien de la touche Ctrl simultanément a cette opération
entrainera la duplication de la vue.
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Suppression

La suppression d’une vue n’entraine pas pour autant la suppression de 1’image et/ou des
catalogues utilisés pour cette vue ; les données restent accessibles dans la pile. En revanche, la
suppression d’une image dans la pile entralne la suppression de toutes les vues qui I’utilisent. Le
menu « Vue => Supprimer les autres vues » permet de supprimer rapidement toutes les vues
exceptée la vue courante.

Vue temporelle

Par défaut, et comme expliqué ci-dessus, une vue est « une fenétre spatiale » sur les données de
la pile. Certaines de ces données peuvent avoir une dimension temporelle. Dés lors il est possible
de filtrer ces données (cf filtrage temporel ci-dessus). Mais il est également possible de changer
le mode d’affichage d’une vue pour en faire une « fenétre temporelle » (menu contextuel de la
vue « créer une vue temporelle ») ou méme d’en créer une nouvelle via le menu « Vue — créer
une vue temporelle »). Une telle vue affiche les données compatibles (repérable par une petite
horloge en superposition de leur logo dans la pile) sous la forme d’un bandeau « temporel ». Il
s’agit principalement de la composante temps d’'un TMOC ou d’un STMOC, ou de tables
disposant d’une colonne « date ». La manipulation de ces éléments (sélection, zoom) s’opeére de
la méme maniere que pour une vue spatiale classique.

Lorsque une couverture temporelle est chargée dans la pile, Aladin crée automatiquement une
vue temporelle en dessous de la vue principale afin de pouvoir visualiser et manipuler les
données simultanément spatialement et temporellement. La sélection (MAJ clic) conjointe de ces
2 vues (spatiale et temporelle) aura un impact sur le filtre temporel appliqué a la vue spatiale :
seuls les objets tombant dans la zone affichée dans la vue temporelle seront visibles dans la vue
spatiale.

Plein écran et simple fenétre
Icones: RS
Menu : Vue => Plein écran, Simple fenétre
Raccourci: F11, F12

Une vue peut étre affichée en utilisant la totalité de 1’écran. Elle peut également n’utiliser qu’une
simple fenétre. Dans les deux cas les panneaux adjacents (pile, mesures, arbres, ...) ne seront
plus directement affichés, mais tout de méme accessibles au moyen de boutons de controles en
superposition de la vue. Un clic sur 'un [& e - 0 x
de ces boutons le transforme en panneau |[EEEEEEE : .

de controle affiché en semi-transparence
au-dessus de la vue. Ces panneaux de
controles peuvent étre déplacés et
modifiés en taille et en transparence en
cliquant dessus afin de faire apparaitre les
poignées de controles nécessaires a ces
actions. La molette de la souris dans la
marge du haut permet le changement du
facteur de transparence.
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Le déplacement de la souris sur le haut de la fenétre fait réapparaitre temporairement la barre des
menus. Une saisie au clavier ouvrira un champ de texte pour soumettre un objet, une position ou
une commande script.

L’utilisation de la touche « FI1 », respectivement « F/2 » va permettre de basculer dans ces
modes de visualisation. La touche « Echap » repassera en mode d’affichage normal.

5.1.5 La barre d’outils principale

Située entre la pile et la vue, verticalement, la « barre des outils » permet d’accéder rapidement
aux outils les plus couramment utilisés :

» select Mode : sélection des objets dans la vue

» dépl. Mode : déplacement de la vue

> T

» dist  Surcharge graphique de mesures de distances R

» phot Surcharge graphique de mesures photométriques j-—-! I_.

» dessin Surcharge graphique de dessin a main levée R

» marq Surcharge graphique de positionnement de marques —

> spect Surcharge graphique d’extraction d’un spectre d’un cube EE L

>

» moc Outil de manipulation des MOC (couvertures)

> filtre Génération de filtres de catalogue

» corr. Outil de corrélation de catalogues

> Xx-y Génération d’un graphique en nuage de points

> rvb Générateur d’images couleurs

-y , o . 5. . . .- marg cont

» assoc Générateur d’associations d’images (mosaiques/ség.animées)

» coupe Extraction d’une sous-image ou d’un sous-MOC

» cont Générateur de contours

» pixel Ouverture de la fenétre du controle de la dynamique des pixels —

» prop Ouverture de la fenétre des propriétés prap

» suppr Suppression de 1’élément courant =
Activation filtre  suppr

Les boutons s’activent en fonction des plans sélectionnés dans la pile. Certains boutons restent en
grisé s’ils ne sont pas concernés par le type de plan ou que le nombre de plans sélectionnés ne
correspond pas a I’action a entreprendre.

Aide

Le maintien de la souris sur 1’'un des boutons va entrainer I’affichage d’une petite fenétre
d’explication bréve sur 1’action du bouton (« tooltip »). Le prolongement du temps d’attente
complétera par une explication plus détaillée dans la zone libre au-dessus de la pile.

Modes et outils

Les 2 premiers boutons concernent les modes d’action de la souris dans la vue pour sélectionner
des objets, déplacer le champ de vue (cf. ci-dessus, les modes de la vue). Il s’agit de boutons
exclusifs. Tous les autres boutons concernent des outils. Nous ne détaillerons dans cette section
que les outils qui n’ont pas été décrits dans les autres sections de ce document.
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Les outils graphiques : dist, phot. dessin , marq. et spect.

Boutons dist tag =

Menu : Graphique => dist, phot, dessin, marq, spect

Raccourci :  Alt+D (distance)
Script : draw ...

Les 5 boutons donnant acces aux outils de surcharges graphiques pour les mesures de distances,
les mesures photométriques, le tracé a main levé, le placement de marques/textes libres.
L’activation de I’un d’eux entraine la création automatique d’un plan « surcharges graphiques »
sur le haut de la pile. Les éléments graphiques qui seront placés a la souris dans la vue seront
mémorisés dans ce plan, avec des coordonnées célestes, et pourront par conséquent étre
visualisés sur d’autres images.

Sélection et déplacement

Les surcharges graphiques créées par 1I’un de ces 5 outils peuvent étre sélectionnées (outil Select),
voire déplacées au moyen d’un cliqué/déplacé a la souris. Lorsqu’ils sont sélectionnés, des
petites poignées vertes apparaissent sur leur pourtour ou sur leurs extrémités.

Détail technique : Lorsque
plusieurs éléments sont
déplacés simultanément, le
déplacement est calculé sur la
volite céleste (en RA, DEC)
uniquement pour I’objet sous
la souris, puis reporté aux

autres objets concernés. Le i P g Sigma

maintien de la touche Maj _r;:””
- 7 Wi

change ce comportement pour , - _ 3 p.q::;-ljj

ne considérer qu’un N _ \ max
mouvement en coordonnées \ < ol T
XY pour tous les objets. Ces
deux techniques ne donnent
pas le méme  résultat
notamment lorsque les objets a déplacer sont distants de plusieurs degrés ou proche des poles.

Visualisation et modification des propriétés

Apres avoir sélectionné une seule surcharge graphique, il est possible d’afficher, voire de
modifier les propriétés spécifiques a cet élément graphique en cliquant sur le bouton « Prop. » ou
par le menu « Edition -> propriétés ». Cela peut étre sa position, sa taille, sa couleur, son titre,
etc...

Quelques astuces

» 1l est possible de faire apparaitre a coté d’une marque sa position. Pour cela sélectionnez la
marque en question et utilisez le menu contextuel (clic droit ou CTRL clic) et sélectionnez
« afficher l'identificateur de I’objet ».

» Lors d’un dessin a main levé (outil « dessin ») il est possible soit de maintenir enfoncé le
bouton de la souris pour effectuer un dessin « en continu », soit de cliquer plusieurs fois afin
de tracer des lignes droites successives. Dans ce dernier cas, il est nécessaire de sortir le
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pointeur hors de la vue pour stopper le processus de dessin ou de double-cliquer pour le
dernier sommet.

» Pour créer un polygone au moyen de I’outil « dessin » il faut que le dernier point de controle
coincide avec le premier point. Pour vous aider, le curseur change de forme lorsque vous
survolez a nouveau le premier sommet.

» Pour créer un nouveau plan afin que les nouvelles surcharges graphiques ne soient pas dans le
méme plan graphique, il est nécessaire de créer au préalable un niveau plan graphique via le
menu « Graphique > créer un nouveau plan Drawing » (Alt+N).

Graphe de coupe associé a I’outil de distance

Lorsque la double fleche utilisée pour mesurer une distance a été sélectionnée dans la vue, le
panneau multifonction - en bas a droite de la fenétre principale - affiche un « graphe de coupe »
représentant la répartition des valeurs des pixels le long du segment mesurant la distance. Si ce
segment est déplacé dans la vue au moyen de la souris, le graphe de coupe évolue en fonction de
la position dans I’image. D’autre part, si vous survolez le graphe de coupe avec la souris, une
barre horizontale permet de calculer la distance, angulaire et en pixels, d’un pic particulier. Cette
méthode permet par exemple d’ef
pour une étoile.

D’autre part, dans le cas d’une im4g
ce sont les niveaux des 3 composa

Mesures photométriques associées

L’outil de mesures photométriq
automatique via un simple clic sur
un cercle ou un polygone au mo
algorithme de mesure barycentriqu
ainsi que les parameétres d’une ellipse englobante. Dans le deuxiéme cas, 11 n’y aura qu’un simple
calcul statistique des pixels inscrits dans le cercle ou le polygone : décompte, moyenne, écart-
type, minimum, maximum,
somme...

Ces mesures s’affichent dans le
panneau multi-usage en
superposition de I’histogramme de
répartition des valeurs des pixels.
Il est possible de mémoriser les
mesures statistiques en appuyant
sur le bouton « sauve » présent sur
Cnt 3180 cet histogramme. Les mesures
sum calculées sont des lors associées a
I’objet de photométrie et seront
consultables et manipulables (tri,
sélection, sauvegarde, ...) dans la
fenétre des mesures sous la vue
principale (tout comme un
catalogue classique).

B e R

s_region origin

Restrictions d’application : Les
pixels d’origine de I’image
astronomique sur laquelle s’applique 1’outil photométrique doivent nécessairement &tre
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disponibles (pas possible pour une image JPEG ou PNG), que ce soit pour une image classique,
ou pour un relevé progressif HiPS. A noter que seuls les pixels dont leur centre est dans le cercle
ou le polygone sont pris en compte dans le calcul des statistiques. Un zoom suffisant fera
apparaitre un point au centre de chaque pixel concerné par la mesure statistique.

Note : Lorsque I’algorithme d’extraction automatique ne parvient pas a déterminer le centre de
1’objet sous la souris, aucune marque n’est insérée.

Note : Dans le cas d’une mesure sur un relevé progressif
HiPS, I’extraction des pixels est effectuée a la
résolution courante de la vue. L’ordre de cette résolution
est indiqué en préfixe du nom de I’image sur laquelle
est effectuée la mesure. Cela signifie que pour les
facteurs faibles de zoom, les calculs statistiques seront
opérés sur des pixels qui sont déja le résultat de la
moyenne des pixels de résolutions supérieures.

Coupe en profondeur associée a I’outil « Spectre »

Le positionnement et la sélection d’une marque par 1’outil « Spect» dans un cube d’images
génere également un graphe de coupe tout comme 1’outil « dist. », mais cette fois-ci dans le sens
de la profondeur du cube. Sur le graphe ainsi obtenu dans le panneau multi-usage, le trait vertical
rouge correspond a la position de
I’image courante du cube (un cube
sous Aladin est visualisé comme une
séquence d’images). La valeur
mentionnée au pied de ce repere
indique la  grandeur physique
correspondant a I’image courante du
cube (par exemple une vitesse).
Comme pour 1’outil distance, le
déplacement a la souris de la marque
entraine 1’ajustement automatique du
graphe. D’autre part, le survol du
graphe par la souris affiche la valeur du pixel correspondant (ordonnée du graphe). Un
cliquer/glisser horizontal va déplacer la ligne rouge de I’image courante et de ce fait faire évoluer
I’image courante dans la vue.

Note : L’utilisation des outils « Spect », « Phot» ou « Dessin » (polygone) sur un cube sont
susceptibles de générer un spectre respectivement pointé ou moyenné sur la zone qui sera
visualisable et manipulable a 1’aide du
« plugin » CASSIS développé par
I’IRAP/Toulouse. Veuillez-vous
référer a la section 6.5 pour les détails.

Spécificités de ’outil « Margq. »

L’outil de placement d’une « marque »
s’utilise soit en simple clic soit en
cliquer/glisser.
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Un simple clic insére une croix identifié par un numéro de série a I’emplacement exact de la
souris, a laquelle sont associées des mesures de positionnement en X, Y (origine a la FITS, cad
(0,0) au milieu du pixel en bas a gauche) et en longitude, latitude présentées dans la fenétre des
mesures. Ces mesures pourront étre manipulées comme un catalogue classique (tri, sélection,
sauvegarde...).

L’insertion par cliquer/glisser permet la création d’une

& Individual object properties — O X

"Tag" object in plane: "Drawing"

Coord gl |05:3415.51 +22:00:33.9

Angle 9 128

Pole size 0 44

Arrow head 9 arrow ~

Font size 20

cor @ LEEEL |HEEE |
BN EoEEE <

B star

« marque » plus complexe qui s’accompagne de la saisie d’un
texte associé a la marque. Elle offre une visualisation plus
sophistiquée (hampe du texte positionnable, embout de la
hampe sélectionnable, taille, bordure et fond du texte
modifiable, ...). En revanche, aucune mesure de
positionnement n’est mémorisée.

Il est souvent plus pratique de modifier a posteriori les
parametres spécifiques d’une telle marque en affichant ses

tabe! @ propriétés (bouton « Prop.» aprés avoir sélectionné la
Label border [] with border marque).
Label background |
Appliquer Fermer

L’outil « loupe » ou « table de pixels »

Menu :
Raccourci :

Image => Loupe, Table de pixels
Cul+G

Lorsque la loupe est activée, le panneau multi-usage — en bas a droite de la fenétre principale —
va étre temporairement utilisé afin d’afficher un agrandissement des pixels se situant autour du
pointeur de la souris lorsque celui-ci
survole la vue.

L’utilisation des touches de déplacement

04 0.6505 0.8723 0.9438 0.700
0.5791 0.7078 0.9867

91 0765 1216  1.402
0.9367  1.445

06649

(fleches Haut, Bas, Droite, Gauche) Pozsss Lia2
devient possible pour effectuer un o
déplacement pixel par pixel du pointeur e
de la souris. i 64 1473

0.8008

48 1.001

07293  1.43 ¥
Il est également possible de sélectionner 61 08008 1366 1452

0.6434 1.058 1.538

I’affichage de la table des valeurs des
pixels sous la souris. Il s’agit d’un affichage similaire a la loupe, mais avec un grossissement
supérieur permettant d’afficher en superposition les valeurs.

L’outil de coupe

Bouton : coupe

Menu : Image => Extraire une portion de I’image
Type d’images :  HiPS ou images classiques

Script : crop ...
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L’outil de coupe permet d’extraire une sous-image a partir d’'une image préalablement chargée.
Celle-ci peut étre de tout type, image classique, en couleur, en vraies valeurs de pixels, en encore
issue d’une relevé progressif HiPS. L’activation de cet outil permet de délimiter la zone
rectangulaire d’extraction au moyen de la souris. Une fois la zone délimitée, il est possible
d’ajuster manuellement les valeurs de positionnement a posteriori en cliquant directement dans
les cartouches puis en éditant les valeurs
adéquates.
L’image extraite est automatiquement
insérée dans la pile. Dans le cas d’une image
en niveaux de gris, sa table des couleurs sera
inversée afin de la repérer facilement en
superposition de I’image originale.

Note technique : Dans le cas d’une image
extraite d’un relevé progressif, si celui-ci est
affiché en mode prévisualisation I’extraction
opére une simple capture visuelle de la sous-
image, rapide mais non exempt de
déformations. En revanche, lorsque le relevé
progressif offre 1’accés aux véritables
valeurs des pixels, 1’extraction sera issue d’un processus d’échantillonnage bilinéaire pixel a
pixel afin de garantir la conservation optimale de 1’astrométrie et de la photométrie originale. Le
choix de la résolution finale d’une telle image extraite peut étre ajusté soit en modifiant le facteur
indiqué en bas a gauche du rectangle d’extraction, soit en cochant en haut a gauche le sélecteur «
original resolution ». 11 est recommandé de vérifier la taille correspondante en pixels a la
résolution sélectionnée avant de lancer I’opération d’extraction.

Astuce : Le méme outil de coupe peut étre utilisé sur un MOC afin d’en extraire un sous MOC
rectangulaire.

L’outil de suppression

Bouton : suppr

Menu : Edition => Supprimer

Edition => Tout supprimer
Raccourci :  Suppr ou Maj+Suppr
Script : rm et reset

L’outil de suppression est dépendant du contexte. En fonction du, ou des éléments sélectionnés
par la souris, il supprime, soit :

» La—ou les - surcharges graphiques ;

» La—oules—vues;

» Le —ou les — plans.

D’autre part, la pression simultanée de la touche « Maj » entrainera la suppression de toutes les

données chargées dans Aladin. A manier a bon escient car Aladin ne dispose pas d’une fonction
« annuler » (« undo »)
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5.1.6 La barre secondaire d’outils
Ml & T w0, = ¢ T 4l (OES088

wue =can  fitre grille exam.cligne r'ﬁ':a_i notd  hdr muftivues . unif.

Située sous 1’arbre des collections des données et sous la vue, la barre secondaire d’outils
autorise les actions décrites ci-dessous.

Arbre des collections (cf. 5.1.1) :

réd. : Développement/réduction de la branche sélectionnée ;

tri : tri de I’arbre des collections suivant différents critére ;

vue : Filtrage des collections n’ayant pas de résultat dans la vue courante ;

scan : Création dynamique d’une couverture pour les collections n’en disposant pas ;
filtre : Activation du filtrage.

VVVVY

grille : Activation de la grille de coordonnées ;

exam. : Examen de I’objet astronomique sous la souris (cf. 5.10) ;

cligne : Suspension temporaire de 1’affichage des surcharges graphiques de la vue ;

maj : Mise-a-jour des plans issus d’une requéte par cone ;

nord : Rotation forcée Nord en haut, Est a gauche ;

hdr : Permutation d’un mode de visualisation prévisualisation au mode dynamique réelle
(HDR pour « High Dynamic Resolution ») ;

multivue : Contréle du nombre de vues visibles simultanément ;

unif. : Utilisation temporaire d’une unique projection pour toutes les vues sélectionnées.

YVVVVYVYVYLk

Y VY

5.1.7 Le bandeau de commande

Dans la partie supérieure de la fenétre principale, sous le menu, un bandeau de commande
regroupe quatre éléments de controles :

Le champ de commande ;

Le sélecteur du référentiel spatial ;

Le sélecteur de la projection courante ;

La liste des signets.

VVVY

Commande Référentiel Jlas Projection Ehlid

D55 MSD55 M2MASS B GALEX B AKARI Saia Simbad W NED W Skymapper +

Le champ de commande

Le champ de commande est utilisé a diverses fins : la visualisation des coordonnées sous la
souris lorsqu’elle survole la vue, la saisie d’une position, de coordonnées, ou d’une commande
script.

Saisie d’une position

La fonction principale du champ de commande consiste en la saisie d’une position astronomique.
Il s’agit d’indiquer les coordonnées de la cible sous la forme d’un couple longitude, latitude. Le
référentiel utilisé doit correspondre a celui spécifié (ICRS, J2000, B1950d, XY image,...) dans le
sélecteur situé sur la droite du champ de saisie. La validation de la position saisie par la touche
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Entrée entraine le déplacement du réticule (croix magenta) a la position correspondante dans la
vue ainsi que le centrage de la vue sur cette position.

Il est également possible de saisir un identificateur d’objet astronomique. Dans ce cas la
validation (touche Entrée) entraine dans un premier temps 1’interrogation automatique du service
« Sesame du CDS » qui retournera la meilleure position connue de 1’objet en consultant les bases
de données Simbad, NED et certains grands catalogues astronomiques de VizieR. Puis, en se
basant sur les coordonnées récupérées, Aladin déplacera le réticule et centrera la vue sur cette
position. Cette fonction est également accessible via le menu « Outil => Résolution d’un nom
d’objet ».

Astuce : Dans le cas ou la vue est encore vide, la saisie d’une position ou d’un identificateur
d’objet astronomique entraine le chargement d’un relevé astronomique par défaut —

habituellement le DSS couleur (modifiable par les préférences utilisateurs — cf. 5.21).

Commande script

Le champ position peut étre également utilisé pour saisir n’importe quelle commande script
supportée par Aladin, et pas uniquement une position (cf. 7.1 — Aladin par script). Sur le c6té
gauche du champ de saisie, un petit triangle ouvre un menu déroulant de I’historique des
commandes exécutées par Aladin. Cette liste contient non seulement les précédentes commandes
scripts exécutées, mais également les commandes équivalentes a une action opérée
précédemment au moyen de I’interface graphique et de la souris. Vous pouvez ainsi ré-exécuter la
méme action, voire 1’éditer et la modifier avant de la ré-exécuter.

hide CDS/P/SDSS9/color-alt M I

show CDS/P/50559/ color-alt
hide CD5/P/5D559/ color-alt

get HiPS{CD5/P/50559/ color-alt)
reset

EN

Les sélecteurs du référentiel et de la projection

mmmﬁ Les deux sélecteurs a droite du champ de

Spheric commande permettent d’indiquer d’une part le
e référentiel spatial utilisé par défaut, et d’autre
part la projection utilisée pour I’affichage dans la
Zenital equal vue.
Stereographig
T Note : le suffixe « d » de certains des référentiels
B1950 Moliweide proposés signifie «degrés» et indique que
B1950d Arc I’affichage et la saisie des coordonnées seront
B1900 faites en nombres décimales (ex: 256.67555 -
— 47.17031) et non en notation sexagésimale (ex : 17 06 42.1320 -47 10
s 13.116) (cf. glossaire).
XY image
XY linear

La modification de ses sélecteurs va se répercuter dans la vue, soit par un
simple ajustement de la grille de coordonnées dans le cas d’images classiques (seul le référentiel
sera modifiable dans ce cas), soit par la transformation de 1’image elle-méme dans le cas d’un
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relevé progressif HiPS afin de tracer celui-ci dans le référentiel et la projection choisie. Il est par
exemple possible de visualiser la voute céleste compléte d’un relevé du ciel en référentiel
galactique / projection AITOFF ou en équatorial ICRS / projection sphérique, etc.

Astuce : en mode multi-vue, il peut étre souhaitable de ne pas afficher toutes les vues dans le
méme référentiel / projection. Pour ce faire, il est nécessaire de choisir un référentiel et une
projection spécifiques via les propriétés des plans associés a chaque vue.

Les signets

Sous le champ de commande, une liste de signets (« bookmarks ») permet un acces rapide a des
actions prédéfinies. Il s’agit en général du chargement d’ une collection spec1f1que pour la

position courante, mais ce peut étre tout type d’actiongmmts SR
page » de couleur verte ont été prédéfinis par le CDS, (™= - - r .

; Eth srCDE,’SLmbﬂd} STARGET SRADfUS
Le survol d’un signet fait apparaitre au bout de quelques secondes la ou les commandes SCrIpts
qui seront exécutées si le signet est exécuté en cliquant dessus. La mise a jour de la liste des
signets visibles dans cette barre, ainsi que la création ou la modification des signets est possible

en cliquant sur I’icone « + » tout a droite de la barre des signets, ou via le menu « Qutils ->
Signets... »

Astuce : Le symbole du signet Ll présent a divers endroits dans 1’interface Aladin, et notamment
dans la « fenétre d’accés » de chaque collection permet de créer immédiatement le signet
correspondant.

Intéressons-nous maintenant au bas de la fenétre principale : le « panneau des mesures ».

5.1.8 Les mesures

Le « panneau des mesures » se situe en bas de la fenétre principale d’Aladin. Il sert a visualiser
les mesures associées aux sources. C’est un outil trés puissant qui permet de sélectionner, de trier,
de filtrer des tables.

Note : Ce panneau est escamotable et peut ne pas étre visible. Si c’est le cas, cliquez sur le petit

onglet symbolisé sous la vue. ;
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Seules les sources qui ont été sélectionnées, individuellement ou collectivement, dans la vue au
moyen de la souris (cf. 5.1.4) apparaissent dans le panneau des mesures. Ces mesures sont
présentées sous forme d’une table ou chaque ligne présente les valeurs associées a une source.

Les sources sélectionnées apparaissent entourées d’un carré vert dans la vue. Le survol par la
souris d’une source sélectionnée fait clignoter cette source et simultanément, rend visible les
mesures correspondantes en surlignant la ligne en bleu. De maniéere symétrique, le survol d’une
ligne dans la table des mesures fait clignoter la source correspondante dans la vue si elle est
visible. D’autre part, la sélection d’une ligne de la table (en double-cliquant dessus) va déplacer
la vue afin de la centrer sur la source correspondante.

i fun
M ¥

L

wnlua(ualun

La premieére ligne de la table affiche 1’en-téte qui décrit le contenu
sur une case d’en-téte entraine le tri, en ordre croissant, puis décrois
des valeurs de la colonne. Un petit triangle apparait a droite du libe
de tri. Le tri sera alphabétique ou numérique suivant le contenu de la colonne. Il est p0551b1e
d’agrandir ou de rétrécir la largeur d’une colonne en cliquant/déplacant le bord droit d’une case
de I’en-téte. Lorsqu’une case est tout de méme trop étroite pour afficher la totalité de la valeur, le
survol de la souris sur cette case 1’agrandit temporairement afin de dévoiler le reste de la valeur.

Mesures issues de catalogues différents

Si les sources sélectionnées sont issues de catalogues différents, plusieurs tables qui n’ont pas
nécessairement les mémes colonnes vont se succéder. La couleur du carré en début de ligne
permet rapidement de B

repérer I’origine des
données (méme couleur que
le plan dans la pile). MAIN_ID OTYPE

La ligne d’en-téte
correspond toujours a la
table de la derniere ligne
sélectionnée (cliquée via la
souris), ou a défaut, a celle
pointée sous la souris. La
couleur du trait sous 1’en-téte reprend la couleur du catalogue correspondant.
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Information sur la cellule

Le survol d’une cellule des mesures entraine 1’affichage d’informations complémentaires
associées a cette cellule dans la zone laissée libre au-dessus de la pile. Il s’agira du rappel du titre
de la table, du nom du champ (« field »), de sa valeur, de son unité, de I’'UCD (Unified Column
Descriptor) associée a cette colonne et enfin de sa description.

Histogramme des valeurs de la colonne

Le survol d’une colonne de la table des mesures fait apparaitre dans
le panneau multi-usage a droite I’histogramme de répartition des
valeurs de cette colonne. Le déplacement de la souris sur 1’une des
barres de cet histogramme restreint 1’affichage dans la vue a ces
seules sources. Dans le cas d’une série numérique, 1’'usage de la
mollette de la souris permet de modifier la largeur des barres.

Liens et boutons

Comme dans un navigateur Web, les valeurs repérées en bleu sont des « liens » vers des
informations supplémentaires disponibles sur le net. L’adresse Web qui sera appelée s’affiche en
bas de la fenétre d’Aladin lorsque le pointeur de la souris survole le lien. Un clic souris sur un
lien ouvre votre navigateur Web qui va charger la page Web correspondante.

En regle générale, le premier lien d’une ligne de mesure va charger la page de 1’enregistrement
original du site Web qui a fourni les données (Simbad, NED, VizieR...)

Certaines valeurs peuvent également étre représentées sous forme d’un bouton. Tout comme un
lien Web, I’activation d’un tel bouton entraine le chargement de données complémentaires via
Internet. Cependant, au lieu d’ouvrir votre navigateur, les données vont étre insérées dans la pile
afin d’étre visualisables immédiatement dans Aladin. Le plus [rEaniiSESEEl e IEGEEEN
souvent il s’agit d’images d’archives associées a une liste

d’observations.

Datalink

Il peut arriver que plusieurs liens soient associés a un méme bouton. Ceux-ci apparaissent des
lors sous la forme d’un petit menu déroulant. Ce systeme de choix multiple appelé « DataLink »
peut requérir a un formulaire intermédiaire qu’il est nécessaire de renseigner afin de charger les
données désignées par le lien sélectionné. Ce peut étre, par exemple pour préciser la portion de
I’image originale qui devra étre chargée.

Déselectionner cette source (MAJ clic)

Afficher I'enregistrement . .
Menu contextuel Copier la valeur sélectionnée
Editer cette source ) ) )
Copier le lien sous la souris
A Supprimer cette source . A .
La fenetre des mesures Copier les coordonnées de I'objet
Se centrer sur cette source

diSpOSEIlt de nombreuses Copier les mesures de 'objet (T5V)

Trier sens ascendant i K
. . . Copier les mesures de I'objet (JSON)
fonctions accessibles via un Trier sens descendant
menu contextuel visualisable

par un clic-droit.

Copier toutes les mesures (pour un éditeur de texte)

Copier... 3 Copier toutes les mesures (pour Excel)

z 3
Créer un nouveau plEI"I GWEC CES SOUrCeEs en une table

Ajouter une nouvelle colonne...

Ce menu dOIlIle notamment Information sur les colonnes...
acces a différentes fonctions Calculs de coordonnées..
d’utilisation du presse-papier pour effectuer un copier/coller. Il offre également la possibilité de

en multi-tables (si nécessaire)
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créer un nouveau plan catalogue contenant la copie des sources/mesures présentes dans la fenétre
des mesures. Cette duplication peut se faire a I’identique (« en multi-tables si nécessaire ») ou en
une table régénérée afin de fusionner des tables susceptibles de ne pas avoir les mémes structures
et noms de colonnes.

& Source record (16360) from CDS/chandre ~ o x Astuce: Afin de comparer aisément deux
_RAJ2000 - 083.63167 deg / Right ascension (FKS, Equinox=12000.0)... ) ]ignes éventuellement non consécutives, le
_DE12000 = +;2._01567 deg !/ Dg[hnatmn (FK?, Equmnx=]?000.0) (co... B B
fion S J et e mign reschution aage o spect.. menu « Afficher I’enregistrement » permet
Low = acis / Get the lower resolution image or spec... . . . )
0bsID = 16360 / Observation 10 (2) de visualiser la hgne sous la forme d’un
Instr — ACTS-S 7/ Instrument (3) . ~
ExpTine = 10.000 ks /7 Exposure tine (ks) enreglstrement dans une fenétre
Target = Crab / Target Name as specified in proposal X . R
Sm D oavouar s 1 oa n s st e indépendante. Seuls les champs non vides
Status = archived / Status of the observation (&) .
bsDate = 2015-01-18T13:27:16 5 / 7 Start Observation date sont repris.
racna = 14150 / Record number assigned by the VizieR t...

Effacer - Fermer

Enfin, Dentrée « Information sur les
colonnes... » donne acces a la fenétre de description des colonnes de la table.

Information sur les colonnes

Le panneau de description des colonnes accessible soit par le menu contextuel des mesures, soit
par le menu principal « Catalogue » affiche sous forme d’une table 1I’ensemble des informations
propres a chaque colonne : sa description, son unité, son type de données, son UCD, taille de la
cellule, la précision d’affichage, .... Certaines de ces informations peuvent étre modifiées.

& CD5/1/337/gais - | X
Visible Coo  Name Description Unit Datatype ucD .o Width  Arra... Prec..

i [1 [ra | _RAI2000 Hight ascension (FK5, Equinox=120... ideg double  |pos.eq.ra;meta.main 11 7 ~

2 [1 [oE _DEJ2000 Dedination (FKS, Equinox=12000.0)... |deg double  |pos.eq.dec;meta.m... 11 7

3 [ v Link to the VizieR record with all details char meta.ref [

4 [ RA_ICRS Right ascension (ICRS) at epoch 20... |deg double  |pos.eq.ra 14 10

6 [ DE_ICRS Dedlination (ICRS) at epoch 2015.0 ... |deg double pos.eq.dec 14 10

5 [] e_RA_ICRS Standard error of right ascension {r... |mas float stat.error;pos.eq.ra & 3

7 [] e_DE_ICRS Standard error of dedination (dec_e... |mas float stat.error;pos.eq.dec 6 3

&8 [ Source Source ID (source_id) (G2) long meta.id;meta. main 19

g [ Phx ? Absolute barycentric stellar paralla... |mas float pos.parallax & 2

i 1 PMRA [pmRA ? Proper motion in right ascension di... |mas/yr double  |pos.pm;pos.eq.ra 9 3

ii [©] [PMDE |pmDE ? Proper motion in dedlination directi... |mas/yr double  |pos.pm;pos.eq.dec 9 3

12 [] RADEcor Correlation between right ascension. .. float stat.correlation 12 3

iz [] Dup [0/1] Source with duplicate sources ... unsignedByte [meta. code 1

id [] =<FG= G-band mean flux (phot_g_mean_flux) |e-/s float phot. flux;stat.mea. .. 11 E4

is [ e <FG> Error on G-band mean flux (phot_g_...|e-/s float stat.error 11 E4 ]
& v Coche tout Deécoche tout - Rapport de traitement Colonnes des coord, Epogue; |12000.0 - Fermer

La colonne intitulée « Visible » permet de sélectionner les colonnes qui seront
affichées, respectivement cachées dans la table des mesures. w
¥ |
La colonne nommée «Ref» permet de désigner les colonnes (et leur format) L] Ra f
utilisées par Aladin pour extraire les coordonnées (RA, DE, GLON, GLAT, E::R A '
ELON, ELAT) et le mouvement propre (PMRA, PMDE) de la source associée evpE [i
a la ligne de mesures. Ce mécanisme sera également utilisé pour repérer la |
colonne fournissant une date associée a cette source (JD, MJD, ISOTIME, Y |
YEARS, DATE). Il est possible de modifier manuellement cette sélection en L] '

cliquant dans la case correspondante. Le petit menu contextuel qui s’ouvre alors permet
d’indiquer la nature de cette colonne.
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Note : Dans le cas d’une table sans support de coordonnées sphériques, il sera éventuellement
possible d’indiquer des colonnes de coordonnées images (X, Y) a la FITS (origine centre du pixel
bas-gauche).

Les deux boutons en bas a gauche permettent de modifier 1’ordre d’apparition ~ v
des colonnes dans la fenétres des mesures.

Fenétre indépendante

Le panneau des mesures peut étre temporairement détaché de la fenétre principale en cliquant sur

le logo en bas a droite 5. Ceci permet d’une part de bénéficier d’un plus large espace de travail
pour la vue et d’autre part, de travailler plus aisément sur un plus grand nombre de mesures.
Notez que la table des mesures d’Aladin peut afficher sans souci plusieurs centaines de millier de
lignes. La réintégration de la fenétre des mesures a sa place initiale se fait simplement en
cliquant a nouveau sur le méme logo, ou en fermant la fenétre.

Sélections des sources

La sélection des sources peut étre effectuée soit par menus, soit par la souris, soit par une
expression de recherche.

Sélection par menus

Menu : Edition => Sélectionner ...
Raccourci:  Ctrl+A (tous les objets)
Script : select ...

Le menu principal « Edition » propose un sous-menu pour sélectionner toutes les sources, c’est-
a-dire toutes les sources présentes dans les plans catalogues de la pile. Il est également possible
de ne sélectionner que les sources d’un ou de certains plans spécifiques via le menu « Edition =>
selectionner tous les objets des plans sélectionnés ». 1l aura fallu au préalable sélectionner les
plans en question dans la pile (cf. 5.1.2).

Sélection par la souris

La sélection par la souris est la méthode la plus courante. Elle permet de choisir des sources en
fonction de leurs positions dans la vue.

» Pour sélection une source il suffit de cliquer dessus dans la vue ;

» Pour sélectionner plusieurs sources il est nécessaire de les englober dans un rectangle de
sélection. Pour cela, il faut cliquer sur une zone sans source légérement au-dessus a
gauche de la premiere source a sélectionner, puis tout en maintenant enfoncé le bouton de
la souris, étendre la sélection en déplacant le pointeur de la souris vers le bas a droite.
Lors de cette opération, un rectangle montre sur la vue la zone de sélection. Lorsque vous
relachez le bouton de la souris, toutes les sources a l’intérieur du rectangle seront
sélectionnées ;

» Pour ajouter des sources a une premiere sélection, procéder comme précédemment, mais
en maintenant enfoncée la touche Maj.

Sélection par expression de recherche

Menu : Catalogue => Chercher dans les catalogues chargés ...
Raccourci:  Ctrl+F
Script : search ...
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Aladin offre une méthode efficace pour sélectionner les sources en fonction des valeurs de leurs
mesures. Pour cela il est nécessaire de saisir une expression de recherche dans la petite boite
« Chercher » qui se trouve juste au-dessus a droite du ianneau des mesures.

I Chercher

La validation de I’expression de recherche par la touche « Entrée » entraine la sélection de toutes
les sources dont une des mesures répond a 1’expression de recherche. Seules les sources des
plans catalogues activés vont étre concernées (cf. 5.1.2 - activation d’un plan dans la pile). Si
I’expression de recherche est précédée du caractere ‘+’, les sources a sélectionner vont s’ajouter a
la sélection courante. De maniere opposée, la présence du caractére ‘- en début d’expression de
recherche entrainera la désélection des sources concernées parmi les sources préalablement
sélectionnées, c’est-a-dire qu’elle les fera disparaitre de la tables des mesures.

L’expression de recherche suit une syntaxe simple et efficace. Ce peut étre :
> une chaine de texte ;
» incluant éventuellement des caracteres jokers: ‘?’ (n’importe quel caractére), *’
(n’importe quelle suite de caracteres) ;
» éventuellement précédé d’un nom de colonne et d’un opérateur de test (=, !=, <, >, <=,
>=) pour restreindre la recherche a une colonne particuliéere ;

D’autre part :
> le nom de colonne peut inclure des caractéres jokers (‘ ?’ ou ‘*’) ;
» le nom de colonne peut étre encadré par deux barres verticales ‘|’ pour indiquer la valeur
absolue ;
» il n’y a pas de distinction entre majuscules et minuscules que ce soit pour le nom de la
colonne ou pour la valeur.

Remarque : par commodité, la recherche d’une chaine de texte simple sans indication de colonne
particuliére est toujours considérée comme une sous chaine a rechercher. Par exemple : la
recherche « gal » sera de fait « *gal* ».

Quelques exemples :

» Star les sources dont les mesures comportent le mot « star »

» otype=uv les sources dont la colonne « otype » a la valeur « uv »

» mag*>=12 premiere colonne dont le nom commence par « mag », la valeur numérique
doit étre supérieure ou égale a 12

> |pm*|<5 méme principe que précédemment mais seule la valeur absolue est prise en
compte

» type!=g* colonne « type » dont les valeurs ne commencent pas par la lettre ‘g’

» bmag!="" colonne « bmag » non vide

Désélection

Menu : Edition => Désélectionner les objets ...
Raccourci : Curl+U

» Pour désélectionner une source d’une sélection précédente, cliquez sur la source en
question en maintenant appuyée la touche Maj
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» Alternativement cliquer sur sa ligne dans la fenétre des mesures puis utiliser le menu
contextuel « Déselectionner cette source » ou Maj-Clic.

» Pour désélection toutes les sources — ce qui revient a « vider » la table des mesures - il
suffit de cliquer dans la vue n’importe ou en dehors de toute source ou encore d’utiliser le
menu « Edition => désélectionner toutes les sources ».

Astuce : Pour éviter de « perdre » accidentellement une sélection, vous pouvez « cocher » les
sources de votre table afin de pouvoir les resélectionner ultérieurement (cf. paragraphe ci-
dessous).

Compteurs
Le rapport du nombre de sources sélectionnées (c'est-a-dire dont les mesures sont affichées) sur
le nombre total de sources apparait dans le compteur en bas a droite de la fenétre d’Aladin.

218 sel £ 1999 =rc

Navigation dans les mesures

L’exploration des mesures, et notamment la visualisation rapide de la source associée, passe par
la sélection d’une ligne particuliere de la table des mesures. La ligne sélectionnée apparait en
fond bleuté « fixé sur la ligne » méme si la souris ne s’y trouve pas.

La sélection d’une ligne de mesures se fait soit manuellement au moyen de la souris soit par
expression de recherche.

Sélection d’une ligne de mesure par la souris

La sélection par la souris se fait soit dans le panneau des mesures par un simple clic souris (hors
d’un lien Web ou d’un bouton), soit dans la vue en cliquant sur une source sélectionnée (carré
vert). Cela entraine le déplacement du réticule (croix magenta) sur la source correspondante. Et
dans le cas ou la sélection s’est faite via le tableau par un double-clic il y a centrage automatique
de la vue sur la source (a moins que la vue n’ait été « verrouillée » - cf. 5.1.4).

Sélection d’une ligne de mesure via une expression

La boite de saisie utilisée pour sélectionner les sources permet également de sélectionner une
ligne particuliere de mesures. Ainsi la saisie d’une expression - SANS effectuer la validation
(sans appuyer Entrée) - et ’'usage des deux fleches a droite de la boite de saisie perrrm
sélectionner la ligne suivante/précédente des mesures correspondante a 1’expression. Les to

« fleche HAUT » « fleche BAS », ou la molette de la souris permet également de passer a la
mesure suivante, respectivement précédente. Comme pour la sélection via la souris, la vue se
centre automatiquement sur la source correspondante. Si 1’expression est vide, ce sera la ligne
suivante ou précédente qui sera simplement sélectionnée.

Parcours des sources et mesures d’un plan

En utilisant le méme mécanisme des deux fléches décrit au paragraphe précédent, il est possible
de parcourir I’ensemble des mesures d’un plan. Ouvrir le menu contextuel en cliquant avec le
cliquet de droite sur le nom du plan dans la pile et choisir le menu « Parcourir les objets du
plan ». Un recentrage automatique de la vue sur l'objet correspondant a la ligne de
mesure courante est opéré.
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Désélection

La désélection de la ligne se fait par simple clic dans le panneau des mesures (en dehors d’un lien
Web ou d’un bouton).

Comportements inhibés

Lorsqu’une ligne de mesure est sélectionnée, certains comportements automatiques sont inhibés :

¢ L’en-téte du panneau des mesures reste celui associé a la ligne sélectionnée méme si la souris
se déplace hors de la ligne en question (ceci permet notamment d’effectuer un tri sur cette
table) ;

+ Le déplacement de la souris, dans la vue, sur les autres sources sélectionnées ne fera plus
défiler les mesures associées.

Coche sur les mesures

Menu : Edition => Cocher ..., Décocher...
Menu contextuel : Cocher..., Décocher..., Garder...
Script : tag... untag ...

Un petit carré de couleur apparait a gauche de chaque ligne de mesures. Il
permet non seulement de repérer le plan d’origine des données par le code
couleur, mais également de « cocher » certaines lignes et, de ce fait les sources
correspondantes, afin de les retrouver aisément ultérieurement.

Deux menus permettent de manipuler les sources « cochées » :
» Le menu qui apparait en cliquant sur 1’épinglette en entéte de la colonne
des coches ;
» Le menu principal « Edition ».

Dans la vue, les sources dont les lignes des mesures sont cochées apparaissent avec un carré
magenta a la place du carré vert habituel.

Ajouter/calculer une nouvelle colonne

Aladin offre la possibilité d’ajouter une nouvelle colonne de valeurs. Cette opération est décrite
en détail dans la section 5.13.

5.2 Le sélecteur de serveurs

Menu : Fichier => Ouvrir le sélecteur de serveurs ...
Raccourci: Ctrl+L
Script : get ..., load ...

De maniere complémentaire a I’arbre des collections des données, Aladin permet d’accéder
directement a certains formulaires dédiés a des serveurs spécifiques. Il s’agit de la fenétre du
« sélecteur de serveurs »

4
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@ Sélecteur de serveurs — O x

[@Fne T\F\%}V ﬁfi‘%u_._}

O Solar system object database from IMCCE 9

i-al Position (ICRS, name) 16 32 26.0999200 -24 28 43.210500 {}) ém
ASkyView
- Rayon 3L117
‘@ WAladin [
“Hips2fits| Epoch TAP
Observer location 500 &'«Gaia
Search for Asteroids and Planets ~ Wa
SkyBot
Max. uncertainty 120 arcsec v
@NED
Filtre d'affichage Arrow of motion “

Obtenir les coord. pour cet objet... INFO serveur _

Réinit. Effacer CHERCHER Fermer | (@)

Cette fenétre se présente sous la forme de plusieurs formulaires d’interrogations sélectionnables
au moyen d’onglets. Les onglets a gauche de la fenétre concernent les serveurs d’images, ceux a
droites les serveurs de données tabulaires.

Ces onglets et formulaires peuvent évoluer au cours du temps en fonction des nouvelles
possibilités offertes par la communauté astronomique.

5.2.1 Saisie des informations

La plupart de ces formulaires nécessitent la saisie d’au moins deux éléments indispensables a une
interrogation par cone, a savoir une position et un rayon.

La position peut étre soit un identificateur d’objet astronomique reconnu par le mécanisme
Sesame du CDS (recherche dans Simbad + NED + quelques grands catalogues), soit des
coordonnées astronomiques exprimées dans le référentiel courant (cf. 5.1.7).

Le rayon d’interrogation correspond au rayon du cone d’interrogation sur le ciel. Cette valeur
peut étre suivi d’une unité (« °», «'» « "» ou « deg », « arcmin », « arcsec »). L’unité par défaut
est la minute d’arc. Il est également possible d’indiquer une zone rectangulaire en utilisant la
syntaxe suivante : W x H ou W et la largeur du rectangle en ascension droite et H la hauteur du
rectangle en déclinaison. Ces deux valeurs peuvent étre suivies par une unité. Dans le cas ou le
serveur interrogé ne supporte que I’interrogation par céne (resp. par rectangle), Aladin choisira
toujours une zone couvrant totalement le champ désigné (cercle englobant, resp. rectangle
englobant).

47



Saisie automatique

Dans le formulaire courant, la position et le rayon sont automatiquement renseignés en fonction
des données précédemment chargées afin de couvrir le méme champ sur le ciel. Il est également
possible de désigner explicitement une zone du ciel sur une image déja chargée au moyen du

bouton « cible » € qui apparait derriere le champ de saisie de la position. Aladin vous invite a
désigner la zone en cliquant/glissant/relachant dans la vue.

Lors du passage d’un formulaire a un autre via les onglets, les valeurs indiquées dans le premier
formulaire seront conservées dans le second formulaire.

5.2.2 Liste et arbre

Certains serveurs nécessitent deux étapes pour charger les données : tout d’abord désigner la

zone du ciel, puis pour sélectionner parmi les images ou catalogues disponibles ceux que vous

souhaitez charger. Lors de la deuxiéme étape, Aladin affiche les données disponibles sous la
forme d’une liste ou d’un arbre. Cette liste/arbre dispose de nombreuses fonctions :

» Le déplacement de la souris sur un élément affiche dans la fenétre principale le ou les champs
de vue correspondants ;

» Lorsque les données sont sous forme d’arbre, un clic droit fait apparaitre un sous-menu de
controle de 1’arbre ;

» Lorsque les données sont sous forme de liste, il est possible de les trier en cliquant sur I’en-
téte des colonnes ;

» Un clic sur un élément affiche les informations relatives a cette donnée ainsi que certains
parametres d’interrogations spécifiques ;

» Chaque élément est précédé d’une case a cocher qui permet de désigner plusieurs éléments a
charger. Ces cases peuvent étre
cochées soit manuellement soit en
cliquant dans la vue afin de ne
désigner que les éléments qui
contiennent  explicitement la
position cliquée. Le bouton
« Réinit. »  permet de  dé-
sélectionner toutes les coches. Le
bouton « Effacer » supprime la
liste / I’arbre.

Filter u
—+] Filter g
-] Filter r
Sloan pigital sky surwey - Filter

13.8' x 9.9'

Sloan Digital sky Filter r 13.6' x 9.9
13.68' x 5.9

L L

Sloan pigital sky survey - Filter

i B . L E e e P AL (= n T

r
Sloan Digital sky Survey - Filter r 13.6' x 9.9'
-
r

5.2.3 Quelques formulaires spécifiques

@ « File » - Accés local ou par URL.
File

Ce formulaire permet de charger des données personnelles, soit via des fichiers
locaux, soit via une adresse Web (url). Ces données doivent étre fournies dans un standard
compatible avec 1I’'un des nombreux formats supportées par Aladin (cf. 8.1). Le bouton
« Parcourir » permet de naviguer dans le sélecteur de fichiers de votre systeme d’exploitation
afin de désigner le fichier concerné.

Astuce : Les données locales peuvent également étre chargées en cliquant/déplacant 1’icone d’un

fichier depuis une fenétre de votre bureau ou de votre gestionnaire de fichier, dans la fenétre
Aladin. Idem pour les images ou liens affichés dans un navigateur Web.
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Astuce : Dans le cas ou il s’agit d’un nom de répertoire local, Aladin va explorer 1’ensemble du
contenu du répertoire et de ses sous-répertoires et en construire un arbre de données disponibles.
Il laissera un fichier nommé « .aladin_idha » qui lui permettra de recharger rapidement cette

description lors d’une autre utilisation.

@V « FOV » - Les champs instrumentaux

Ce formulaire permet d’accéder a une liste
de description de champs de vue instrumentaux (« FoV »)
d’un grand nombre de télescopes. Ces champs vont
pouvoir étre superposés aux images pour, par exemple,
préparer une mission d’observation. Ils pourront étre
éventuellement déplacés, voire tournés au moyen d’une
sélection a la souris.

Il est possible de définir ses propres champs
instrumentaux sous la forme d’un fichier XML. Vous
trouverez la description de la syntaxe et quelques

exemples a I’adresse suivante : http://aladin.cds.unistra.fr/java/FAQ.htx#FoV.

TAP

« TAP » - L’accés aux serveurs compatibles TAP

Cet onglet donne accés aux serveurs compatibles avec le protocole d’acces TAP (« Table Access

Protocol »). L’activation de cet onglet [ & 1., ool
fait apparaitre une liste de serveurs
présélectionnés par le CDS, ainsi que la

Specifier [URL de base d'un serveur TAP

Ou choississez dans |a liste d-dessous :

- O X

CHARGER

liste exhaustive des SEIVEUTS | serveurs présclectiomés Liste axumutive
compatibles. Bien que ce mode | . Desaipton 7 i
d’interrogation Soit également proposé CDS/Simbad SIMBAD Astronomical Database http: fsimbad.u-strasbg. fr fsimbad fsim-tap

. s . . ~ archive,stsd.edufcaomtap  MAST STScI CAOM and ObsCore TAP ... http://vao.stsd.edu/CAOMTAP [TapService
via I’arbre des collections il peut étre |asdci= ASDC TAP Service http:/jtools.asdc.asi t/TAP

. o1 . cadc.nrc.caftap CADC Table Query (TAF) Service http:/fwww.cadc-ccda. hia-ha. nre-cnre. g
plus Prathue d’utlhser Cet Onglet S1 l,on cds, vizier /tap TAP VizieR guery engine http://tapvizier.u-strasbg. fr/TAPVizieR, /tap
3 3 irsa.ipac/tap IRSA Table Access Protocol (TAP) Ser... https:/firsa.ipac. caltech.edu/TAP

Souhalte. lnterroger U‘Il serveur TAP org.gavo.dcftap GAVO Data Center TAP service http:/{dc.zah.uni-heidelberg.deftap
particulier. Une fois le serveur
sélectionné, un formulaire |- 2
d’interrogation TAP vous est proposé CHARGER | | Fermer
(cf. 5.3).

j?%kw.ﬁm-.r « SkyView » - Le serveur d’images d’HEASARC/NASA

SkyView est un service de génération d’images géré par HEASARC/NASA. 1l
fournit des images issues d’un trés grand nombre de relevés de référence, rééchantillonnées

ﬁ’f«iaia

« Gaia » - Le catalogue astrométrique de référence

dynamiquement dans une projection choisie par I’utilisateur.

Gaia est LE catalogue astrométrique de référence issue de la mission européenne du méme nom.
Il contient pas loin de deux milliards de sources dont la précision astrométrique est inégalée.
Faisant partie du consortium de distribution de ce catalogue (CU9), le CDS propose ce

formulaire spécifique.
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m « SkyBot » - Les objets du systeme solaire (hormis les planétes)
SkyBot

L’onglet « SkyBot » ouvre un formulaire d’acces aux objets du systeme solaire (hors
planetes). L’institut de mécanique céleste de Paris (IMCCE) met a disposition d’Aladin sa base

de données des éphémérides ce qui
permet de trouver avec une O Solar system object database from IMCCE )
excellente PrGClSlOIl les\ aster01d'e5 Position (ICRS, name) 05 34 22,89335 +22 00 24,3046 13
et ,autres objets du systgme solaire Rayon g
présents sur votre image en
. 5z . Epoch 1992-12-17T01:56:55

fonction de 1’époque de celle-ci.

Observer location 500

Search for Asteroids and Planets ~
Le champ pour indiquer la date est | Max uncertainty 120 arcsec v
automatiquement  renseigné  en | pyre gaffichage Arrow of motion »
fonction de 1’époque de I’image
courante. Obtenir les coord. pour cet objet+ép... INFO serveur

A noter : I’époque indiquée dans I’en-téte de 1’image n’est pas toujours tres précises d’ou de
possibles erreurs de positionnements. Dans ce cas, il vous sera nécessaire de renseigner
manuellement cette date.

D’autre part, il est possible de saisir dans le champ position le nom d’un astéroide ou d’une
comete afin que SkyBot le remplace par sa position céleste a la date mentionnée. Pour cela il est
nécessaire de presser le bouton « Obtenir les coord. pour cet objet+époque ».

o
i « VO » - Les acces génériques au VO

L’onglet VO propose une série de formulaires génériques propre a chacun des protocoles définis
par le VO - I’Observatoire Virtuel. Dans la mesure ou vous connaissez 1’adresse d’un serveur
spécifique compatible avec 1’'un des protocoles du VO, Geretic Simple Spectra access query
vous serez en mesure de pouvoir I’interroger Genetic Simple Image Access w2 query
directement. Generic Simple Image Access w1 query

Coverage server (M)

Genetic Cone Search query

5.2.4 Ajout d’un serveur personnel

La fenétre du « sélecteur de serveurs » peut étre adaptée a vos propres serveurs. Il est ainsi
possible de définir un serveur personnel qui ajoutera son propre onglet/formulaire. Pour ce faire,
il est nécessaire de créer un petit fichier donnant les informations tels que le nom, la description,
I’adresse Web, divers parametres, et de le charger dans Aladin comme n’importe quel autre
fichier. Afin de retrouver ce formulaire a chaque nouveau lancement il sera éventuellement
nécessaire de 1’indiquer sur la ligne de commande de démarrage d’Aladin :

java —Jjar Aladin.jar votreFichier

Exemple de fichier de description :

$ActionName MonServeur

$Aladin.Label Test

%Description Ceci est un exemple de serveur

$URL http://mon.site.web//base/reqgq?yy=5$1&xx=52
%$Param.Description Sl=Parametre 1

$Param.Description $2=Parametre 2

$ResultDataType Mime (image/fits)
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La syntaxe complete est décrite dans la FAQ d’Aladin
(http://aladin.cds.unistra.fr/java/FAQ.html#Glu).

Astuce : Un tel enregistrement peut étre copié/collé sans passer par un fichier.

5.3 Formulaires d’interrogation par criteres

Certains fournisseurs de données distribuent leurs collections au travers d’un protocole IVOA
particulier nommé TAP pour « Table Access Protocol ». Ce protocole d’interrogation permet a
I’utilisateur de rédiger puis de soumettre une requéte dans une syntaxe se référant a n’importe
quels champs de la structure de la base de données du serveur. Ces requétes doivent suivre la
syntaxe ADQL (Astronomical Data Query Language) définie par ’IVOA qui est un dérivé du
langage SQL °.

Bien que trés puissante et versatile, une telle requéte est ardue a construire. C’est pourquoi
Aladin offre deux types de formulaires pour vous aider a rédiger, puis a soumettre une telle
requéte. Ceux-ci vous sont proposés depuis le « fenétre d’acces » qui apparait lorsque vous
cliquez sur le nom d’une collection de I’arbre des collections (cf. 1). Le formulaire simplifié sera
appelé si vous sélectionné le sélecteur « custom », tandis que le formulaire générique TAP est
associé au sélecteur « par criteres TAP ».

Formulaire TAP simplifié (« custom »)

Le formulaire TAP simplifié a été
« customisé » au préalable par le CDS afin
de vous permettre de contraindre une liste | Target(ICRS, name) 1403 12.5830100 +54 20 55.500000
prédéfinie de critéres, concernant une ou | padius »

plusieurs tables de la base de données que
vous souhaitez interroger.

= Gaia DR3 via TAP Vizier 0

Table "1/355/gaiadr3"

Parallax [mas] (ex: >...

Ce formulaire est facile d’utilisation mais | Parallax over its error

ne vous permet pas de choisir un autre
critere que ceux sélectionnés par le CDS.
La requéte ADQL correspondant a vos
sélections apparait en bas du formulaire, et
si vous le souhaitez, vous pourrez
éventuellement 1’éditer directement, puis la
soumettre.

Shttp://www.ivoa.net/documents/latest/ ADQL.html

Gmag (ex: 13..14)
Bpmag (ex: 13..14)
Rpmag (ex: 13..14)

Total proper motion [...

Max records TOP 1000 - first 1000

Qutput columns * - all columns

Chedc.. SYNC  ~r
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Formulaire TAP générique (« par critéres »)

Le formulaire TAP générique quant a lui expose I’ensemble des tables et critéres d’interrogations
possibles. Vous devrez sélectionner la table a interroger a moins qu’elle n’ait été
automatiquement présélectionnée. Puis a ’aide des boutons de controles, ajouter les contraintes
que vous souhaitez sur Chacun des Champs dlspombles Le point d’interrogation en haut du

i formulaire ouvre une nouvelle

= () 9 esavol/hsaltap 0 Made: Generic ©  fenétre affichant les
Géndrez, vérifiez et exécutez votre requéte, descriptiOHS et autres méta
| Table: hsa.v_active_observation . Set ra, dec Jain dOHHéES aSSOCiéeS é Chaqlle

champ de chaque table. Un tel
formulaire requiére de fait une
5 bonne connaissance de la

| Select [ Al Constraints:  Add new Max rows: 9%93 -

Target 22 48 14.66795 +58 04 54.2813 H .
. 4 structure interne de la base de
1.082' CIRCLE Add 7 .
Rapon données du fournisseur.
Ra= 342.06112 Dec= 58.08174 Radius= 0.01803 X .

Comme pour le formulaire
simplifié, la requéte ADQL
correspondante s’affiche dans
le panneau en bas. Vous

” ol pouvez éventuellement 1’éditer

3 : : manuellement, puis il ne vous

Refresh query Check.. SYNC ~ Async jobs>> N

reste qu’a soumettre votre

|SELECT TOP 9999 * FROM hsa.v_active_observation WHERE - requéte.

| CONTAINS(POINT(ICRS', ra, dec), CIRCLE{CRS", 342.06712, 58.08174,

|0.07803) = 1
Intéressons-nous  maintenant
au filtrage de 1’arbre des

k= collections.

Réinit. Effacer CHERCHER Fermer ()

5.4 Le filtrage de 1’arbre des collections

Icone :
Menu : Fichier => Filtrer les collections disponibles ...

L’arbre des collections présente plusieurs dizaines de milliers de collections. De maniere
complémentaire au filtre sur simple mot-clé présenté a la section 5.1.1, Aladin offre un
mécanisme sophistiqué et rapide pour ne visualiser que les collections répondants a certains
critéres. Ceux-ci peuvent étre de différentes natures : temporels, spatiaux, en flux, ou sur toute
caractéristique qui aura été associée a une collection.

L’ouverture de la fenétre de filtrage s’effectue par I’icone a droite du
A . . . LED - |iste de t il—
sélecteur en bas de 1’arbre, ou au moyen du menu « Fichier -> Filtrer Slederae

les collections disponibles... »
Cette fenétre comporte une partie centrale a 4 onglets, chacun d’eux regroupant les sélecteurs et
champs de saisies propres a une catégorie de contraintes :
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> Contraintes globales ; @F\ItresurI‘arbrededécuuvertedesdonnées - (] x

» Spécifiques aux catalogues ; Womdufite [ ]

> Couverture; Cortrateschbsest| Spéfies amcadlpes | Comertre [ T |

» Techniques.

ot g | |

La partie basse de la fenétre affiche 1’expression catore @ g;ﬂl’v EZZ?:; SZ;:;.. Clpatabase  [Jimsge
logique correspondante aux contraintes renseignées e @ EF9 rtew Onow v
a travers les onglets. Et juste en dessous, en couleur Lo e e R
verte, le nombre de collections retenues par la régle | “<“ @ ——
de filtrage et affichées désormais dans 1’arbre des S - - E
collections. = 9 = Ze = |
La partie haute de la fenétre permet de nommer le |~ ¢
filtrage ainsi créé et de le sauvegarder pour une | “**** @ ——
utilisation ultérieure, éventuellement dans une

prochaine session d’Aladin. Celui-ci sera désormais
disponible dans le sélecteur sous 1’arbre.

obs_regime=Radio

— Filtre activé — collections retenues: 4331

Propriétés et couvertures

Le systtme de filtrage d’Aladin utilise les

propriétés associées a chacune des collections de I’arbre. Ces propriétés sont représentées sous la
forme d’une liste de mots-clés prédéfinis auxquels le fournisseur de la collection a associer une
ou plusieurs valeurs numériques, ou dans un vocabulaire spécifique ou libre. Ces propriétés
peuvent étre consultées en affichant le « fenétre d’acceés » associé a la collection sélectionnée,
puis en cliquant sur I’icone B

obs_title
obs_description

ng exposure correctiol
acarsseninar - s mages are cresas rron sse o REStTiCtion d’usage : Les collections sont distribuées par de

event files, where R is 0.4-1.5 keV, C is 1.5-4 keV and B is 4

Suzaku public data image
Superposition of Suzaku pseudo-color im:

& JAXA/P/SUZAKU properties - o x

s release e - i 15dpct " Pour le filtrage spatial, Aladin utilise 1’ensemble des MOC,
Mipa_ e Gaeorta cad les couvertures sur la sphere célestes de chaque collection
remtar T SRz oears. ran sarsansy (cf. 4)

hips_copyright = Public . .

M referance - X07PASY...555. 1K nombreux fournisseurs de données de par le monde. Méme si
T A e Sy 351 ceux-ci s’activent a décrire leurs collections dans des standards
ST Dggmmmemerm et 1 IVOA communs, certaines divergences existent principalement
i - i sur les mots clés a renseigner ou non, et sur le vocabulaire a
Tl D Aanesten 9.0 employer pour telle ou telle propriété. Cet hétérogénéité sur les
e L méta-données doit étre prise en compte lors de la mise au point
TG AT . s S d’une regle de filtrage, et les résultats obtenues ne sont que le
Mbpiese - boouss reflet de la qualité des descriptions initiales. D’autre part, les
:pp“ydfw s couvertures (MOC) ne sont pas systématiquement fournies par
< i >~ les fournisseurs de données. Ces collections ne pourront donc

Fermer

étre filtrées spatialement et/ou temporellement.

Note technique : Le filtrage d'Aladin s'appuie sur une librairie développée par le CDS, implantée
d'une part dans le client Aladin lui-méme et d'autre part dans un serveur distant : le MocServer’.
L'utilisation conjointe de ces deux éléments offre un filtrage a la fois puissant, souple et tres

7

http://alasky.cds.unistra.fr/MocServer/query
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rapide. Quelques détails techniques sur ce mécanisme sont fournis dans la section 8.3 en fin de
document.

Syntaxe des réegles de filtrage des collections

De maniere alternative aux sélecteurs du formulaire des filtres, vous pouvez saisir directement
une régle de filtrage sous sa forme interne, cad une chaine décrivant une série de conditions.
Ainsi, une regle basique est une condition a remplir sous la forme d’une expression « mot-clé =
valeur ». Cette chaine de caractere peut étre directement passée dans le champ « Select » sous
I’arbre des collections, ou dans la partie basse du formulaire des filtres.

Exemple : ID = CDS/P/DSS2/color

Dans cette condition, le mot-clé n’est rien d’autre que le nom d’un champ des propriétés
associées a chaque collection. Ce peut également étre une liste séparés par des virgules. Les
jokers « * » (n’importe quelle suite de caracteres) et « ? » (un caracteére quelconque) peuvent étre
inclus. De la méme maniere la valeur peut étre unique, ou multiple (séparées par des virgules), et
peut intégrer également des jokers. Un intervalle est représenté par ses deux bornes séparées par
deux points consécutifs (..). Enfin la condition n’est pas limitée a 1’égalité (=) mais peut étre
également la différence ( !=) et les comparaisons sur les valeurs numériques ou sur les dates
(>,<,>=, <=).

Plusieurs conditions simultanées peuvent étre organisées en utilisant les opérateurs logiques ET
(&&), OU (|)), SAUF (&!) ainsi que les parentheses pour garantir 1’ordre des opérations
logiques.

Exemples :
» ID = CDS*,ESA: dont’ID commence par « CDS » ou « ESA »
> obs_* = *NASA* : dont I’'une des champs commengant par « obs_ » contient le mot
« NASA »
> bib _year = 1996 .. 2000 : année de publication entre 1996 et 2000 inclus
> moc_order < 3 && (moc_order > 10 || moc_skyfraction = 1)
> hips builder = !'* :dontle champ hips_builder est vide
> obs _regime = X-ray,UV &! ID = CDS* :dont|’obs_regime est « X-ray » ou

« UV », sauf si I’ID commence par « CDS »

A noter : Lorsque le champ n’est pas renseigné, la collection est écartée a 1’exception notable de
la condition « =!* » c’est-a-dire « vide »

5.5 Le gestionnaire de la dynamique des pixels

Bouton pixel

Menu : Image => Constraste des pixels
Raccourci : Cul+M

Type d’images : HiPS et images classiques
Script : cm

Aladin utilise un algorithme spécifique pour visualiser au mieux le contraste des images
astronomiques. Celles-ci se caractérisent par une dynamique de valeurs de pixels souvent tres
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large, et avec parfois des valeurs aberrantes (bord du détecteur, saturation, valeurs inconnues...).
Or le rendu visuel « monochrome » (ou en fausses couleurs) ne peut prendre généralement que
256 valeurs sur votre carte graphique. Par conséquent Aladin effectue un échantillonnage des
pixels afin d’appliquer un seuillage : toutes les valeurs de pixels inférieures au seuil bas seront
affichées en blanc, celles au-dessus du seuil haut en noir, et les valeurs intermédiaires seront
converties entre 0 et 255. Le « seuillage automatique » d’Aladin donne la plupart du temps un
bon contraste sur les pixels « intéressants ».

Les 256 valeurs de pixels peuvent étre affichées soit en niveau de gris, en positif ou en négatif,
soit avec une table de couleurs faisant correspondre a chaque valeur de pixel une couleur
particuliere.

Il est cependant possible que les pixels « intéressants » ne soient pas ceux qui vous intéressent,
ou encore que 1’algorithme de seuillage automatique ne soit pas bien adapté aux caractéristiques
des images que vous visualisez. Pour ajuster manuellement la dynamique des pixels, vous
utiliserez le menu « Image => Contraste des pixels », ou plus directement le bouton « pixel »
accessible dans la barre d’outils.

La fenétre de la dynamique des pixels se lit de haut en bas de la maniére suivante :
» La barre du haut schématise la totalité des valeurs des pixels présentes dans I’image. La
zone en bleu correspond a la plage des valeurs retenues par Aladin pour étre visualisés ;
» Le rectangle du milieu affiche I’histogramme de répartition des pixels retenus et en
surimpression la fonction de transfert appliquée pour convertir la plage de valeurs
retenues en 256 valeurs ;

. , & Dynamique des pixels: M101 - m} s
» Enfin, la barre en bas présente la
o . Prévisualisation () Dyn: Seuil local | | Toutes les valeurs | Conf. par deéfaut 9
table des couleurs choisies pour
4 A 21 Flage des valeurs 28304
représenter les 256 valeurs calculées. | |
Exemple : ci-contre les valeurs des pixels %79 Pixeis vsiles (22710
sont comprises entre 21 et 28304, la plage | @ Astr o plagelces pels s
. . ainsi que la table
retenue comporte les pixels compris entre des couleurs associée
3879 et 22710 qui sont convertis en 256 Réinit.
niveaux de gris en suivant une fonction de .
. ya Inverser
transfert linéaire. 4 - 4 .
Table des couleurs gray « |Linear
9 REinit, CM sur vue
Appliquer aux images sélectionnées | | Calculette... | |Fermer

Plusieurs boutons, sélecteur et zones sensibles vous permettent d’ajuster les parametres de
’algorithme de rendu des pixels.

Ajustement du contraste et de la luminosité

» « Sans réfléchir » : La méthode la plus simple reprend la
technique implantée dans le logiciel « DS9 » : au moyen
de la souris, cliquez et maintenez appuyé le bouton de
droite, puis déplacez la souris sur la surface de la vue,
vous serez a méme d’ajuster intuitivement a la fois le
contraste et la luminosité suivant la position de la souris
dans le cadre de la vue.
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» «En réfléchissant » : Dans la fenétre du
controle des pixels, vous pouvez dans un
premier temps ajuster les valeurs de la plage
retenue soit en saisissant manuellement (et
validant par la touche entrée) celles-ci dans les
champs numériques au-dessus de
I’histogramme des pixels, soit par un

Powd

cliquer/glisser sur les limites droite ou gauche 4 & A

de la plage des valeurs (barre du haut). Cette

action force Aladin a relire la totalité des pixels du fichier image. Cela peut prendre
quelques dixiéemes de secondes voire davantage suivant la taille de 1’image. Une
possibilité alternative, bien plus rapide, consiste a jouer uniquement sur la méthode de
conversion de la plage retenue, sans en changer les bornes. Pour cela il est possible
d’agir tout d’abord sur la fonction de transfert. Par défaut linéaire, elle peut étre
remplacée par ’une des fonctions suivantes : Asinh, Log, Sqrt, Pow2. Ensuite, afin
d’affiner votre fonction, une deuxiéme opération, linéaire sur deux segments, peut étre
appliquée par composition a votre premier choix. Pour cela vous devez jouer sur les 3
triangles de contréles placés sous I’histogramme afin de déterminer les pentes
respectives des deux segments.

Astuce : La recherche manuelle de la plage des pixels « intéressants » a visualiser peut s’avérer
fastidieuse, et varier d’une région a 1’autre d’une méme image (centre d’une étoile, fond du ciel).
Le bouton « Seuil local » demande a Aladin d’appliquer son algorithme de seuillage
uniquement autour de la position courante du réticule, et sur un rayon d’un sixieme  Seuil local
de la vue courante. Ainsi pour ajuster le contraste sur une étoile ou une galaxie
spécifique, il suffit de cliquer dessus, d’ajuster le zoom puis d’activer le bouton « Seuil local ».

Note : Cette action de seuillage automatique pointé est toujours appliquée lorsque 1I’on
active I’icone « adr » (sous la vue). L

Tables des couleurs

Aladin dispose de quelques tables de couleurs courantes en astronomie. Celles-ci peuvent étre
non seulement ajustées via le contrdle de la fonction de transfert comme indiqué précédemment,
mais également inversées.

Astuce : Le bouton « CM sur vue » permet d’afficher la table des couleurs en surimpression dans
la vue. Sa taille et sa position pourront étre modifiées en cliquant sur la table des
couleurs, puis en agissant sur les poignées de controles.

CM sur vue

Voici la liste des tables des couleurs avec une fonction de transfert linéaire simple et leur rendu
en mode normal et en mode inversé :

» Gray:
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> Stern :

> Rainbow:

> Fosb:

> Fire :

> Cubhlx :

> Polar:

A noter : Les utilisateurs d’IDL peuvent également charger dynamiquement une table des
couleurs IDL via la librairie IDL-Aladin (cf.7.5).

Exploration rapide des pixels

En survolant la barre de la table des couleurs avec le pointeur de
la souris, Aladin va utiliser temporairement une table des
couleurs particuliére afin de mettre en évidence les positions des
pixels correspondants dans 1’image. L’image sera affichée en
niveau de gris, et les pixels concernés en cyan.

Images particuliéeres, cas particuliers

Lorsqu’il s’agit d’une image en vraies couleurs, ou d’un cube d’images, la fenétre est adaptée en
fonction de la nature des pixels.

Image couleur

Aladin peut manipuler des images en
« vraies » couleurs (composition
colorées — cf. 5.15, images JPEG, PNG
ou FITS couleur). Dans ce cas, il n’y a
pas de seuillage automatique et la fenétre
de controle de la dynamique fait
apparaitre 3 histogrammes les uns au-
dessus des autres, munis de leurs
curseurs de controle, correspondants a la
répartition des valeurs de pixels dans les
3 composantes Rouge, Vert et Bleu.




Chaque histogramme est muni de ses 3 curseurs de controles comme pour une image classique.
Le maintien appuyé de la touche Maj lors du déplacement d’un curseur synchronise les curseurs
des 2 autres composantes couleurs permettant d’effectuer un ajustement simultanément sur les 3
composantes.

Cubes d’images

Aladin peut manipuler des cubes d’images (cf. 5.16 - associations d’images, ou cubes FITS).
Dans ce cas I’histogramme de la répartition des pixels ne concerne que I’image en cours
d’affichage. Si le cube est en cours de défilement, 1’histogramme évoluera dynamiquement en
fonction de I’image courante. Toutes les possibilités d’ajustement de la dynamique des pixels
sont les mémes que pour une image simple. Dans le cas de trés gros cubes (plusieurs centaines de
mégaoctets), les opérations de modifications du seuillage d’origine peuvent nécessiter quelques
secondes pour que le résultat soit visible sur I’ensemble des images composant le cube.

Aladin peut manipuler des images issues de capteur multi CCD. Celles-ci s’afficheront
simultanément dans la vue, mais n’auront pas nécessairement le méme ajustement de contraste.
Pour appliquer la méme fonction d’ajustement des pixels pour tous les capteurs CCD, utiliser le
bouton « Appliquer aux images sélectionnées » en bas de la fenétre des pixels.

HiPS image

Dans le cas d’image HiPS, la visualisation des pixels peut étre faite soit en mode
« Prévisualisation » soit en mode « Dynamique compléte ». Les ajustements de la dynamique de
pixels ne seront pleinement possibles que dans ce B

dernier mode. Prévisualisation (@) Dynamique complete
5.6 Geénérateur de contours

Bouton cont

Menu : Graphique => Tracer des contours...

Type d’images :  HiPS et images classiques

Script : contour ...
Aladin dispose d’un outil d’extraction de contours permettant [ seneratesr de contours - o x
de générer des isophotes d’une image. Le menu « Graphique N —
=> Tracer des contours... » ouvre une fenétre de controle vous | cnoississeziavaleur de chaque niveau
permettant d’ajuster le nombre d’isophotes souhaité ainsi que Pixel values histogram

leur niveau de pixel en regard de I’histogramme de
distributions des pixels présents dans 1’image. Il est possible
d’effectuer des lissages, ou de réduire le bruit de I’image avant
I’extraction des contours, ou encore de réduire 1’extraction a la

portion de I’image visible dans la vue. A 2 &

Générez 4w | niveaux équidistants
Les contours vont étre mémorisés dans un plan de la pﬂe, Ajouter manuellement un |nouveau niv.
superposable a I’image d’origine, mais également a d’autres
images (mémorisation des coordonnées célestes). Cette M Lissage acti  Niveaus delissage |2 v
propriété permet de comparer aisément deux images n’ayant, I Réuction du bruit
par exemple, pas la méme longueur d’ondes. [ Travailler sur a portion visible

maontrer FAIDE

Calcule R&init. Fermer ;



Astuce : La fenétre des propriétés associées a un plan
contour (menu : Edition => Propriétés) permet d’ajuster
a posteriori les niveaux et la couleur de chaque contour.

Restriction d’utilisation : 1’extraction de contour est
possible sur un relevé progressif (HiPS), mais il sera
automatiquement bridé au champ de vue courant. En interne, 1’algorithme de génération ne
travaille pas sur les pixels HEALPix, mais sur une sous-image extraite du relevé HiPS (cf. 5.1.5 -
L’outil de coupe).

5.7 Calculatrices

Aladin dispose de plusieurs outils pour vous aider dans vos calculs que ce soit sur les valeurs
numeériques courantes, ou s’il s’agit de valeurs de pixels ou de coordonnées sphériques. Aladin
offre également un outil de conversions pour les diverses unités.

5.7.1 Calcul algébrique par commande script

Menu : Outil => calculatrice...
Script : = expression

Pour tout calcul algébrique classique, vous pouvez directement saisir votre expression sous la
forme d’une commande script. Celle-ci doit simplement commencer par le caractére « =»
comme une formule de tableur. L’ensemble des opérateurs classiques, la prise en compte des
parentheses, et les fonctions mathématiques courantes sont supportés. Certaines fonctions
spécifiques a I’astronomie sont également prises en compte :

X,+,%*,/,%,/ addition, subtraction, multiplication, division, modulo, power
exp(x) Euler's number 'e' raised to the power of x

In(x) the natural logarithm (base 'e") of x

log(x) the base 10 logarithm of x

sqrt(x) the correctly rounded positive square root of x

ceil(x) the largest (closest to positive infinity) integer value
floor(x) the smallest (closest to negative infinity) integer value
round(x) the value of the argument rounded to the nearest integer
abs(x) the absolute value of the argument

sin(x) trigonometric sine of an angle (x in radians)

cos(x) trigonometric cosine of an angle (x in radians)

tan(x) trigonometric tangent of an angle (x in degrees)

asin(x) the arc sine of a value (result in radians)

acos(x) the arc cosine of a value (result in radians)

atan(x) the arc tangent of a value (result in radians)

sinh(x) the hyperbolic sine of x

cosh(x) the hyperbolic cosine of x

tanh(x) the hyperbolic tangent of x

sind,cosd,tand
asind,acosd,atad

trigonometric functions of an angle (x in degress)
the arc trigonometric functions (result in degrees)

rad2deg(a) the measurement of the angle a in radians

deg2rad(a) the measurement of the angle a in degrees

min(x,y) the smaller of x and y

max(x,y) the larger of x and y

atan2(x,y) the angle (in radians) corresponding to x,y in cartesian coordinates
atan2d(x,y) the angle (in degrees) corresponding to X,y in cartesian coordinates

dist(x1,y1,x2,y2)

cartesian distance between x1,y1 and x2,y2
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skydist(ral,del,ra2,de2)  spherical distance (coord in degrees or sexa with  :” as separator

Exemples :

= 3*8
1024 * (132E-7 +1/32.2)

-skydist (05:34:43.68,+21:59:28.1,184.50849,-05.79883)*-60 -sin ( -
round( 100+1e-03)%(3*2) + -cos(32.2+8"(7-5*max(3,1/8.7) ) )) * —(6-
2E+5)

Astuce : Le caractére « = » peut également étre inséré apres 1’expression algébrique plut6t qu’avant.

5.7.2 Conversion par commande script

Script : convert xxx unitl into unit2

Aladin intégre également une bibliothéque de conversion® prenant en compte la plupart des unités
physiques usuelles. Cette bibliotheque est utilisée au travers de la commande scripts « convert »
qui peut étre saisie directement dans le bandeau de commande.

La syntaxe est la suivante : convert xxx unitl into unit2.

La valeur est généralement un scalaire, ou une expression algébrique, ou éventuellement une
date, voire un nombre exprimé en sexagésimal (longitude ou latitude d’une coordonnée).

Les unités doivent étre I'une de celles du tableau ci-dessous, ou une combinaison d’unités
utilisant les opérateurs classiques (ex : km/s). Elles peuvent étre éventuellement préfixées par une
lettre spécifiant un multiple ou un sous-multiple (ex : mHz). La liste de ces multiples sont
données dans le deuxieme tableau.

solMass solar mass "date" Fully qualified date

gauss Gauss(10-4T) "YYYYMMDD" Fully qualified date (without separator)
pi pi(=3.14...) "h:m" hour minutes (sexagesimal time from
ph photon hours)

pc parsec muB (Bohr magneton)

yr year mp mp(proton_mass)

Ro (magnetic constant) A Angstroem(0.1nm)

geoMass Earth mass ct count

Ry Rydberg(13.6eV) me me(electron_mass)

JD Julian Date mu0 (magnetic constant)

\h hbar(Planck constant) "hhmmss" hour minutes seconds (sexagesimal time
inch inch without separator)

Hz Herz Pa Pascal

Angstrom Angstroem(0.1nm) cal calorie

Mgeo Earth mass cd candela(lumen/sr)

rad radian Ix lux(Im/m2)

"d:m:s" degree arcminute arcsecond (sexagesimal jovMass Jupiter mass

angle from degree) min minute

erg erg(10-7J) Im lumen

mas milli-second of arc byte byte(8bits)

"month" month solRad solar radius

eV electron-Volt alpha (fine structure constant)

"day" Day of month number arcmin minute of arc

mag magnitude uas micro-second of arc

"datime" Fully qualified date/time (ISO-8601)

¥Cette bibliothéque a été développée par le CDS pour manipuler les grandeurs physiques des catalogues gérés par le
service VizieR (http://vizier.cds.unistra.fr/doc/catstd.htx).
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"m:s"
minutes)
"h:m:s"
from hours)
au

kg

sec

al

bar

Lsun
mmHg
"MM/yy"
u

t

s

MJD

m

1

k

h

Wb
solLum
g
arcsec
e

d

C

a
dyn

wH<Lg Ve

Symbol Explanation Value

O T 3 2 3 Q Q

N

Yy

Exemples :
convert
convert
convert
convert

minutes seconds (sexagesimal time from R

R(gas_constant)

degree arcminute arcsecond (sexagesimal

Sun Solar unit
hour minutes seconds (sexagesimal time pix pixel

N Newton

K Kelvin
astronomical unit bit binary information unit
kilogram J Joule
second (use 's") H Henry
light-year G G(gravitation constant)
bar(10+5Pa) epsO (electric constant)
solar luminosity F Farad
mercury_mm D Debye (dipole)
Month/Year(from 2000 when yy<50) barn barn(10-28m2)
atomic mass unit C Coulomb
ton "MM/YY" Month/Year(from 1900)
second deg degree
Modified Julian Date (JD-2400000.5) Rsun solar radius
metre A Ampere
litre a0 (Bohr radius)
k(Boltzmann) ? pi(=3.14...)
hour mol mole
Weber(V.s) pas micro-second of arc
solar luminosity hr hour(use 'h')
gram atm atmosphere
second of arc Mjup Jupiter mass
e(electron_charge) % percent
day "ddmmss"
c(speed_of_light) angle without separator)
year degF Fahrenheit
dyne(10-5N) Jy Jansky(10-26W/m2/Hz)
steradian degC Celsius
hbar(Planck constant) Ohm Ohm(V/A)
Watt lyr light-year (c*yr)
Volt Msun solar mass
Tesla
Siemens(A/V)

Symbol Explanation Value

deci 107 da deca 10
centi 107 h hecto 107
milli 107 k kilo 107
micro (1)  10° M mega 10°
nano 107 G giga 100
pico 1077 T tera 10"
femto 107 P peta 107
atto 107 E exa 10"
zepto 107 z zetta 107
yocto 107 Y yotta 107

1/10m into nm =>1.0E§ nm

2a into d =>730.5d

20011210 "YYYYMMDD" into MJD  =>52253.0 MJD

10:10:8 "d:m:s" into deg

=>10.168888888888889 deg
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5.7.3 Calculatrice a pixels

Les calculs sur les valeurs des pixels sont | & calculatrice de pixels.. - o X
courants en astronomie car les images Physical - ioE | RET @e
utilisent la plupart du temps une fonction de |Mnenc. 500 32768 ! oovoo I
P . Datamin  |0.1568 1093 1 o000 [

transformation : le codage interne sous la _
Cutmin  |0.4654 3050 1 0-00-00 ||

forme d'un réel ou d'un entier (raw), va étre

Pixel value 2.914 19097 10 -DO-D0
multiplié par un facteur constant (mot-clé |cutmax 3.444 22568 55 )FDFD
FITS BSCALE), puis le résultat sera |Datamax |3.752 24584 55 |20
additionné a une autre constante (mot-clé |"=c =% 2757 SR Eaitait
FITS BZERO). La conversion de la valeur | gmolo BITPIX |16

de codage a la valeur physique représentée | sscaie 1524
suit donc la regle : valeur = BZERO +
BSCALE * raw.

D'autre part, pour l'affichage, cette valeur physique du pixel devra étre convertie en un index de
la table des couleurs (ou de niveaux de gris) compris entre 0 et 255, voire 1 et 255 si le canal 0
est utilisé pour la transparence. Cette conversion dépend des choix retenues pour régir la table

des couleurs (fonction de transfert, plage des valeurs physiques des pixels a afficher) (cf. 5.5).

BLAME. | MaM

Ces deux opérations de conversions peuvent étre gérées dans la calculatrice a pixel. Celle-ci
apparait dans une fenétre via le menu "Outil -> Calculatrice a pixels".

Ce formulaire peut étre utilisé librement en affectant manuellement les constantes BZERO et
BSCALE et la valeur d’un pixel. Ces valeurs, les parametres de la table des couleurs, et la valeur
du pixel seront automatiquement renseignées si vous cliquez dans une image présente dans la
vue.

5.7.4 Calculatrice a coordonnées

Tout comme pour les pixels, les calculs portant sur les coordonnées astronomiques sont tres
courants: conversions de la représentation sexagésimale ou décimale, changement de référentiel
spatial (ex: conversion B1875 en ICRS), prise en compte de 1'époque d'observation par rapport a
'époque d'affichage en connaissance du mouvement propre et/ou de la vitesse radiale, etc. Ces
calculs peuvent s'avérer complexes. Aladin vous offre une "calculatrice a coordonnées”
accessible par le menu "Outil -> Calculatrice a coordonnées".

Vous pouvez utiliser cette
calculatrice en  saisissant
directement les coordonnées
et les autres parametres de
position, puis en validant par
"Entrée" pour obtenir ces
mémes coordonnées dans les
autres systémes et autres
époques. Vous pouvez
également cliquer dans la vue,
voire dans la fenétre des
mesures, pour prendre en
compte la position sous la

@ Calculatrice de coordonnées...

PMRA (mas/yr) -B|
PMDEC (masyr) 22
Parallax (mas)

Dist (parsec)

Dist (light-year)
Radial velocity (km/s)

Origin epach (Jy) 2000.0
Target epoch {Jy) 2150.0
= —%

Ang.dist, from orig.loc 4,448

— | X

ICRS | 2045 39.63620 +30 43 15,1504
ICRSd |311.41515085 +30.72087511
Ediptic |325.6750358 +46.4810131

Gal 073.3056 -07.6304

SGal  |332.0409 +60.6039

J2000 |20 45 39.630 +30 43 15.13
J2000d|311.415151 +30.720875
B1950 |20 43 35.57 +30 32 16.3
B1950d|310.89321 +30.53736
B1900 |20 41 31.73 +30 21 23.5
B1875 |20 40 29.84 +30 15 59.7

souris. Dans le cas de mesures de catalogue, si celui-ci dispose d'information de mouvement
propre et/ou de vitesse radiale, ces parametres seront également renseignés et utilisés.
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5.7.5 Calculatrice de temps

Aladin dispose d’un petit utilitaire pour convertir les dates. Il @ Calculatic..  — O *

est accessible par le menu « Outils — Calcultatrice de |IS0 time: 1967-05-05T00:00:00)

temps ». Cet outil permet d’obtenir les équivalences entre une |JD* 2439619.5

date exprimée en format ISO (YYYY-MM-DDTHH:MM:SS), et | M- 9613.0

les correspondances en Jours Juliens (JD), en Jours Juliens |Julanyears: |1967.3497604380561
Besselian years: |1967. 3503405742822

Modifiés (MJD), en années juliennes décimales, ou encore en
années besséliennes décimales. Il suffit de renseigner I’un des Effacer || Fermer |
champs, et de valider avec la touche « Entrée » pour obtenir
les équivalences dans les autres systemes.

5.8 Gestionnaire des filtres de catalogues

Bouton filtre HE

Menu : Catalogue => Créer un nouveau filtre...
Type de données : ~ HiPS catalogues et catalogues classiques
Script : filter ...

Le filtrage des catalogues dans Aladin est un outil puissant pour visualiser « intelligemment » les
sources.

Attention : Les filtres de catalogues ne doivent pas étre confondus avec le filtrage de 1’arbre
des collections.

Comportement par défaut (sans filtre)

Aladin représente, par défaut, les sources a I’aide de [ || | BB |
symboles graphiques, tous identiques pour un plan i | | /BN ||

catalogue donné (couleur et forme). La forme est
uniquement fonction du nombre de sources (plus petits
symboles pour les catalogues denses). La couleur et la forme peuvent étre modifiées a posteriori
en utilisant les propriétés attachées au plan catalogue (menu « Edition => Propriétés »), la taille
par la réglette « taille » sous la pile.

small crde -

Il peut étre cependant intéressant de contraindre la forme et la couleur en se basant sur les valeurs
des mesures associées a chaque source. Pour cela il est nécessaire d’utiliser ce qu’Aladin nomme
« un filtre ».

Définition du filtre

Pour Aladin, un filtre va étre appliqué a un ou
plusieurs plans catalogues afin de modifier la
maniere dont les symboles graphiques sont
tracés dans la vue. Il s’agit d’une ou plusieurs
regles qui indiqueront a Aladin comment
dessiner les sources en fonction des valeurs
présentes dans les mesures de chaque source.




Ainsi il sera ainsi possible de tracer des cercles proportionnels a la magnitude, des ellipses
d’erreur sur la position, des fléches dont ’orientation et la taille dépendent des valeurs de

mouvements propres...

Représentation du filtre dans la pile

Le filtre est représenté comme un plan spécial dans la pile qui s’applique a tous les plans

catalogues situés en dessous de lui.

Filtre prédéfini

Dessine des cercles proportionnels  la luminosité des objets
Affiche uniquement les objets brillants (magnitude < 12)
Affiche uniquement les objets faibles (magnitude > 17)
Inscrit les types d'objets

Trace le mouvements propres des étoiles

Affiche les dimensions des galaxies

aux manipulations les

Aladin propose quelques filtres prédéfinis qui
correspondent
courantes en astronomie. Vous pouvez ainsi les
sélectionner et les appliquer immédiatement via
le menu « Catalogue => Filtres prédéfinis ».

plus

En revanche, il est souvent nécessaire d’ajuster
plus finement les contraintes du filtre et pour cela de créer ou d’éditer manuellement vos regles
de filtrage. C’est ce qui va étre détaillé dans la section suivante.

Génération d’un filtre

Un filtre est généré au moyen du bouton « filtre »
présent dans la barre d’outils ou a partir du menu
« Catalogue => Créer un nouveau filtre ». Deux
modes sont exploitables via des onglets :
» Le mode « débutant » qui revient a utiliser un
filtre prédéfini (voir ci-dessus) ;
» Le mode «expert» ou vous étes chargés
d’éditer vous-mémes vos regles de filtrage.

Le panneau du mode expert vous permet d’éditer les
régles du filtre dans la boite d’édition centrale, et
vous propose toute une série d’aides a la rédaction :
» De nombreux exemples commentés qui
peuvent servir de base a vos propres filtres ;
» Des boutons d’acceés aux références des
colonnes des catalogues actuellement chargés
dans Aladin ;

& Propriétés - m}
Propriété du filtre "Filter1”
Un filtre vous permet de modifier et contraindre 'affichage des plans catalogues
Froprigte du fitre |Filter 1
Mode débutant Mode expert

Choississez un filtre prédéfini

Filfres prédéfines | — ~

Ou définissez votre propre définition de filtre
eg: §{Bmag}<10 {draw red square}

=> | Colonnes [ UCDs - Actions [~ Math... Unités [

${B}>8 { draw circle(-${B}) } 2

Aide

Exemples

Sauve le filtre| |Charge un filtre

Exporte Crée un nouveau plan avec les objets filtrés

i

Fermer

» Un bouton d’acces aux « actions » graphiques a mettre en ceuvre ;
» Des boutons d’accés aux fonctions mathématiques et aux unités physiques disponibles.

Il vous est également possible de recharger un filtre depuis un fichier préalablement sauvegardé.

Syntaxe

Pour comprendre la syntaxe d’un filtre, partons de 1’exemple suivant. Supposons que vous
vouliez afficher les « types d’objets », et uniquement pour les sources brillantes. Ce filtre pourra

s’écrire de la facon suivante :

${B}<18 { draw ${OTYPE} }
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Seules les lignes dont la valeur dans la colonne « B » (magnitude B) est inférieure a 18 seront
retenues, et I’affichage portera sur le contenu de la colonne « OTYPE » (type d’objet).

Comme nous le voyons, un filtre de base suit la syntaxe suivante :
un_test { une_action }

> Le test est facultatif et s’il n’y en a pas toutes les sources sont concernées ;

» 1l est possible d’indiquer plusieurs actions, séparées par le caractére ¢ ;’ ou un retour a la
ligne ;

» 1l est possible d’avoir plusieurs groupes « test{action} » consécutifs, sachant que c’est
I’action associée au premier test « vrai » de la liste qui sera prise en compte, les autres
lignes étant ignorées.

${class}="Star" {draw square}

S{class}="Radio" {draw rhomb}

S{class}="Galaxy" {draw plus}
» Les lignes commencgant par ‘#’ sont des commentaires.

Le test

» Le test utilise les habituels opérateurs de comparaison (=, !=, <, >, >=, <=).

» 1l peut comporter des parentheses et des opérations booléennes ET (&&), OU (]|), NON
(D

» 1l peut utiliser des fonctions mathématiques (abs, cos, deg2rad, exp, In, log, rad2deg, sin,
sqrt, tan) ;

Exemple : Tracé des sources répondant a I’expression suivante :
log( abs(${Fi})/${Fx} ) > 44 { draw }

» 1l est nécessaire d’utiliser des doubles quotes (") pour les chalnes de caractéeres. Les
jokers ‘ ?’ et “*’ y sont autorisés ;

» L’opérateur « undefined(...) » permet de repérer les lignes n’ayant pas de valeur pour une
colonne donnée.

Les actions graphiques

Deux actions sont possibles :
» draw : pour afficher une source ;
» hide : rarement utilisée, elle permet de cacher des sources particulieres.

Dans le cas d’un « draw », 1’action peut porter sur la forme et/ou sur la couleur du tracé. La
syntaxe est la suivante :
draw couleur forme

Le panneau d’édition du filtre propose deux boutons permettant de sélectionner rapidement la
forme et/ou la couleur désirée.
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Actions |
Fct de forme

Fct de couleur 3

Les fonctions de formes et de couleurs peuvent faire référence a des colonnes et/ou utiliser des

expressions arithmétiques.

ELLIPSE({semi-maj. axis, semi-minor axis, pos. angle)
FILLELLIPSE{semi-maj. axis, semi-minor axis, pos. angle)
CIRCLE(parameter)

FILLCIRCLE(parameter)

FIXEDCIRCLE(parameter)

PM(proper motion RA, proper motion Dec)
RECTANGLE(width, height, pos. angle)

LIME(ral, decl, ra2, dec2)

oval
sguare
cross
plus
rhomb
triangle
dot

microdot

RGEB(red param., green param., blue param.)
RAINBOW (parameter)
SATURATION(parameter)

black
blue
cyan
darkGray
gray
green
lightGray
magenta
orange
pink

red
white

yellow

}

Exemple : Tracé de triangles rouge :
{ draw red triangle }

Exemple : Traceé d’ellipses
{ draw ELLIPSE(0.5*${MajAxis},0.5*${MinAxis},6 ${PosAng})

Exemple : Tracé de carrés dont la couleur dépend de la magnitude
{ draw RAINBOW (${magB}) square }

Les fonctions particuliéres

» FILLCIRCLE : cercle plein ;

» FIXEDCIRCLE : Cercle dont la taille est fixe (non assujettie a la valeur du zoom de la
vue) ;

» PM: fleche dont ’orientation et la taille dépendent des deux angles indiquant un
mouvement propre ;

» LINE : tracé d’un segment, trés utile pour visualiser les résultats d’une corrélation entre 2

catalogues.

Les fonctions CIRCLE, FILLCIRCLE et RAINBOW acceptent deux parameétres facultatifs
fournissant les valeurs minimale et maximale utilisées pour le tragage. Exemple : draw

CIRCLE (${A},1,10) tracera des cercles proportionnels pour les valeurs de la colonne « A »,
le plus petit cercle ayant 1 pixel de rayon, le plus grand cercle 10 pixels.

Si I’action « draw » porte sur une chaine (ex : draw "étoile™) ou une référence a une

colonne (ex : draw ${ObjectClass}), ce sera la chaine ou la valeur de la colonne qui sera
affichée.
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Nom de colonne ou UCD

La référence a une valeur de colonne se fait classiquement par le nom de la colonne via la
syntaxe ${NOM_DE_COLONNE}. Cette méthode implique que le filtre soit plus ou moins
dédié a un catalogue particulier puisqu’il est nécessaire de connaitre explicitement les noms des
colonnes. Pour écrire des filtres plus génériques, par exemple prenant en compte la magnitude
quel que soit le nom de colonne que 1’auteur a donné, Aladin utilise les UCD.

Les UCDs, ou « Unified Content Descriptors » fournissent une caractérisation des colonnes
indépendante du catalogue. A chaque colonne a été associée une UCD qui permet de connaitre la
grandeur physique représentée par la colonne. Par exemple une colonne avec des magnitudes sera
étiquetée par I’UCD « pos.mag ». La liste des UCDs est maintenue par un comité international et
disponible sur le site de I'IVOA®. La plupart des serveurs en astronomie fournissent leurs
catalogues en VOTable déja munis de ces précieuses UCDs.

Lorsqu’une regle de filtre utilise une UCD, la syntaxe utilisée est ${UCD]. Les jokers ‘*’ et ¢ ?’
sont autorisés. Par exemple $[phot*] correspond a la premiére colonne ayant une UCD qui
commence par « phot », donc la premiere colonne ayant des mesures de magnitude.

En résumé, la référence a une colonne par son nom s’écrit avec des accolades, la référence a une
colonne par son UCD avec des crochets.

Exemple : Tracé d’un cercle proportionnel a la magnitude pour toutes les sources
plus brillante que 12
$[phot*]1<12 { draw circle(-$[phot*]) }

Pour simplifier la saisie des références aux colonnes, le panneau d’édition d’un filtre propose
deux boutons « Colonnes » et « UCDs » qui permettent de cliquer dans une liste sur le nom de
colonne, respectivement sur I’UCD, afin que le texte correspondant s’écrive automatiquement a
I’emplacement du curseur dans la fenétre d’édition.

Dans le cas ou des sources sont sélectionnées dans la vue, et font donc apparaitre leurs mesures,
il est possible de désigner une colonne en cliquant simplement dessus dans le panneau des
mesures. Pour cela, il est nécessaire de choisir le sous-menu « Pointer... » lorsque vous cliquez
dans « Colonnes » ou « UCDs ».

Unités physigues

L’indication d’unités physiques (ex : arcmin, Jy...) dans le test permet de s’affranchir de la
conversion manuelle pour des expressions utilisant des colonnes dont les valeurs ne sont pas
exprimées dans la méme unité. Les unités peuvent étre composées comme montré dans 1’exemple
ci-dessous. C’est une fonction puissante qui permet d’écrire des filtres tres génériques.

Exemple : Tracé d’un cercle proportionnel au flux en X (UCD : phot.flux;em.X-
ray) pour toutes les sources dont le niveau d’énergie est supérieur au seuil
mentionné
$ [phot. flux;em.X-ray]>10*-8 erg/m"2/s
{ draw circle($[phot.flux;em.X-ray]) }

9

http://www.ivoa.net/Documents/latest/UCDIlistMaintenance.html
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Modification d’un filtre

Pour retrouver la fenétre d’édition d’un filtre, il faut sélectionner le filtre en question dans la pile,

puis afficher ses propriétés via le menu « Edition => Propriétés ».

Etendue d’application d’un filtre

Pour s’appliquer un filtre doit étre activé (clic sur son logo dans la pile).
Par défaut, un filtre s’applique a tous les plans catalogues qui se situent

COS i Simbad

en dessous de lui dans la pile Aladin. En revanche, si un filtre est placé dans un dossier de la pile,

il ne s’appliquera qu’aux plans catalogues présents dans ce méme
dossier n’a pas la propriété « local » activée (cf. 5.1.2).

dossier, et ceci méme si ce

Filtre dédié a un plan catalogue unique

Certains serveurs proposent une série de filtres dédiés a
leurs données (Simbad, NED, Skybot...). Ils apparaissent

Rayon

Position (ICRS, name)

O La base extragalactique NED 9

Indiquez une position et a taille du champ puis appuyez sur CHERCHER
1402 32.18714 +54 23 28.7756

20,48

dans certains formulaires d’interrogation des données (cf.
5.2) sous la forme d’une liste déroulante a la fin de la liste
des parametres d’interrogation.

Un filtre « dédié », s’il est activé n’apparait pas dans la pile

Filtre d'affichage

all objects

et il s’applique uniquement au plan catalogue en question. Il inhibe 1’action de tout autre filtre
générique sur ce plan. Le choix ou ’activation d’un filtre « dédié » peut étre modifié a posteriori

via les « propriétés » associées au plan (menu Edition =>
Propriétés...). Via le bouton « This filter on the stack for
edition », il est également possible de « transformer » un filtre
«dédié » en filtre générique pour le modifier et/ou de
I’appliquer a plusieurs plans catalogues.

Exemples de filtres génériques

Cercles en fonction de {

d ircle (-$ [phot.mag*
la magnitude } raw circle(-$[phot.mag*])

draw ellipse(
0.5*$ [phys.angSize.smajAxis],
0.5*$ [phys.angSize.sminAxis],
S [pos.posAng])

draw

Ellipses de position
+

Affichage par défaut

Filtres dédiés

() Radio
QOw
Om
® fieki
Ox

This filter on the stack for editing
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$ [phot.mag*]1<17 { .

Carrés bleu pour les draw blue square -

sources brillantes )

S[src.class]="Star"
{draw red square}
Différents symboles $[src.class]="Radio"
colorisés en fonction {draw blue rhomb}

de la classe de ’objet ~ $[src.class]="Galaxy"
|| S[src.class]="Seyfert"

{draw green plus}

draw pm (
Mouvements propres 5*$ [pos.pm;pos.eqg.ral,
5*$ [pos.pm; pos.eqg.dec])

5.9 L’outil « Mesure automatique »

Menu : Outil => Mesure de distance automatique

L’outil de « mesure de distance automatique »
s’active par le menu « Qutil ». Lorsque cet outil
est activé, la sélection conjointe de deux sources
de catalogue entraine le tracé temporaire d’un
segment entre ces deux objets avec affichage de la
mesure de leur distance angulaire.

entre deux objets astronomiques d’une image, et
non de catalogue, utilisez 1’outil « phot » et cliquez au préalable sur chacun de ces
objets afin qu’Aladin calcule le centroide barycentrique pour chacun d’eux. Puis
sélectionnez les deux points de mesures afin de voir apparaitre la distance précise de
séparation.

Bouton : exam.
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Menu : Outil => Pointeur Simbad
Outil => Pointeur VizieR

Aladin peut s’appuyer sur les bases de données du CDS pour examiner 1’objet astronomique
pointé par la souris et fournir des informations d’analyse de cet objet s’il a déja été étudié par la
communauté scientifique. Le mode d’examen automatique est activé via les deux menus
complémentaires « Outil -> Pointeur Simbad » et « Outil -> Pointeur VizieR ». Il peut également
I’étre en cliquant sur I’icone « exam. » en-dessous de la vue. La couleur orange de cette icone
indique que le pointeur Simbad est actif, la couleur verte que les pointeurs Simbad et VizieR sont
conjointement actifs.

Pointeur Simbad

La mise en route du « pointeur Simbad » s’effectue en cliquant
dans la vue et en maintenant la souris a cette position pendant 3
secondes. Aladin va des lors interroger la base de données
Simbad et retourner ’identificateur, la magnitude, le type et les
coordonnées les plus précises connues de 1’objet astronomique
sous ou proche de la position de la souris. Le rayon de cette
recherche dépend du facteur de zoom, et correspond & un 20°™
de la taille de la vue. Dans le cas ou Simbad propose plusieurs
sources, celle qui a été la plus étudiée - c’est-a-dire ayant le plus
d’articles de recherche citant cette source - sera retenue.

Aladin affiche deés lors une étiquette en superposition de la vue, accrochée a la source retenue. Un
clic souris sur le nom de I’objet de cette étiquette ouvrira votre navigateur Web a la page de
Simbad correspondant a cet objet. De la méme maniere, un clic souris sur le lien « Biblio »
affichera la page Simbad de tous les articles scientifiques associés a cette source.

Pointeur VizieR

Le « pointeur Vizier » s’active de la méme facon que le
« pointeur Simbad » par un clic a I’emplacement prévu et le
maintien de la souris a cette position pendant quelques
secondes. Aladin va alors interroger le service de catalogues
VizieR afin de construire dynamiquement un graphe SED
(Spectral Energy Distribution) en prenant en compte une
collection de catalogues disposant de mesures d’énergie
proches de la position de la souris et ceci pour des filtres

18nm

7.9um I différents. Le graphe ainsi obtenu s’affiche dans le panneau
multi-usage en bas a droite.

Mise en garde : 1l n’est aucunement garanti que chacune de ses mesures concerne effectivement
le méme objet astronomique, ni que ces mesures de flux sont réellement comparables. Il s’agit
uniquement des mesures obtenues dans un rayon de quelques secondes autour de la position de la
souris.

Le graphe peut étre affiché en longueur d’onde ou en fréquence
en agissant sur le petit bouton « ~» en haut a droite. La barre
verticale représente la bande optique. Le graphe peut étre
agrandie si nécessaire en jouant sur la proportion des bandeaux
bas et a droite de la fenétre d’ Aladin. Si nécessaire, le petit bouton




« +» ouvrira votre navigateur sur le méme graphe mais géré par un outil Web plus puissant
fourni par le CDS et permettant notamment 1’impression et la sauvegarde.

Un clic sur I’icone « table » en superposition du graphique, ou sur 1’un des points du graphe
entraine la création d’un plan catalogue contenant I’ensemble des mesures, positionnées dans la
vue, et affichées dans la fenétre des mesures. La ligne correspondante au point cliqué sera
automatiquement sélectionnée.

La sélection conjointe des mesures de plusieurs
plans issus de mesures du « pointeur VizieR »
entraine le tracé en superposition des SED dans le
panneau multi-usage.

Astuce : Dans le cas d’une activation conjointe des
deux « pointeurs », 1’interrogation de VizieR prendra
en compte non pas la position directement sous la
souris mais les coordonnées de 1’objet fournie par
Simbad. Cette méthode permet d’améliorer la
vraisemblance d’origine du flux depuis le méme
objet.

Enfin, dans le cas ou les informations de flux sont
datées, une icone « time » apparait a coté de 1’icone
« table ». Son activation va générer un graphe temporelle (cf section Erreur : source de la
référence non trouvée) dont 1’abscisse sera la date et 1’ordonnée la valeur du flux correspondante.
Ceci permet d’obtenir une courbe de lumiere en gardant a 1’esprit la mise en garde énoncée
précédemment sur 1’origine hétérogéne des données et des modes de calcul.

5.11 Corrélateur de catalogues

Bouton corr.
Menu : Catalogue
=> Corréler les catalogues sélectionnés...
Type de données : ~ Catalogues classiques uniquement
Script : xmatch ...

Aladin integre un outil de corrélation de sources. Il s’agit de déterminer les sources communes a
deux catalogues. Le corrélateur va considérer 2 plans catalogues, opérer la corrélation et générer
un nouveau plan catalogue contenant les objets communs.

Note : Le corrélateur décrit ici s’applique uniquement a des catalogues pré-chargés, a ne pas
confondre avec la possibilité de corréler un plan local et une table distante localisée au CDS via

« ’arbre des collections » et « la fenétre d’acces ».

La fenétre qui controle la corrélation est accessible par le bouton « corr.» ou le menu
« Catalogue => Corréler les catalogues sélectionnée ».
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Les 3 modes de corrélations

Aladin propose 3 modes de corrélations accessibles par les onglets en haut de la fenétre de
corrélation :
» Une corrélation basée uniquement sur la position ;
» Une corrélation « par champ » basée sur la présence de valeurs identiques dans une
colonne de chaque catalogue (typiquement un identificateur) ;
» Une corrélation basée sur la position avec prise en compte d’ellipses d’erreur.

& Corrélateur de catalogues = O X
Correlatlon par DOSltlon Corrélateur par champ  Ellipses
Le panneau du corrélateur positionnel permet | Comélateur positionnel
d’indiquer les 2 catalogues concernés ainsi
1 1 d t < 1 t Seules la séparation des positions est utilisée.
que les co anes correspon aq es"a, a position coS/Simbag 1 en R — e B
(ra,dec). S’il n’y a pas d’ambiguité, les noms ned.ipacibasic_data_near position v | RA |RA(eg) « | pEC |pEC(de
des Colonnes Ont dé] é été Correctement La "Séparation” est |a distance entre sources (en sec. d'arc)
renseignés par Aladin. Il est ensuite nécessaire ¢ <= Séparation <= [4
. . . . , . ;. Choissi | thode d Elati
d’indiquer la limite de séparation supérieure, DMdaresaon
voire inférieure, pour laquelle les sources [ Toutes les solutions
seront corrélées. Elle est exprimée en ] Obgets sans soltion
secondes d’arc. Enfin un sélecteur offre 3
choix : :
5. . . Advanced options Lance le calcul Fermer
1. Lorsqu’il y a plusieurs objets dans le

cercle de corrélation, seule la source la plus proche sera corrélée ;
1. Ou au contraire, toutes les combinaisons seront conservées ;
2. Ou encore, seules les sources n’ayant pas de contreparties seront retenues.

Corrélation par champ

La corrélation par champ consiste a réunir les sources dont une valeur de champ est présente a
I’identique dans les deux catalogues. Ce type de corrélation est dédié a un champ qui identifie de
maniére unique chaque source, par exemple un identificateur, un numéro de série... En base de
données, on parlera de « jointure ».

Corrélation par ellipses

Le panneau pour controler la corrélation par ellipses est similaire a celui de la simple corrélation
par position. La différence notable est la possibilité de spécifier non seulement les colonnes de
position mais également celles qui donnent I’erreur sur la position. Cette erreur doit étre
exprimée sous la forme de 3 champs décrivant une ellipse : I’axe majeur, 1’axe mineur et
I’ orientation par rapport au nord.

Choix des champs a conserver

Lorsqu’Aladin effectue une corrélation, il crée un nouveau plan
catalogue avec les résultats. Chaque paire de sources corrélées va
correspondre a une source dans le plan résultat, et par défaut, toutes les
mesures des deux sources vont étre conservées. Pour éviter des
confusions possibles sur les noms de colonnes, ils seront
automatiquement suffixés par « _tab1 », respectivement « _tab2 ».
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En utilisant le bouton « Advanced options » présent dans chacun des formulaires de corrélation, il
est possible de choisir explicitement les colonnes a conserver ainsi que de préciser les suffixes ou
éventuellement les préfixes de noms de colonnes.

@ Options for xmatch ouput - [u]
Output options
Catalogue A : CDS/Simbad
Column prefix || Column suffix |_tabt

Choose columns to keep

Deselest all

Catalogue B : ned.ipac/oasic_data_near_position

Colurmn prefix Column suffix |_tab2

Choose columns to keep

Deselect all

ucp:

Colonnes et UCDs

Lorsque le pointeur de la souris survole les boutons pour sélectionner
les colonnes, les boutons en correspondance dans les deux catalogues
vont s’afficher sur fond bleu. Cette correspondance s’appuie sur des
UCD communes pour ces deux colonnes (une UCD est un attribut
propre a chaque colonne qui caractérise sa signification physique —
ex : « pos.eq.dec » pour une mesure de déclinaison - cf. description
des UCD dans la section 5.7).

A noter : Certains UCD ne doivent apparaitre qu’une seule fois dans
une table (« meta_main »). Ainsi, si la correspondance s’affiche sur
fond rouge, cela signifie qu’il va y avoir conflit d’UCD. Pour lever le

conflit, il est nécessaire de cliquer sur le nom de la colonne prépondérante en maintenant la
touche Crrl enfoncée. A 1’absence d’indication, ce sera la colonne du premier catalogue qui sera

prépondérante.

5.12  Nuages de points et séries temporelles

Bouton

Xy

Menu : Catalogue
=> Créer un graphe de points / une série temporelle
Type de données : Catalogues classiques uniquement

L’outil « nuage de points » permet de comparer deux grandeurs prises dans les mesures d’un
catalogue. L’activation de cet outil apres avoir sélectionné

dan§_la pile le Plan cqtalogue concerné, va Creer une vue . gimsg .| [JFip []Log
additionnelle qui accueillera le tracé du graphe de nuage de

points. Simultanément,

Aladin ouvrira la fenétre des v: BR «| [JFlip [JLog

propriétés de ce plan afin que vous puissiez préciser les deux

grandeurs a comparer.

zoom all | |delete

Le «nuage de points » se manipule de maniere similaire a une vue classique (zoom,
déplacement). Il est possible de sélectionner les sources concernées et ainsi pouvoir
immédiatement repérer dans une autre vue ou elles se situent sur le ciel.

Astuce : 11 est possible de tracer simultanément plusieurs « nuages de points » issus de
différents plans sur le méme graphique. Pour cela, glisser-déposer le logo des plans pour
lesquels vous souhaitez visualiser conjointement le nuage de points sur un graphique
déja créé. Il sera cependant nécessaire d’indiquer les colonnes concernées pour chaque

plan ajouté.
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COSAUISNOBBImag, B-R)|

15 USHNOB

[yl [y

19
Dans le cas particulier d’une « série temporelle », c’est-a-dire lorsque la colonne choisie pour
labscisse est une date, la vue utilisée a des caractéristiques spécifiques. Le
comportement du zoom differe 1égérement : seule ’échelle de temps (abscisse) sera
impactée par le facteur de zoom, et non I’échelle des valeurs (ordonnée) ce qui aura
l'effet de contracter (resp. dilater) le graphe horizontalement. D’autre part, une telle vue
« temporelle » peut afficher en superposition la composante temps d'un MOC temporel
ou spatio-temporel (cf. 5.1.4) .

995-07-05 2001-03-31 2003-12-26 2006-09-21 2009-06-17 2012-03-13 2014-12-08

Note : L’outil « nuage de points » reste cependant relativement basique. N’hésitez pas a utiliser
un autre outil tel TOPcat conjointement a Aladin au travers 1’interface d’échange SAMP décrite a
la section 6.4 - Interaction avec les outils VO : SAMP

5.13 Calculateur de colonnes

Menu : Catalogue => Ajouter une nouvelle colonne...
Menu contextuel des mesures : Ajouter une nouvelle colonne...
Script : addcol ...
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Les catalogues fournissent un certain nombre de mesures qu’il est possible de visualiser dans le
« panneau des mesures » en sélectionnant les sources concernées (cf. 5.1.8). Ces mesures se
présentent sous la forme de plusieurs colonnes de valeurs. Aladin offre la possibilité d’ajouter des
colonnes qui sont obtenues par calcul sur les valeurs d’autres colonnes. Par exemple il est
possible de créer une colonne « B-V » fournissant la différence entre deux colonnes de magnitude
« B» et « V».

Acceés a la fenétre

& Calculateur de colonnes — O *
La fenétre pour gérer le calcul d’une nouvelle

colonne s’ouvre soit par le menu contextuel du

« panneau des mesures » (clic droit ou CTRL clic), Nb;" =
soit via le menu principal « Catalogue => ajouter | uwi

une nouvelle colonne...». Dans ce dernier cas, il | @@= 4 v|décimales
aura fallu spécifier au préalable le catalogue | [y i 0. SEmagsiine

concerné en sélectionnant son plan dans la pile.

Ajout d'une colonne au plan CDS/Simbad

Information générale sur la nouvelle Feameez un nom de celonne
colonne MAIN_ID OTYPE RA DEC
COO_ERR_..| COO_ERR_.. COO_ERR_.. PMRA
La création d’une nouvelle colonne nécessite la PMDEC B v R
spécification d’un nom. De maniére facultative s = = s
vous pouveZ indiquer l’unite’ de la nouveue Colonne GALDIM_MA... || GALDIM_ML.. | GALDIM_AN... BIBLIST
ainsi que ’UCD qui doit y étre associée (cf. 5.8). Pointez un opérateur / une fonction
Vous pouvez également spécifier le nombre de =1 *[lz/ | allc|l|) |~Foncions— ~
décimales significatives lors de 1’affichage des
valeurs. Crée la colonne Fermer

Expression de calcul

Pour créer une nouvelle colonne, il est nécessaire d’indiquer I’expression de calcul qu’Aladin
doit utiliser pour générer les valeurs de cette nouvelle colonne. La saisie se fait dans le cadre
central intitulé « Expression ». La syntaxe utilisée reprend les conventions habituelles d’une
expression algébrique. Les références aux autres colonnes respectent la syntaxe :

${nom_de colonne}

Pour éviter les erreurs de saisie, la fenétre affiche une liste de boutons reprenant les noms des
colonnes du catalogue concerné. Un clic souris sur I’un d’eux insere, a I’emplacement du curseur
dans le panneau de saisie de I’expression, la référence a la colonne concernée.

Il est également possible d’insérer les opérateurs (+, -, *, /...) et les fonctions mathématiques
éventuellement nécessaires (abs, cos, sin, rad2deg, ...) en cliquant sur les boutons et sélecteurs
correspondants.

Génération de la colonne

Une fois créée en utilisant le bouton « Crée la colonne », les nouvelles valeurs apparaitront tout a
droite de la table des mesures, et en couleur brun/orangé afin de les distinguer facilement des
mesures originales. Cette nouvelle colonne peut étre utilisée comme toutes les autres colonnes :
triée, filtrée... Elle sera sauvegardée avec les autres colonnes le cas échéant.
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5.14 Fenétre de calibration astrométrique

Menu : Image => Calibration astrométrique...
Type d’images : fits, jpeg, png uniquement

Lorsqu’Aladin superpose des sources sur une image, il utilise la solution astrométrique associée
a cette image. Il s’agit d’informations permettant de faire correspondre a chaque pixel de I’image
une position dans le ciel et réciproquement. Il existe de nombreuses possibilités qui décrivent
généralement une méthode de projection d’une portion de la sphere céleste sur une plan
(tangentielle, sinusoidale, ...). Aladin gere les projections couramment utilisées en astronomie
(SINUS, TANGENTIAL, AITOFF, ZENITAL_EQUAL_AREA, STEREOGRAPHIC, CARTESIAN, NCP, ZPN,

)

Informations de calibration astrométrique

Aladin dispose de 4 méthodes pour connaitre la calibration astrométrique d’une image :

1. Lorsqu’il s’agit d’image au format FITS, les informations de calibration sont fournies via
les mots clés adéquats de 1’en-téte FITS (selon le standard WCS) ;

2. Dans le cas d’une image JPEG ou PNG, Aladin sait également reconnaitre une calibration
astrométrique fournie dans son segment commentaire. Cette calibration doit suivre la
syntaxe des mots clés FITS avec un ‘\n’ a la fin de chaque ligne ;

3. Cette calibration associée a une image JPEG ou PNG peut également étre stockée dans un
fichier texte ayant le méme nom que I’image a laquelle elle est associée, mais avec
I’extension « .hhh ». Dans ce cas la syntaxe est soit FITS (entéte alignée sur 80 octets),
soit ASCII avec retour a la ligne classique ;

4. Enfin, Aladin sait également prendre en compte la calibration astrométrique lorsque
I’image a été chargée depuis une liste conforme au standard de 1’Observatoire Virtuel :
SIA (Simple Image Access, cf. 8.1 - Les types de données supportés).

Astuce : Dans les deux premiers cas, I’en-téte FITS peut étre visualisé via le menu Edition
=> En-téte FITS.

Une image peut disposer de plusieurs calibrations astrométriques, notamment si vous en avez
générées manuellement. Pour changer de solution astrométrique, il est nécessaire d’afficher les
propriétés du plan et de changer la Reéduction astrométrique

sélection. JLrafecion ﬁﬁﬁfﬁj&fﬁﬁﬁuf o MNouveau... Editer...

En revanche, si I’image ne dispose pas de calibration astrométrique, Aladin pourra tout de méme
générer des vues mais ne pourra pas superposer de sources ou de surcharges graphiques avec des
coordonnées célestes. Le déplacement de la souris dans une telle image affichera simplement
« No astrometrical reduction » dans le cadre de position. Il sera cependant possible d’y ajouter
des surcharges graphiques manuelles (dessins a main levée, marques...), contours... Ces
surcharges graphiques n’auront que des coordonnées en XY propres a 1I’image.
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Création/modification d’une calibration astrométrique

Aladin  permet de créer
manuellement une solution
astrométrique pour une image

qui n’en dispose pas, ou
d’affiner une solution
existante. Pour cela il est

nécessaire de sélectionner le
plan image concerné dans la
pile (clic sur le nom) puis
d’utiliser le menu « Image =>
Calibration astrométrique... ».

La fenétre de calibration vous
demande en premier lieu de
nommer votre nouvelle
calibration.

Par paramétres Par corresp. d'étodes  par entéte WCS

Cliguez dans limage (ou dans le panneau des mesures) pour
recupenar les coordonnées correspondantes. (plus proche etoile po
plus proche objet de catalogue pour un champ RADEC)

position " y" hh men 55 +dd mm 55

|-138.?5L3 02,8229 05 34 3..28408 +2203
|595.42 17 45.4952 05 34 27.28296 +2158

|1I:|4.4-14? 8.3489 05 34 4295136 +2158

| 72,9243 432.0760 05 3443.82376 +2201

Puis, elle propose 3 méthodes pour créer/modifier une calibration :

1. Par parametres ;

2. Par correspondances d’étoiles ;

3. Par en-téte WCS.

Calibration par parametres

Le premier onglet affiche les parameétres de base de la solution
astrométrique, c’est-a-dire une position céleste et les coordonnées du
pixel correspondant dans 1’image, la taille angulaire du pixel, la
méthode de projection, un angle de rotation par rapport au nord et
enfin le sens croissant de 1’ascension droite.

& Calibration astrométrique — O X

Complétez fe formulaire en fonction du plan "D554"

Calibration par en-téte WCS

& Calibration astrométrique — [m] x

Complétez ke formulaie en fonclion du pian "0831"
Nom: |Ma projection 1

Par paramétres  Par corresp. détolles  par entéte WCS

Coordonnées (72000)105 34 31.94392 +22 00 51,3620
Fos. comresp. (xy): 384.0 384.0

Taille ol pixe 1.008"

Réfirentel cieste | Equatorial

Tangential -

0.3845675986622535

Projection:
Rotation (Heq):

Symétrie en RA: Ovra @ Faux

Nom: Ma projection 1

Par paramétres Par corresp, détoiles  par entéte WCS

Le 3°™ onglet affiche les mots clés FITS

. Réinit. | Effacer

NAXIS1 = 768 -
HAXTS2 = 768

CRPIX1 = 384.0

(RPTX2 = 384.0

EQUINOX = 2000.0

CRVALL = B3.63309966666665
CRVALZ = 22.014267222222223
CTYPEL = RA---TAN

CTYPE2Z = DEC--TAN

RADECSYS= FK5
-2.799936020464082E-4
-1.879337711139427E-6
-1.879337711139427E-6
2. 799936929464082E-4

=)
=]
=
I
]

[l

MODIFIER | Defaire Refaie Reinit, | Effacer

fournissant les parameétres de la calibration dans le standard WCS. Si
vous connaissez ce standard, vous pouvez directement modifier ces
parametres. Il est par exemple possible d’utiliser la solution
astrométrique d’une autre image en copiant/collant ses parametres
WCS tels quels.

Astuce : 11 est également possible de modifier une valeur d’un mot
clé WCS via la commande script : set PlanID FITS:keyword=value
(cf. 7.1 - Aladin par script)

Calibration par correspondances d’étoiles

Le 2°™ onglet affiche une table destinée a saisir une liste de coordonnées XY images et leur
correspondance en position céleste. C’est une méthode puissante et souple qui permet d’obtenir
rapidement d’excellentes calibrations. Nous allons brievement détailler la méthode. Pour plus de
détails, veuillez-vous référer au tutorial en ligne dédié a cette manipulation sur le site du CDS™.

Supposons que nous ayons chargé une image JPEG non calibrée dans la vue de gauche, et une
image DSS du méme champ avec en superposition un catalogue astrométrique tel UCACS5 dans

10

http://cds.unistra.fr/tutorials/pdf/aladin-tutorial-astrometric-calibration.pdf
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la vue de droite. La méthode pour calibrer I’image JPEG consiste a cliquer successivement sur
une étoile de I’image non calibrée, puis sur la source UCACS correspondante dans 1’image DSS.
A chaque clic de la souris, Aladin renseigne la table du panneau de calibration. Quatre
correspondances suffisent généralement a obtenir une bonne calibration.

A noter : Lorsqu’il est nécessaire de déterminer les coordonnées d’une étoile par « clic souris »,
Aladin utilise en algorithme de centroide par barycentre. S’il n’est pas possible de déterminer le
centre (étoile trop large), un message indiquera que la position cliquée sera prise telle quelle.

Astuces :

» 1l peut étre judicieux d’effectuer une « rotation » (Ctri+cliquer/déplacer dans la vue, -
uniquement possible pour un relevé progressif HiPS) de I’image de référence afin de se
rapprocher de I’orientation de I’image a calibrer ;

» 1l est préférable de n’afficher que les sources brillantes et a faible mouvement propre.
L’utilisation d’un filtre sur le catalogue facilite grandement le repérage des
correspondances, par exemple :
$[pos.pm;pos.eqg.dec]<3 mas/yr && $[pos.pm;pos.eqg.ral<3 mas/yr

&& S$[phot.mag*]<17 { draw circle(-$[phot.mag*]) }

» 1l est possible de ne pas charger de catalogue, les coordonnées célestes seront alors celles
déduites de la calibration de 1’image DSS. La précision de la calibration sera moins
bonne ;

» L’utilisation de la semi transparence (Menu « image => Niveau de transparence ») pour
visualiser I’image qui vient d’étre calibrée sur I’image DSS permet de vérifier d’un coup
d’ceil la qualité de la calibration.

Faire et défaire

Lors du processus de création ou d’ajustement d’une calibration, il est possible de revenir a la
solution antérieure en utilisant les boutons « Défaire » et « Faire » en bas de la fenétre.

5.15 Générateur d’images couleurs RVB

Icone : rvbm

Menu : Image => Créer une image RVB...
Type d’images : fits, jpeg ou png en niveaux de gris
Script : RGB, RGBdiff

Aladin peut créer une image en
vraies couleurs a partir de 2 ou 3
images en «niveaux de gris ».
Pour cela, il affectera a la
composante « rouge » la premiére
image, et pour les deux autres
composantes « vert» et « bleu »
les deux autres images. L’image
en vraies couleurs sera mémorisée
dans un plan de la pile.




Rééchantillonnage

Afin que les pixels des images correspondent aux mémes positions dans le ciel, Aladin effectue
un rééchantillonnage sur deux des images en fonction de la solution astrométrique de la
troisieme. Celle-ci est appelée « image de référence ». Par défaut, ce sera I’image dont la taille
angulaire du pixel est la plus petite qui sera prise en référence. Le rééchantillonnage est basé sur
I’algorithme du « pixel le plus proche » (cf. 5.16)

ACCéS é Ia fenétl’e & Générateur d'images couleurs RVB — O *

Spécifiez deux ou trois images, une pour chague

La fenétre pour générer une image Couleur est composante couleur, désignez limage de référence du rééchantilonnage
. . , i CREE Enérer ['i RVB.
accessible soit par le menu « Image => Créer e e

. . 1) Rouge POSSILN-DSS$2.270 - "M51" ~

une image RVB... » soit par le bouton « rvb ».
POSSILF-DS82.270 - "M51" ~
3) Bleu |POSSILJ-DSS2.270 - "M51" ~

Le choix par défaut des images pour chaque
composante dépend de I’état de la pile. S’il y a
deux ou trois plans sélectionnées, Aladin va les

A0 RGR img utiliser pour
renseigner le
formulaire. Sinon, Aladin considérera les 3 images du haut de la
pile, ou a défaut les 2 premieéres. S’il connait les longueurs d’ondes
des images, Aladin les trie en fonction de ce parameétre.

Image de référence durééchantll.: (JR ()G (OB (®) Meileure résolution

Soustraction d'images

£ Reint. | Ferme 9

Astuce : Lorsque le curseur de la souris se trouve sur le logo du plan RVB créé, les logos des 3
images originales apparaissent dans la couleur de leur composante propre.

Cas particulier de 2 images

Il est possible de ne sélectionner que 2 images. Dans ce cas, la 3*™ composante couleur sera
calculée en fonction des 2 autres en prenant a chaque fois la moyenne des valeurs des deux autres
images. Cette méthode construit de tres belles images colorées particulierement si la composante
laissée libre est le vert (mode par défaut).

Différences entre 2 images

Avec 2 images, il est également possible d’effectuer une
soustraction colorée. Les différences positives seront les
valeurs de la premiére composante couleur, les différences
négatives celles de la seconde composante couleur. D’autre
part, les différences vont étre normalisées entre 0 et 255 pour
offrir un contraste maximal. Cette méthode est tres
intéressante pour visualiser rapidement les variations, méme
minimes, entre 2 images.

5.16 Associations d’images : cubes & mosaiques

Icone : assoc
Menu : Image => Créer une image mosaiques...
Image => Créer une séquence animée...
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Type d’images :
Script :

fits, jpeg ou png en niveaux de gris
blink ..., mosaic ...

Aladin peut associer 2 ou plusieurs images en les combinant soit sous la forme d’un cube qu’il

affichera comme une séquence animée, soit en
créant une nouvelle image mosaique des images
originales.

@ Associations d'images — O s

Spécifiez les images que vous désirez assaocier.
Sélectionnez le mode Mosaigue ou Séguence animée,
puis appuyez sur CREE.

1) POSSIN-DSS2.061 - "09 55 33.17306 +69 03 55.0610" *

PR ~ y .,
Acces a Ia fenetre d association 2) |POSSILF-DS52.061 - "09 55 33.17306 +69 03 55.0610"

La fenétre qUI s’ouvre via le menu « [mage => 3) POSSILJ-DS52.061 - "09 55 33.17306 +69 03 55.0610™

créer une image mosaique » ou « Image => Créer |4
une séquence animée », ou encore par le bouton |5
«assoc » vous permet de contrOler I’association. |6
Vous y indiquerez les plans images originaux, le ||« >
délai initial de séquence dans le cas de la production

POSS1.O-DSS2.037 - "09 55 33.17306 +69 03 55.0610"
-- aucum --

—aucum -

() Mossique (@) Séquence animée - délais: | 400 ms ~
d’un cube et I’image de référence s’il y a lieu
5 sz . Image de référence du rééchantil.: |1
d’effectuer un rééchantillonnage pour superposer les
pixels. CREE | Rénit. | Ferme (@)
Mosaique

Dans le cas de la production d’une image « mosaique », I’image obtenue aura la taille requise
pour contenir toutes les images originales dans la grille de projection de I’image de référence.
L’image obtenue sera visualisée et manipulable
comme tout autre image dans Aladin. La moyenne
sera utilisée pour les zones de recouvrements.

A savoir : Cette fonction de génération d’image
mosaique est relativement simpliste (nombre
d’images limité a la RAM, pas d’ajustement de fond,
pas de masque d’exclusion, ...). Cependant vous
pouvez egalement générer une mosaique d’images sous la forme d’un H1PS Pour cela veuillez-
vous référer a la section 6.2.

Cube ou « séquence animée »

Un cube est visualisé par Aladin comme une
séquence animeée, c'est-a-dire image apres
image. Le logo dans la pile est repérable par
un double trait a sa base symbolisant
I’épaisseur du cube. La manipulation d’un
cube est décrite dans la section concernant
«lavue » en 5.1.2.

Le contréle du défilement des images du cube
s’opere soit par les icones rouges en
superposition de la vue, soit pas la réglette « cube » située sous la pile. Si celle-ci n’est pas
visible, activez-la via les préférences utilisateurs (menu Edition).
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Astuce : 11 est possible d’ajouter une nouvelle image a un cube existant. Pour cela, vous devez
cliquer/glisser le logo du plan de la nouvelle image dans la vue ou le cube est en train de défiler.
Apres une courte pause nécessaire au rééchantillonnage de la nouvelle image, le défilement du
cube reprend avec une image de plus.

A savoir : 11 est possible d’extraire un spectre localisé a partir d’un cube (cf. 5.1.5 - Coupe en
profondeur associée a 1’outil « Spectre »).

5.17 Rééchantillonnage d’images

Menu : Image => Rééchantillonner...
Type d’images :  fits, jpeg ou png en niveaux de gris
Script : resamp ...

Principe

Méme si elle concerne le méme champ du ciel, chaque image dispose généralement de sa propre
solution astrométrique. Cela signifie qu’un pixel particulier ne pointe pas nécessairement au
meéme endroit dans le ciel. Pour comparer deux images pixel a pixel, il est souvent nécessaire de
rééchantillonner I'une d’elle en fonction de 1’autre, appelée «image de référence ».
Concretement Aladin parcourra toutes les positions des pixels de I’image de référence, en déduira
leurs coordonnées dans le ciel, puis en utilisant cette
fois-ci la solution astrométrique de la deuxieme image, | & Rééchantillonnage - O X
et ce pour chaque position céleste précédemment Désignez limage de référence
calculée, il en déduira la valeur du pixel, soit le plus pour le réchantilonnage puis appuyez sur CREE
proche de la position trouvée, soit une approximation | nttps:irsa.ipac.caltech.edu:443/cgi-bin2MAS... -
bilinéaire des 4 pixels les plus proches. A la fin du
processus vous disposerez de deux images ayant la
méme « grille » de pixels pour une unique solution Méthode : () Plus proche pixel ~ (@) Biinéaire
astrométrique.

Pixels: (@) b

Conserver limage d'origine dans la pile

Accés a la fenétre CREE | Rénit.  Ferme | (g9

La fenétre qui controle le rééchantillonnage s’ouvre

par le menu « Image => Rééchantillonner ». 1l aura fallu au préalable sélectionner dans la pile
I’image a rééchantillonner. Dans la fenétre, vous devez indiquer I’image de référence, s’il faut ou
non garder la valeur des « full » pixels, ou juste les « niveaux de gris » codés sur 8 bits, choisir la
méthode d’estimation de la valeur des pixels et enfin indiquer si 1’image originale doit étre
remplacée par I’image rééchantillonnée ou conservée dans la pile.

Attention : 11 faut noter que les méthodes de rééchantillonnage proposées par Aladin (plus proche
ou bilinéaire) n’assure pas nécessairement la conservation du flux, c’est-a-dire que la somme des
valeurs des pixels avant rééchantillonnage n’est pas obligatoirement la méme qu’apres.

A noter : Une image ayant été rééchantillonnée fait apparaitre dans la vue le logo .
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Astuce : L’utilisation de la semi transparence des images (cf. 5.1.2) fournit une alternative bien
plus rapide et souple par rapport au rééchantillonnage. Elle est cependant moins précise
puisqu’elle n’agit pas pixel par pixel mais uniquement en se basant sur les 4 coins et en
approximant globalement la position des autres pixels.

5.18 Opérations arithmétiques sur les images

Menu : Image => Opérations arithmétiques...
Image => Convolutions
Image => Normalisation des pixels
Type d’images :  fits
Script : +, -, *, /, conv, norm, kernel

Addition, soustraction, multiplication et division

Aladin offre une interface simple pour | @& Genérateur dimages arithmétiques  — O X
effectuer les calculs de base sur un couple . _ ,

y . K Désignez 2 plans images ou 1 plan image et une valeur
d’images : addition, soustraction, ainsi que 'opération arithmétique & effectuer puis
multiplication division. La fenétre de controle appuyez sur le bouton CREER. pour générer limage résultante.

s .
S’ouvre Via le menu « [mage => OpératiOns Plan hitps:iirsa.ipac.caltech.edu:443/cgi-binl... -

arithmétiques » (accessible uniquement si au Plan ou Valeur http:iarchive.eso.org/dssidssiimage?ra=1 ~
moins deux images sont présentes dans la
pile). Aladin procédera pixel par pixel en
effectuant le cas échéant une rééchantillonnage [] Normalisation préalable des pixels (div. par moy)

de la deuxiéme image pour qu’elle Rééchantilonnage (si nécessaire) (@) Plus proche pixel () Bilinéaire
corresponde a la grille de pixels de la premiere.
Il est possible de demander une normalisation CREE | | Réinit. | |Ferme | ()
préalable des pixels de deux images afin que
leurs valeurs soient réparties autour de 1 par division préalable par la moyenne. Le résultat de
I’opération sera vu comme un nouveau plan image dans la pile.

(@) Addiion () Soustraction () Multiplication () Division

Convolution

D’autre part, le menu « Image => Convolutions ... » permet de « convoluer » I’image courante
avec une matrice spécifique, c’est-a-dire calculer une nouvelle image en fonction du produit de
chaque pixel d’origine (et ceux a proximité) avec une matrice particuliere. Le sous menu propose
les matrices couramment utilisées en astronomie (Gauss, Mex, Tophat, ...) de différentes tailles.
Vous pouvez également définir votre propre matrice de convolution en utilisant la commande
script : « conv » (cf. 7.1). L’image résultante remplacera 1’image d’origine dans la pile. Si vous
désirez conserver 1’image originale il est nécessaire de la dupliquer au préalable (menu : « Image
=> Dupliquer »)

82



5.19 Sauvegardes, exportations et impressions

Menu : Fichier => Enregistrer..., Fichier => Exporter...
Fichier => Sauvegarder..., Fichier => Imprimer...
Raccourci: Ctrl +S, Ctrl +P

Script : save ..., export ...
Les fonctions de sauvegardes, d’exportations et g, .gier.. CHrles
d’impressions sont accessibles par le menu | gnegistrerlavue courante.. e Bmp
principal « Fichier ». Exporter la vue courante (EPS]... JPEG
Exporter des plans (FIT5,VOTable,...)... PMG
Aladin dispose de plusieurs possibilités pour —Sauvegarderapile.. PNG-+LINK

enregistrer votre travail :
» Impression de la vue (ou des vues) ;
» Sauvegarde de la vue courante. Les formats supportés sont BMP, JPEG, PNG et EPS. Ce
dernier format est spécialement indiqué pour une publication scientifique ;
» Exportation d’un ou plusieurs plans de la pile. Les images seront exportées en FITS,
JPEG ou PNG, les catalogues en

& sauveqarde Aladin - O X
TSV  (Tab-Separated-Value) ou
VOTable (Cf. 8_1), FITS et JSON Choississez |'une de ces possibilités
pour les MOCs ; Sauve | _
auvegarde la vue courante dans ]

» Conservation de la pile et des vues Rl L ichicr

P , . courante
pour une réutilisation ultérieure.
E:-:po!'te Wous permet de sauvegarder des plans:
certains | _ catalogues en ASCI TSY, VOTable ou JSON
plans - images en FITS {ou JPEG/PNG pour les images RvE)

Sau_ve Cree un fichier unigue mémorisant la pile courante
Génération d’une carte « cliquab[e » l lapile | (Le format est propre & Aladin - format AJ)

Fermer

Dans le cas de la sauvegarde de la vue
Aladin propose le format « PNG+LINK ». Ce format est dédié a la création de « cartes Web
cliquables ». La vue est enregistrée au format PNG classique. Un deuxieme fichier est généré
simultanément ayant I’extension « .Ink ». Il contient dans un format ASCII basique les objets
cliquables présents dans la vue, leur position dans I’image PNG ainsi qu’une URL pour accéder a
I’enregistrement complet associé. Ces deux fichiers placés sur un serveur Web vont permettre de
réaliser a moindre frais une carte cliquable. Pour plus de détail sur la méthode, le format et des
exemples d’implantation, veuillez consulter 1’adresse suivante :
http://aladin.cds.unistra.fr/java/FAQ.htx#Map

5.20 Les signets
Icone :

Menu : Outil => Signets...
Script:  function ..., call ...

Aladin integre un mécanisme de « signets » vous permettant d’effectuer une série d’actions
prédéterminées au moyen d’un simple clic souris sur un des
boutons visibles dans le bandeau de commande (cf. 5.1.7).

Gaia M Simbad MFoV HST MCassis
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Certains signets ont été prédéfinis par I’équipe du CDS. Ils apparaissent avec un symbole de
couleur verte. Vous pouvez créer vos propres signets dont le symbole sera alors de couleur bleue.

La fenétre qui s’ouvre en cliquant sur 1’icéne « + » tout a droite de la barre des signets, ou via le
menu « Outil -> Signets... » vous permet de consulter les signets existants, de les modifier, voire
d’en créer de nouveaux. La partie haute de cette fenétre comporte la table des signets définis. Si
vous en sélectionnez une ligne, les actions associées a ce signet apparaissent dans le panneau

{& Gestionnaire des signets - m] ¥
Bookmark Name Description
[ LES Load HiPS DSS colored - Band: Optical (progressive mo...
[] A |DSS-red Load HiPS DSS red - Band: Optical (progressive mode, ...
[] A [SDSS Load HiPS SDSS colored - Band: Optical (progressive m...
= A [2MASS Load HiPS 2MASS colored - Band: Infrared (progressiv...
] A |WISE Load HiPS WISE colored - Band: Infrared {progressive ...
[~] A |GALEX Load HiPS GALEX colored - Band: UV {progressive mode)
[ A |PLANCK Load HiPS PLANCK R2 LFI colored - Band: Radio {progr...
[] A |AKARI Load HiPS AKARI-FIS colored - Band: Far Infrared (pro...
[ A [XMM Load HiPS ¥MM colared - Band: X {progressive mode)
] A |[Fermi Load HiPS Fermi colored - Band: Gamma-ray {progressi...
[] n |Gaia Load HiPS Gaia catalog (progressive mode)
[ A |Simbad Load HiPS Simbad {progressive mode)
[] A |NED Load MED {current view)
L] A RIS Load HiPS IRIS colored - Band: Infrared (progressive ...
O A |Spitzer Load HiPS Spitzer colored - Band: Infrared (progressiv. ..
] A |PPMX Load HiPS PPMX catalog (progressive mode)
[] A |2MASS_cat  |Load HIPS 2MASS catalog {progressive mode)
[] M |Pressimag  |Load HST colored press release images around current...
[] A [FoV HST Display HST FoV for current location
O Planets Various Planet maps
[m [3axA/P/SL... |Load JAXA[R/SUZAKU on the view
#Skymapper & bands+color -~
function Skymapper (STARGET, SRADIUS) {
Toad http://alasky.u-strashy. fr/Skymapper/hipslist
v

Nouveau...

5.21 L

Supprimer

Recharge signets Exécuter

es préférences

Menu :

sous la table.

Un signet est mémorisé de maniere interne comme une
"fonction script”, cad une liste de commandes scripts (cf
7.1) a laquelle on aura donné un nom, et éventuellement
des parametres. Deux parametres prédéfinis sont
particulierement utiles : $STARGET qui sera remplacé par
la position du réticule a l'appel du signet, et $SRADIUS
pour le rayon couvrant le champ de vue courant. L'ajout
d'un commentaire au-dessus de la définition de la fonction
permettra de fournir une description succinte. C'est celle-
ci qui sera affichée par le "tooltip" du signet
correspondant.

Note technique : La réinitialisation du « cache » d’Aladin
(cf. glossaire), ou I’installation d’une nouvelle version
peut entrainer la remise a jour des signets visualisés dans
la barre sous le menu. Vos signets propres ne sont pas
pour autant supprimés, il suffit de les revalider dans la
fenétre décrite ci-dessus.

utilisateurs

Edition => Préférences utilisateurs...

Aladin regroupe dans la fenétre des préférences la plupart des parameétres de configuration
propres a |’utilisateur. Vous pouvez ainsi définir les éléments suivants :

VVVY

La langue de I’interface graphique (anglais, frangais, italien, ...) ;

L’activation du mode « assistant » offrant des aides contextuelles ;

Le rendu de I’interface (théme clair ou foncé, taille des polices et icones) ;

Le style de fenétre d’acces aux fichiers et aux répertoires (dépendant du systéme

d’exploitation, ou propre a I’application Aladin) ;

VVVVVYVYY

Le choix des réglettes de controles sous la pile ;

Le répertoire par défaut ou Aladin cherche ou enregistre les fichiers locaux ;

Le référentiel spatial et la projection par défaut ;

Le mode d’affichage des pixels par défaut (vidéo inversée, table des couleurs...) ;
L’activation ou non des filtres dédiés (cf. 5.8);

Le serveur d’image par défaut ;

Le site par défaut de I’annuaire des serveurs (cf. 5.2) , c’est-a-dire la machine qui lui

fournit a chaque démarrage la liste des serveurs disponibles ... ;

A\

taille des polices) ;

Les choix graphiques de la grille de coordonnées et des informations de la vue (couleur,
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» L’activation des outils de métrologie du CDS (log) ;

» La taille de la mémoire tampon locale (cache) ;

» Le filtrage automatique des extensions de données FITS jugées non pertinentes ;
» L’acces et la manipulation des données planétaire.

Quelques précisions :

Theéme de I’interface — Echelle : Les écrans dont le nombre de pixels en fonction de la taille
physique est particulierement élevé (écrans HDPI) nécessitent d’agrandir la taille des polices, des
icones et des autres éléments de I’interface. Ce facteur d’accroissement peut étre automatique
(«auto») ce qui laisse I’Operating System faire le choix le plus adéquat. Ce n’est
malheureusement pas toujours le cas. C’est pourquoi Aladin offre les alternatives manuelles en
pourcentage d’accroissement (110%, 120%...) et permet a I’utilisateur de déterminer lui-méme
ce facteur d’accroissement. Il est dés lors nécessaire de procéder a quelques tests pour choisir la
meilleure option.

Style de fenétres : Certains Operating Systems fournissent des formulaires d’accés aux fichiers
et aux répertoires réutilisables par les applications telles qu’Aladin. Ceci permet de conserver les
mémes habitudes de travail d’un logiciel a I’autre. En revanche, certains OS n’offrent pas toutes
les fonctionnalités attendues, par exemple la sélection d’un répertoire. C’est pourquoi 1’ utilisateur
est laissé libre d’opter pour un formulaire générique, fourni par la librairie Java.

Taille de la mémoire tampon : La fonction d’Aladin I’ameéne a télécharger un gros volume de
données, notamment lorsqu’il s’agit d’explorer des relevés progressifs. Or les statistiques
montrent qu’un utilisateur travaille souvent sur les mémes données, le méme endroit dans le ciel
ce qui fait qu’il va souvent rechargé les mémes données. C’est pourquoi Aladin s’appuie
fortement sur la notion de « tampon », c’est-a-dire des copies sur le disque local des données les
plus souvent accédées. Non seulement cela permet une visualisation bien plus rapide, mais cela
économise des ressources dont la planete a bien besoin et ce sera d’autant plus vrai que cette
zone tampon sera volumineuse.

Métrologie CDS : Vous utilisez gratuitement Aladin développé par le Centre de Données
astronomiques de Strasbourg. Vous aiderez grandement 1’équipe de développement en activant ce
mécanisme de statistiques d’utilisation (courts rapports d’utilisations (logs) transmis
automatiquement au CDS). Ils sont anonymes et ne contiennent aucune information locale ou
personnelle (noms de fichier, répertoires, ...). Ces statistiques sont précieuses pour justifier de
I’activité du CDS auprés de ses tutelles gouvernementales francaises, et décider des futurs
développements. Vous pouvez bien siir écarter cette option selon vos préférences.

Manipulation des données planétaires : A partir de la version 12 d’Aladin, il est possible
d’activer 1’accés aux données planétaires (surfaces, catalogues, couvertures). Cependant, ces
données sont tributaires de 1’évolution des standards IVOA associés aux planétes. L’état actuel de
ces protocoles ne permet pas toujours de différencier efficacement les données planétaires des
données célestes. L’acces aux données planétaires est donc fourni « en 1’état », sans garantie d’un
affichage toujours cohérent. Lorsque cette option est activée, 1’arbre des collections fait
apparaitre une nouvelle branche « Systéme solaire » pour accéder a ces ressources. Dans le cas
ou Aladin ne peut étre assurer que les données a superposer sont cohérentes (méme planete,
uniquement céleste, ...) il affichera un message d’alerte rappelant le probléeme potentiel.
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La fenétre des préférences permet également :
» De créer sa propre langue de traduction (voir ci-dessous) ;
» De recharger en cours de session toutes les définitions des serveurs de données, ce qui
aura également 1’effet de réinitialiser le cache interne des méta données d’ Aladin.

Note : Certains parametres ne sont pas configurables par la fenétre des préférences, mais
simplement conservés d’une session a 1’autre, par exemple, la taille et I’emplacement de la
fenétre Aladin, le type de réticule (large ou classique), 1’activation ou non des infobulles sur les
sources...

Astuce : Les paramétres de configurations sont conservés dans un simple fichier ASCII
« Aladin.conf » qui peut étre édité dans le répertoire « .aladin » présent dans votre répertoire
d’accueil ($SHOME en unix, \Users\YourName en Windows). Pour réinitialiser les parameétres
dans la configuration d’origine il suffit de supprimer ce fichier.

Gestion des langues de l'interface

Aladin supporte plusieurs langues pour son interface graphique. Il est possible de créer sa propre
traduction si la langue que vous souhaitez n’est pas encore supportée ou pas totalement traduite.
Pour cela utilisez le bouton « Nouvelle traduction » et spécifiez — en anglais — votre langue ainsi
que le code «2 lettres » qui y correspond (ex : "French" - "fr"). Aladin ouvre une fenétre
d’édition qui affiche I’ensemble des expressions qu’il est nécessaire de traduire (en anglais),
celles qui ont déja été traduites le cas échéant et celles qui ne sont plus nécessaires (utilisées par
une version antérieure par exemple). Vous pouvez installer votre traduction qui apparaitra a la
prochaine session comme une alternative possible de langage dans la liste des traductions
supportées.

Précisions :

» Les expressions qui ne sont pas traduites apparaitront en anglais.

» Aladin supporte les langages non ASCII (ex : chinois...) et éventuellement écrits de
droite a gauche (ex : persan...).

» 1l est possible de compléter ou corriger une traduction existante. Pour cela il est
nécessaire d’installer au préalable la langue en question puis d’appuyer sur le bouton
« Nouvelle traduction » en laissant vide les champs « Langue » et « Code 2 lettres ». Vos
compléments de traduction ne concerneront que votre installation d’Aladin.

A noter : Si vous le désirez, vous pouvez contacter le CDS'" et ’équipe de développement
d’Aladin afin de faire profiter la communauté des utilisateurs de votre travail. Votre fichier de
traduction est sauvegardé dans le méme répertoire que le fichier de configuration d’Aladin (voir
ci-dessus) avec le nom « Aladin-langue-version-perso.string... ».

5.22 La console de commandes

Menu : Outil => Console de commandes...
Raccourci: F5

''cds-question a unistra.fr
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Toutes les actions réalisables via I’interface
graphique peuvent également étre faites par

des « commandes en ligne ». Le but est de | °== Type  Description
. oy . . 13/12f17 18:22:47 [Cmd  |rm "http:/[archive.eso.org/dss/dss/image?ra...| o
pouvoir utiliser Aladin en mode « Script» | iz/12/17 3:22:57 lcnd |rm CDS/P/DSS2/color

ANAHiH1 3 3 131217 18:22:57 |Cmd  |rm irsa.ipac/2mass/images/asky-at

pour effgctuer des travaux répétitifs, mdluner O e
des traitements a effectuer ou controler | [13/12/i715:23:00 |Cnd |cview “https:/firsa.ipac.caltech.cdu:a43/cgi-b...

T 13/12f17 18:23:02 [Cmd  |cview "http://archive.eso.org/dss/dss /image...
Aladln d dlStance‘ 131217 18:26:21 |Cmd  |resamp "http:/ farchive.eso.org/dss/dss/ima...
131217 18:26:32 |Cmd  |overlay on
~ . 131217 18:28:04 |Cmd  |rm "Rsp [http:/ farchive.eso.org/dss/dss/ima...
Ces commandes peuvent etre soumises par 13/12/17 18:43:25 |Cmd | modeview 2

différents canaux dont les principaux sont 13/12/17 18:49:46 |Cmd  |get HIPS(CDS/P/SD559/g) 023.46637 +30.803...

& Console Aladin - O X

131217 18:49:54 |Cmd 01:33:36.16 +30:51:03.9 W

» Le champ « Commande » sous le | Command:
menu ; grid on| ~

» La « Console de commande » ; . -
> Un f1c¥11er de commandes ; e T
» L’entrée standard.

Motepad: .

05:41:03.41 -02:24:54.5 €

ME7 => (ICRS) 08:51:18.00 +11:48:00.0
M110 =» (ICRS) 00:40:22.08 +41:41:07.1

La console de commande s’ouvre par le | |M33=» (ICRS) 01:33:50.50 +30:39:35.8

. 01:33:51.93 +30:48:11.0
menu « Outil => console de | |01:33:35.48 +30:41:04.0

~ . . L
commandes... ». Cette fenétre visualise sous | |. B
forme d’une table toutes les Commandes Copie le contenu du panneau des mesures Effacer

équivalentes aux actions qui ont été déja
réalisées via I’interface graphique durant la session, ainsi que pour les sessions précédentes. C’est
une aide pratique pour apprendre la syntaxe. Il est possible de taper directement une ou plusieurs
commandes dans le rectangle de saisie au milieu de la fenétre.

Astuce : la sélection a la souris d’une ou plusieurs commandes de la table entrainera leur recopie
dans le champ de saisie en vue de leur édition et exécution.
Alternative a la console

Pour passer rapidement une commande sans ouvrir la console, il est possible de la saisir
directement dans le chami « Commande » situé sous le menu principal (cf. 5.1.5).

get Simbad M101 14° X

Le petit triangle a gauche de ce champ vous ouvre I’historique de toutes les commandes scripts
précédemment exécutées (via une vraie commande script, ou par une action dans !’interface
graphique). Cette liste est également consultable en utilisant les fléches Haut et Bas dans le
champ de saisie.

Astuce : la saisie au clavier d’'une commande ne nécessite pas d’avoir au préalable cliqué dans le
champ « Command ». L’usage des fléches « haut » « bas » permet de réafficher rapidement les

commandes précédentes (resp. suivantes).

Veuillez-vous référer a la section « Aladin par script» (cf. 7.1, ci-dessous) pour plus
d’information sur le controle d’Aladin par script
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6 Les outils annexes

Aladin dispose de quelques outils supplémentaires élargissant son champ d’application, dont
entre autres :

Un gestionnaire de « macros » pour les travaux répétitifs ;

Un outil de génération de relevés progressifs (HiPS) ;

Un outil de génération de couvertures (MOC) ;

Un mécanisme d’interactions avec d’autres outils astronomiques compatibles

« Observatoire Virtuel» ;

L’outil d’extraction de source : S-extractor ;

Un générateur de « vues vignettes »

VVVYY

Y VY

Nous allons présenter rapidement chacun de ces outils.

6.1 Le gestionnaire de macros

Menu : Outil => Macros...
Script : macro ...

@ Macros - [m] x
Fichier Aide

Pour faciliter les traitements répétitifs, Aladin offre un mécanisme
de « macros » basé sur les commandes scripts (cf. 7.1). Il s’agit de _

,oa. . . hlps(FDS/Pstszfco\or) $3
rédiger un script utilisant des commandes textuelles et pouvant .
incorporer des noms de variables afin que le script puisse étre
utilisé de maniere répétitive, par exemple sur une liste de noms

Type or load a macro script

d 3 Obj etS Saisissez ou chargez une liste de paramétres
Ajouter une colonne Effacer
A . . §1 52 %3
La fenétre des macros s’ouvre via le menu « Outils => : Mo cats  |19:40146.58 495702 | | m
oG 2510 05:55:25, 20 16:00i57.5 |- |

NGC 7078 645 |21:29:59.48 +12:10:51.2 ...
NGC 3918 11:50:17.77 -57:10:56.4 ...
NGC 2818 09:16:01,49 -36:37:37.4 ..
NGC 6572 18:12:06.37 +06:51:13.0 |...

Macros... ». Elle est divisée en 3 parties :
1. Le panneau supérieur permet la saisie d’un script. Celui-ci
pourra inclure des « variables » nommeées $1, $2, etc ;
2. Le panneau du milieu permet de fournir la liste des valeurs
que peuvent prendre les variables ;
3. Le panneau du bas permet de controler 1’exécution.

EaET e )

Exécution du seript

Exéc. paramétres courants

Exéc. tout Exéc. tout depuis params courants

Alternativement, le chargement de la liste des valeurs (tableau central) par un fichier externe peut
étre générée a partir des sources de I’un des plans catalogues de la pile (menu Fichier de la
fenétre « Macros »).

Le script ainsi que les valeurs des parametres peuvent étre sauvegardés afin d’étre rechargés
ultérieurement (méme menu).

Astuce : Lors de la saisie du script, Aladin reconnait automatiquement la syntaxe et la met en
valeur a 1’aide de couleurs. Les commandes sont « cliquables » pour afficher rapidement de
’aide s’y rapportant.

6.2 Générateur de relevés progressifs HiPS

Menu : Outil => Générer un HiPS via...
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Ligne de commande :  java —jar Aladin.jar —hipsgen ....

Aladin integre la librairie « Hipsgen » de génération de relevés progressifs HiPS. Cette librairie,
développée et maintenue par le CDS permet de construire de maniére rapide et efficace un HiPS
a partir d’une collection d’images individuelles.

Un HiPS, ou Hierarchical Progressive Survey, et une mosaique d’images astronomiques stockée
sous forme de tuiles hiérarchiques utilisant le découpage du ciel HEALPix. Il s’agit d’une
méthode inventée par le CDS et repris par I’IVOA (International Virtual Alliance) sous la forme
d’un standard international dont le document est disponible a 1’adresse suivante :
http://www.ivoa.net/documents/HiPS/. La création d’un HiPS consiste a générer la mosaique, le
découpage, puis la génération de 1’arborescence des tuiles qui constituent le HiPS final. Suivant
le nombre d’images sources et leurs tailles, ce processus peut prendre entre quelques secondes et
plusieurs jours.

Détails techniques : Hipsgen permet de traiter 1 terapixels sources en une dizaine d’heures sur
une machine de moyenne puissance. Il peut prendre en charge de 1 a plusieurs millions de
fichiers images sources. Il peut gérer I’ajout a posteriori d’images supplémentaires dans un HiPS
existant. C’est ’outil utilisé par le CDS et par la plupart des
autres centres de données qui fournissent des relevés
progressifs HiPS : ESAC, JAXA, IRAP, CADC, HEASARC,

A savoir : pour afficher un HiPS directement dans une page
Web, utilisez « Aladin Lite" ». 1l s’agit d’un code développé
par le CDS, écrit en JavaScript dédié a 1’affichage des HiPS

dans un navigateur Web (ci-contre, I’utilisation d’Aladin Lite par 1’équipe
VIRGO pour visualiser les zones probables d’émissions des ondes
gravitationnelles).

Aladin pilote Hipsgen soit par I’interface graphique via le menu « Qutil -> Générer un HiPS... »,
soit par la ligne de commande de démarrage d’Aladin avec 1’option « -hipsgen ». Un document
dédié a la génération des HiPS par commande en ligne est disponible sur le site du CDS™.

L’utilisation d’Hipsgen a travers 1’interface graphique d’Aladin s’effectue en plusieurs opérations
consécutives paramétrables a 1’aide d’un formulaire a onglets successifs que nous allons
présenter succinctement.

Onglet 1 : La description des données — entrées et sorties

Le premier onglet permet de décrire I’emplacement de la collection des images sources. Ces
images peuvent étre en FITS, JPEG ou PNG. Dans tous les cas, ces images doivent disposer
d’une calibration astrométrique. Cette calibration peut étre classiquement interne au fichier image
sous la forme de mots clés WCS (World Coordinate System) intégrés a I’entéte FITS, ou dans un
« segment commentaire » JPEG ou PNG, ou encore externe, sous la forme d’un fichier ASCII de
méme nom et d’extension « .hhh ».

?http://aladin.cds.unistra.fr/AladinLite/doc/
Bhttp://aladin.cds.unistra.fi/hips/HipsIn10Steps.gml
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& Créez votre propre ciel progressif (HiPS) - O x

-1- Description des données  -2-Création  -3- Post-fraitement -4- Publication Construction RVE

Ce fanmuiaine vous permet de consiruie un ‘ol orogressit” également aopels HIFS (Hierarohical Progressive
Survey) 8 partir dune colection dimages (FITS, JPES ou ANG, calbrées astrométniguement, eventuelement
gapoées). Aladin rééchantilionne volre colection dimages en HEALPx, ef enregisire e résultat sous

Iz forme d'une Aigrarchie de répertaires et de fohiers (nommes Tulles 7). Uine fols gendré, vous pourmes
aoceder directement 3 volre oel progressif auss simplement gue cewx defg disponibies dans Alsdin. Vows
pourrez également fe publier 2fin de le rendre accessbie 3 vos collshorateurs.

Source (rep ou map): 9 D:'Halphalorth

Rép. destination : 9 D:'\HalphaNarthHiPs', Parcourir...

Nom des données: 9 HalphaMorth

Param. avances: 9 Le jeu dimages sources a été modifié

[] Supprimer toutes les tuiles pré-existantes
(®) conserver les valeurs des pixels déja calculés () remplacer () moyenner
[] valeur BLANK alternative
[] Muméros HDU spécifiques(ex: 0 2all)
() Ajustement du fond du del (mot dé FITS [true =auto)
[] Fondufenchaing sur les recouvrements
[] Bords d'image & ignorer (M 0 5 E en pix)
[] Me traiter que certaines tuiles (ex 3/128...)

Voir une image originale REinit. Suivant =

Astuce : Vérifiez la présence d’une calibration astrométrique compatible en visualisant une grille
de coordonnées sur une image chargée dans Aladin.

Note : Le jeu d’images source peut étre réduit a une unique « map HEALPix », c’est-a-dire un
fichier FITS décrivant le ciel de maniéere globale a I’aide d’un découpage HEALPix.

La collection d’images sources est repérée par le répertoire du disque sur lequel elles sont
stockées (directement ou dans une arborescence). Ce peut étre directement le nom du fichier dans
le cas d’une image unique. Ce formulaire permet également d’indiquer le répertoire ou sera
généré le HiPS a produire.

Ce premier formulaire propose d’autre part une série de sélecteurs et de champs de saisie
précisant le mode de fonctionnement du générateur de HiPS :

» BLANK : Ce champ de saisie permet d’indiquer une valeur de pixel spécifique pour
repérer ceux qui ne doivent pas étre pris en compte. Ce champ est normalement renseigné
dans I’entéte FITS de I’image, mais souvent absent ;

» HDU : Un fichier FITS peut étre structuré en plusieurs extensions nommées HDU. Ce
champ permet d’indiquer quelle est la, ou les extensions, a prendre en compte ;

» Fond du ciel : Méthode d’ajustement du niveau de « fond du ciel » d’une image a I’autre
et éviter un effet « patch work ». Ce champ de saisie peut prendre soit la valeur d’un mot
clé, présent dans I’entéte FITS des images et fournissant explicitement la valeur du « fond
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du ciel » pour chaque image (ex : BKGROUND), soit la valeur « auto ». Dans ce cas,
Aladin/Hipsgen effectuera une analyse statistique de chaque image et tentera de
déterminer automatiquement chaque valeur de « fond » ;

» Fondu/enchainé : I’activation de ce sélecteur entrainera un effet de « liaison » pour
chaque recouvrement d’images sources. Par défaut une simple moyenne est calculée pour
chaque pixel de ces zones de recouvrement. En mode fondu/enchainé, cette moyenne sera
pondérée par la distance au bord le plus proche (uniquement sur le 6°™ de la largeur
(respectivement hauteur) ;

> Bords de I’'image : Dans le cas ou les images sources ont des bords non exposés (pas de
valeurs de mesures), ou erronés (pixels aberrants a la limite du capteur original) ce champ
permet d’indiquer le nombre de pixels des bords de I’image a ignorer ;

> Restriction de la région a traiter : le dernier champ de saisie permet de restreindre le
calcul du HiPS a une région spécifique déterminée par une suite d’indices HEALPix.

Une fois ces différents parametres renseignés, passons a la création du HiPS a proprement parler.

Onglet 2 : La création — génération des tuiles FITS

Le deuxieme onglet permet de préciser le codage qui doit étre utilisé pour mémoriser les valeurs
des pixels, ainsi que la résolution finale du HiPS a générer. Aladin/Hipsgen utilise la premiere
image présente dans le répertoire source pour déterminer des valeurs par défaut.

Il ne reste plus qu’a lancer la création du HiPS. Celle-ci s’effectue en deux étapes
correspondantes aux deux barres de progressions. Tout d’abord une indexation des images
sources dans 1’espace HEALPix, puis le traitement pixel par pixel pour produire les tuiles HiPS
pour chaque niveau hiérarchique.

Astuce : Le bouton « voir la couverture » s’active a la fin de la premiére phase et vous permet de
contréler la région couverte par 1’ensemble des images sources sous la forme d’un MOC.
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{& Créez votre propre ciel progressif (HiPS) — O x

Nombre de bits par pixel 0
short (8bits) int (16bits) long int (32bits)
float real (32bits) double real (64bits) Conserver le BITPIX original

Résolution angulaire du pixel 0

Pixel angular HEALPix: Tiles: {*) Space
resolution order [ MSIDE Depth [ Mb required (*)
51,53" 12 [ 4096 3/ 260 345,8MB A
] 25.77" 13 /8192 4/ 1040 1,02GE
] 12.88" 14/ 16384 5/ 4150 5,4GE
] 6.442" 15 [ 32753 & [ 16640 21,61GE
] 3.221" 15 [ 65536 7 | 66560 86,45GE
] 1.61" 17 [ 131072 8 [ 266240 345,8GE
] 805.2mas 18 [ 262144 9 [ 1064960 1,35TB
1 AN Ermae 10 J 247999 10 AC09A0 = = e
(%) 33.854% of sky => 13966°"2
Healpix Indexation Sky tesselation
] 7%

. Origina/ images: 113 files (&l gzipped) using 45,47MB == biggest: [385x1x385 x4]
Processing info:  thread: 4 / 4 - RAM: 303,42MB/1,21GE (FITS cache: 15,93MB)
Low fevel fles: 2941260 tiles for 29MB - avg.proc.time: 0,875 [0.218s .. 1.453s]

. Tree fies: 0 tile for 0B - ava.proc. ime: 0.0s
. Time: runmning 65 - 360 tilesmn
< Précédent Voir la couverture (index)... LAMCER Pause Annuler Suivant =

A la fin de I’étape 2, le HiPS est prét, mais uniquement disponible sous la forme de tuiles FITS.
Celles-ci contiennent toute la dynamique des valeurs des pixels originaux, mais sont
volumineuses en terme de place disque, et lors de leur utilisation, de temps de transfert.

Onglet 3 : Post traitement — génération des tuiles JPEG/PNG

Le troisiéme onglet permet de créer un deuxiéme, voire un troisieme jeu de tuiles HiPS, mais
cette fois-ci compressées en JPEG ou en PNG. Ces tuiles alternatives seront ajoutées a
I’arborescence produite dans la phase 2 de génération du HiPS. L’avantage de générer a la fois
des tuiles HiPS au format Fits et JPEG/PNG offrira aux outils d’affichage HiPS — tel Aladin
Desktop ou Aladin Lite — 1’opportunité de choisir son mode d’acces, soit rapide en tuiles
compressées, soit plus lent mais avec toute la dynamique des valeurs des pixels.

Les parametres de cet onglet permettent d’indiquer la plage des valeurs de pixels qui seront
retenues pour générer les tuiles compressées. Deux méthodes sont proposées. La premiere
consiste a fournir les deux bornes de I’intervalle. La deuxiéme méthode va reprendre le réglage
courant utilisé par la visualisation du HiPS généré a 1’étape numéro 2. Cette méthode est bien
plus souple et puissante puisqu’il est possible de prendre en compte la fonction de transfert telle
que vous 1’avez définie (cf. 5.5).
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Le dernier sélecteur de ce formulaire décrit la méthode de calcul de tuiles hiérarchiques. Chaque
niveau hiérarchique HiPS divise par 4 le nombre de tuiles en agrégeant 4 pixels en 1, soit par une
moyenne, soit par une médiane.

{& Créez votre propre ciel progressif (HiPS) — O et

Description des données  -2- Création | -3- Post-traitement ! 4- publication  Construction RVE

Cette éfape vous permet de oréer fes fules de prévisualization (PG ou ANG) assoodes
Auy fulles FITS, Dans ke cas ou vous souhaifer rendre aocessble res données deouis
un site Web § est wivement conselice de générer ces fuiles gui ofitiront & vos
uilisateurs des femps de réponses bien plus rapides. Le format JPES est plus compact
mais altére iBgérament les donndes. I ne gére pas 3 fransparence 3 [z différence

dls PNG.

(@ Seuvillage manuel (linéaire) : 0

Min (-4.691 Max 4028

() seuvillage utilisé dans la vue : 0
Pivels: 0. 255 ffom 0 .. 255 - Transfert function: Linear

Format des tuiles () JFEG (@) FNG

Méthode de calcul : médiane maoyenne

On

L’a
pro

Un
Ci ¢
cha
ne ¢
suiv
acc

On

& Créez votre propre ciel progressif (HiPS) — O et

-1- Description des données  -2- Création  -3- Post-traitement -3 Publication  Construction RVE

Juste pour vous :
A nlimporte quel moment, vous pouvez rechargez votre del progressif simplement en ouvrant le repertoire dble

D 'HalphaMorthHiPSY,

Distribution restreinte :

Pour une distribution restreinte de votre relevé, placez le répertoire de destination
derriére un serveur Web. Vos collaborateurs pourront accéder a votre relevé en utilisant
directement ['adresse Web d-dessous. Cet accés pourra étre éventuellement protégé
par mot de passe,

http: ffservername. org/HalphaMor thHiPS

Distribution en tant gque fichier FITS HEALPD: unique :

Exparter votre relevé généré en tant gu'un unigue fichier FITS gue vous pourrez envoyer
a vos collaborateurs. Ce fichier sera conforme & la norme HEALPix MESTED et sa résolution
angulaire par pixel sera de 51" (NISDE=409a).

| 0 %

GEnérer

Distribution publique :

Afin de rendre accessible votre releveé pour tous les utilisateurs Aladin, veuillez
“exposer” le repértoire de destination derriére un serveur Web, remplir et valider
le formulaire suivant :

£ Formulaire pour publier  §

iPS

lle-

le
S’il
re a
1dre
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Le dernier onglet est destiné a la génération d’un HiPS couleur a partir de deux ou trois HiPS en
niveaux de gris ayant été préalablement générés. Chaque tuile du HiPS couleur sera générée a
partir des tuiles correspondantes des HiPS originaux. Il s’agit donc de désigner quel HiPS
original est pris en compte pour la composante rouge, respectivement verte et bleu. D’autre part,
il est nécessaire de paramétrer la plage de valeurs des pixels qui sera prise en compte pour
chaque composante couleur notamment si les HiPS originaux ont des contrastes assez peu
homogeénes entre eux. Le choix de ces parametres dépend du résultat souhaité : qualité visuelle,
mise en évidence des objets faibles, etc.

Aladin propose deux méthodes :

1. Classic : Pour chaque HiPS original, la plage des pixels est déterminée avec la méme
méthode que le rendu visuel utilisé par Aladin pour son interface (cf. 5.5- Dynamique des
pixels). Il s’agit de définir I’intervalle retenu (« cut min », « cutmax »), et éventuellement
une fonction de transfert alternative a « Linear », ainsi qu’un seuil médian (cut middle).
Pour simplifier la saisie de ces valeurs, elles seront automatiquement reportées a partir du
réglage du rendu visuel si le HiPS concerné a été chargé dans la pile.

2. Lupton : Aladin permet également de définir les 3 paramétres nécessaire pour appliquer
I’algorithme proposé par Lupton (min, strech et Q). Pour plus de renseignement sur cette
méthode, veuillez-vous reporter a I’article « Preparing Ref-Green-Blue Images from CCD
Data »"*

Note : Pour que la génération puisse s’effectuer, il est indispensable que ces HiPS soient
disponibles sur la machine locale et non pas uniquement accessibles via un serveur http. De plus,
si ces HiPS originaux sont chargées dans la pile d’Aladin, il est possible de visualiser
dynamiquement le résultat final qui sera obtenu en fonction des paramétres retenus. L’utilisation
du multi-fenétrage aidera grandement a 1’ajustement dynamique des parametres.

"“https://ui.adsabs.harvard.edu/abs/2004PASP..116..133L
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& Créez votre propre ciel progressif (HiPS) - O X
-1- Description des données  -2- Création  -3- Post-traitement  -4- Publication  Construction RVE

Ce formulaie est dedie 8 ls oréation d'un “oel progressit™ (HPS) en cowlewr. Caluwi-o
est généré 3 partir de 2 ou 3 HPS en niveaux de gris, ayant dejs éte caloulés au
préalable. Pour ce faire, vous devez dharger ces HIPS dans la pite dAladin, pus
ajuster leur contraste respectit. Aprés cela, ¥ sagit dassoner 3 chaoune des
composantes cowleurs Rouge, Vert et Bleu le ol souhaite, de spedfier ke réperfoire

de destination puis de lBncer e calou,

1) Rouge i i
2) Vert r ~
3) Bleu g v

Rép. destination : C:\Data\sD55'RGE

Methode RVE e (®) Classic () Lupton reset

Classic  Lupton
-| Cutmin [+ -| Cutmiddle [+ |-| Cutmax [+ Function
Red -0,03702 0.1743 0.544 Linear
Green -0.06264 0.2654 0.5508 Linear
Blue -0,03702 0.3738 0.7815 Linear

Calcudl de [ higrarchie: 9 (® médiane () moyenne
Fiftre e [] Réduction du bruit

Format des tules (@) (O PEG @ PNG

I 0%
LRGE fles: -
. Time: =
Prévisualisation. .. E Commande script ? i -| LAMCER Pause Annuler 9

Le formulaire offre également la possibilité d’ajuster 3 parameétres de sortie :

1. Le mode de calcul de la hiérarchie HiPS : Il détermine la méthode pour générer la tuile
parente a partir de ses 4 tuiles « filles », autrement dit, quelle valeur de pixel conserver
pour les 4 pixels correspondants dans le niveau hiérarchique plus profond. Il peut s’agir
d’une moyenne des 4 pixels concernés, ou d’une « fausse médiane », c’est-a-dire 1’une
des valeurs de 2 pixels médians. La deuxieme méthode permet de mettre en évidence les
grandes structures et filaments. Ces modes de calcul sont appliqués composante couleur
par composante couleur.

2. Le filtre de réduction du bruit : il s’agit d’appliquer un filtre gaussien qui lisse le bruit
de fond.

3. Le format des tuiles : Le format PNG permet de gérer une transparence éventuelle,
intéressant dans le cas de relevés partiels du ciel. Le JPEG offre un meilleur taux de
compression et une génération plus rapide, mais ne permet pas de gérer la transparence, et
introduit des effets visuels indésirables liés a son algorithme de compression.

Note : Le bouton « Commande script » affiche les parametres de la commande script équivalente
aux choix indiqués dans le formulaire. Cela vous permet de préparer visuellement le rendu
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souhaité, mais de lancer la génération du HiPS couleur via un ligne de commande « Aladin -
hipsgen... ».

6.3 Générateur de couverture MOC

Menu : Couverture => Génération d’un MOC spatial a partir de...
=>Une collection d’images
Ligne de commande :  java —jar Aladin.jar —-mocgen ....

Aladin integre la librairie Mocgen de génération d’une couverture MOC spatial a partir d’une
collection d’images. Tout comme pour la génération d’un HiPS, Aladin/Mocgen va traiter une
collection d’images sources stockées dans un répertoire sous la forme d’une liste ou d’une
arborescence de fichiers images. Les formats supportés sont identiques a ceux décrits dans la
section précédente (cf. 6.2).

Les parametres de controle de Mocgen ne présentent pas de difficultés. A noter cependant la
grande différence de temps de traitement dans le cas ou I’on choisit de construire le MOC
uniquement en se basant sur I’entéte WCS de chaque image sans chercher a examiner un a un
chaque pixel de chaque image.

A savoir : il est inutile de générer un MOC suite a la création d’'un HiPS. En effet, lors de la
génération du HiPS, le MOC correspondant aura déja été calculé et stocké dans le répertoire
racine du HiPS sous le nom de fichier « Moc.fits ».

{5 Génération de MOC - O e

Indiguez le répertoire de votre collection dimages,
ainsi que la rézolution souhaitée
puis appuyez sur le bouton CREER. pour générer le MOC résultant.

Source (rep ou map): Browse

Spedifical FITS HDU (e.qg 1,3-5[all} (first one by default)
[[] Scanning sub-directaries
[[] Scanning image pixel values (not just WCS)

== Alternative BLAMNK value

MQOC resolution @ | Order 10 == 3.435' w

CREE | | Réinit. | | Ferme 9

Il y a aussi la possibilité de créer un MOC temporel ou un MOC spatio-temporel : Couverture
=> Génération d’un MOC temporel a partir... , Generate a Space-Time MOC based on

6.4 Interaction avec les outils VO : SAMP
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Menu : Outil => QOutils VO...
Types de données :  Catalogues, Images, Spectres (pas de HiPS)

Aladin manipule des images et des catalogues pour générer des vues. Il peut cependant s’appuyer
sur d’autres applications indépendantes pour effectuer d’autres traitements tels que générer des
graphes 2D, afficher des spectres... Pour cela, Aladin implante un mécanisme issu d’un standard
de I’Observatoire Virtuel nommé SAMP pour Simple Application Messaging Protocol.

Principe

SAMP permet de faire dialoguer des applications pour que non seulement elles puissent se
transmettre des données, mais également interagir. Ainsi la sélection d’une source astronomique
sera, par exemple, visualisée simultanément dans toutes les applications.

Installation

Aladin facilite 1’utilisation de SAMP en présentant dans une fenétre une liste des applications qui
peuvent « dialoguer » avec Aladin. Cette fenétre offre la possibilité d’installer facilement 1’une
ou I’autre de ces applications,

afin qu’elles apparaissent dans i& VOTool Application installer & controller - O X

le menu « OM tl l => OI/! fl l S VO This list shows a selection of VO tools compatible with Aladin. These sofiwares are able to cooperate with Aladin by
. exchanging data, cross selecting sources...

=>...» s et qu > elles pl_ussent Select, install if required, or define yourself (Running directory + Command line) the VO applications directly
runnable from the Aladin menu.

ainSi étl‘e démarrées Contact directly the authors for any questions, bugs...

faCllement- Cette hSte est SPL e ; CASSIS spectrum analyser [IRAP/OVGSO]

ITlall'ltenU.e d Jour ‘?’E}Tscg;ihl Origis 2 Institut de Recherche en Astrophysique et Planélogie (IRAP - France)

dynamiquement, elle fait ainsi | voper Coprant: P USIARS .

N , Vospec Documentation : http: fjcassis.irap.omp.eu?page =cassis
apparaltre les nouveautes, les | veno The CASSIS (Centre dAnalyse Scientifique de Spectres Instrumentaux et Synthéques) "~
] software has been developed by CESRARAP since 2005. CASSIS uses the SSAP

nouveues Versions protocol (Single Spectral Access Protocol) to access the [VOA services in order to retrieve

disponibleS. . any spectra (Hubble, Corot, Splatalogue, 130, etc; the complete list dans be found at
hitp:firegistry. euro-vo.org webpage) via our 35AP module. Also CASSIS uses the SAMP
messaging protocol (Simple Application Messaging Protocol) that enables astronomy v
Version : 3.7 (SAMP compatible)

. Insiall. method :  Java Webstart {no installation)

ConneXIon SA MP Running directory :  — Browse
Command fine :

Pour faire interagir deux Available in the Aladin menu

applications compatibles install. | Asly  Run. | Delete.. New... | [ Cose

SAMP il suffit qu’elles
s’exécutent simultanément. Aladin offre la possibilité de démarrer une autre application SAMP
directement a partir du menu « Outil => Qutils VO...».

Lorsque les deux applications s’exécutent, elles se « verront » 1’une I’autre suivant le mode qui
est propre a chacune, par exemple dans un menu « Interop » (TOPCAT, VOPlot, VOSpec,
Aladin...), « File => SAMP » (DS9), ou au moyen d’une icone particuliere (CASSIS, Aladin).

Aladin visualise les « connexions » SAMP au moyen de 1’icone représentant une antenne radar
en bas a droite de sa fenétre principale. Si celle-ci est dessinée avec une série « d’ondes », cela
signifie qu’une ou plusieurs autres applications compatibles SAMP sont en cours I
d’exécution et peuvent interagir avec Aladin.

Le menu « Interop » regroupe l'ensemble des Interop
fonctionnalités associées a SAMP et permet Se connecter 3 SAMP
d'accéder aux options. Il est également possible Se déconnecter de SAMP

Envoyer les plans sélectionnés

Envoie les images sélectionnées a ...

Envoie les tables sélectionnéesa... 2 ... toutes les applications SAMP

Préférences SAMP topcat-1



d'utiliser le menu contextuel (clic-droit ou CTRL clic) en plagant la souris directement sur
« I'antenne ».

Transfert de données

Une fois Aladin « connecté » a une autre application, il peut recevoir des données (images,
tables...) qui apparaitront sous la forme de nouveaux plans dans la pile. Il peut également
envoyer des données. La méthode consiste a sélectionner le ou les plans concernés dans la pile,
puis a ouvrir le menu « Interop » afin de désigner I’application SAMP « cible » dans le sous-
menu adéquat.

Interactions

T T e

Généralement, lorsque les données sont des arclelaiss §
tables ou des catalogues, les sources 5
sélectionnées dans une des applications :
sont automatiquement sélectionnées dans o
I’autre application. C’est une méthode tres .
pratique pour, par exemple, repérer ou se :
situe dans le champ Aladin les sources o
présentant des particularités dans leurs
mesures dans un graphe couleur/couleur
dans TOPcat.

=]

A noter : Les actions «<SAMP» dépendent des applications, il est possible qu’une sélection
d’objet soit simplement ignorée par une application compatible SAMP mais qui n’a pas voulu
implanter cette possibilité.

6.5 Manipulation des spectres via CASSIS

Menu : Outil => Outils OV => CASSIS...
Type de données : Cubes FITS classiques

L’outil « spect » permet d’extraire et visualiser un spectre a partir d’un cube de données
préalablement chargé dans Aladin (cf section 5.1.5). Cependant, il s’agit d’un outil basique
uniquement destiné a la visualisation. C’est pourquoi Aladin peut faire appel a un outil externe
spécialisé dans I’analyse spectrale : CASSIS. Il s’agit d’un logiciel développé par I’IRAP
(Toulouse/France) dont un plugin compatible Aladin est facilement téléchargeable/installable afin
d’etre utilisé en interaction avec Aladin.
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Installation/exécution du plugin CASSIS

!]L ALADIN CASSIS PLUGIN £.2.0.0 - 2021-10-21 10:02 — O X
File Edit Modules View Scripts Windows Database Preferences VO Help Plugin

@ - AL~ 88

Le plugin CASSIS s’installe et s’exécute en quelques clics via le menu « Outil - Outils OV —
CASSIS spectrum alalyzer ».

Extraction d’un spectre et analyse via CASSIS

Aladin dispose de trois outils permettant d’extraire un spectre depuis un cube de données. Il
s’agit des outils « spect » qui effectue une extraction en un unique point, « phot » et « draw » qui
moyenne les valeurs sur un cercle, respectivement un polygone. Dés que CASSIS est actif,
chaque spectre extrait est automatiquement transféré a CASSIS pour affichage et analyse. Dans
le cas ou le cube de données ne dispose pas d’information relative aux échelles utilisées, CASSIS
propose un petit formulaire afin de compléter les informations nécessaires.

La modification a posteriori des outils d’extraction (position, surface) et possible et remet
automatiquement a jour les spectres correspondants dans CASSIS.

Utilisation de CASSIS

Le plugin CASSIS est quasi identique a sa version classique. Il dispose de quelques fonctions
supplémentaires spécifiques a son usage conjoint avec Aladin. Il est notamment possible au
moyen du bouton central de la souris de désigner une zone sur le spectre qui entraine la création
d’une image dans Aladin. Celle-ci correspond a la moyenne des valeurs du cube original pour la
zone désignée.
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M. ALADIM CASSIS PLUGIN 6.2.0.0 - 2021-10-21 10:02 = a x
File Edit Modules View Scripts Windows Database Preferences VO Help Plugin
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La documentation de CASSIS est disponible en ligne (http://cassis.irap.omp.eu/help/) et
directement accessible via le menu CASSIS « Help — Users-s manual ».

6.6 Extraction de sources via SExtractor

Menu : Fichier => Sélecteur de serveurs
=> Tools => S-extractor...
Type d’images :  Images FITS classiques

Aladin ne dispose pas nativement d’outils automatique d’extractions de sources. Cependant, il
peut faire appel a « SExtractor » qui est un logiciel couramment utilisé par les astronomes pour

extraire des sources d’une image et calculer des valeurs de magnitude (Bertin & Arnouts — 1996).

Le menu «Fichier => Sélecteur de

serveurs => Tools => S-extractor » ouvre © s-extractor facility (v2.8.6) &2

7 bl
le «Sélecteur de serveur» sur l'onglet | . o POSSIL1-DS52.540 9
concernant 1’outil SExtrator. Ce formulaire | 1.choi xrus) 20

présente les parametres principaux pOUr | mag zero point
I’extraction de source et un sélecteur pour | satration (a0u)

désigner le plan — image concerné. stellar FWHM (arcsec) 1.2

Filter type default.conv v
La validation de ce formulaire entraine | Pnotdiam.aperture (pix)
I’interrogation a distance d’un serveur | Backeroundtype e v

Backgd annulus thick. (p...

Filtre d'affichage Object elongation ~
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implanté au CDS a Strasbourg et dédié a ce type de travaux. Cette machine va exécuter
SExtractor sur votre image, et retourner la table des sources extraites. Celles-ci apparaitront dans
la pile et donc projetées sur 1’image.

6.7 Géneération de vues « vignettes »

Menu : Vue => Créer une vue par image
Types d’images : ~ HIiPS et images classiques
Script : thumbnail ...

Aladin offre la possibilité de créer facilement des « vignettes » pour une liste d’objets, c’est-a-
dire une série d’images centrées sur les objets de la liste. Pour cela, Aladin propose de créer
autant de «vues » (cf.5.1.3) que d’objets. Les objets en question sont soit ceux qui sont
sélectionnées dans la vue courante, soit toutes les sources d’un plan catalogue ou d’un plan ne
contenant que des marques graphiques.

Exemple d’utilisation

Supposons que vous vouliez créer des vignettes des
« nébuleuses planétaires » les plus connues ;
» Chargez le HiPS DSS couleur en cliquant sur le
premier signet ;
» Dans I’arbre des collections, charger le catalogue
« CDS/Outreach/Nebulae/PN » en utilisant le
champ « Select » ;
» Créez les vues vignettes via le menu « Vue =>
Créer des vues vignettes ».

signale le petit cadenas en bas a gauche de chacune d’elles (cf.5.1.4 — vue verrouillée).

Les wvues «vignettes» sont automatiquement
« verrouillées » sur leur position centrale comme le

Astuce : Puisque les vues vignettes sont toutes verrouillées il est facile de ne supprimer qu’elles
en utilisant le menu « Vue => Supprimer toutes les vues verrouillées ».

Alternative

Il est également possible d’utiliser une macro (cf. 6.1) pour générer une a une les vignettes et les
sauvegarder dans des fichiers individuels.
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7 Aladin pour les experts

Dans cette section nous allons brievement présenter différents aspects d’Aladin s’adressant a des
utilisateurs avertis ou a des fournisseurs de données qui voudraient faire bénéficier leurs
utilisateurs des potentialités d’Aladin. Nous verrons ainsi :

» Comment utiliser Aladin en mode script ;

» Etendre les fonctionnalités d’ Aladin en développant des plugins java ;

» Comment dialoguer entre IDL et Aladin.

7.1 Aladin par script

En alternative a I’interface graphique, Aladin peut étre piloté par des commandes textuelles.
Celles-ci permettent d’effectuer les mémes opérations que via la souris mais dans un
environnement ou « I’interlocuteur » n’est pas nécessairement un utilisateur devant son clavier
mais peut étre un autre programme.

Les différentes applications des commandes scripts

Les commandes scripts peuvent étre utilisées dans différents contextes :
» En alternative a la souris via la console ou le champ de commande (cf. ci-dessus)
» Comme contrdle « a distance » par un autre programme via :
¢ [’entrée standard. Un shell script, ou autre script python/perl/etc pourra ainsi
soumettre des commandes a Aladin
¢ la méthode « execCommand(String) » pour qu’une autre application java partageant la
méme machine virtuelle Java (JVM) puisse « dialoguer » avec Aladin.
(http://aladin.u-strasbg.fr/java/FA Q.htx#Launch)
» Pour faire des « signets »
» Pour rédiger des « macros » (cf. section précédente)

Exemple de script

Exemple : Chargement d’une image par URL, ajout de Simbad, activation de la
grille et passage en table des couleurs « BB » :
get File (http://monServeur/monImage.fits)
get Simbad
grid on
cm bb noreverse

Liste des commandes

Pour connattre la liste des commandes et obtenir de 1’aide sur chacune d’elle, Aladin intégre une
aide en ligne accessible par le menu « Adide => Aide sur les commandes en ligne d’Aladin ».
Celle-ci transforme temporairement le panneau de la vue en hypertexte permettant de naviguer
rapidement dans cette aide. Vous pouvez également utiliser la commande script « help xxx » ou
xxx est le nom de la commande.
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Aladin script commands.
ey [11214]9]16
: T] [[x ]
1 [v2..]

oth] [zoom]

[-c .rr-].l [x] BITPIX

t(param)

[name]

=o] [x1]wvl...

[on|off|end]
msg

Utilisation des plans de la pile comme des « variables »

Dans le contexte des scripts, il est possible d’utiliser les plans de la pile comme des « variables »
accessibles par leur nom ou par leur position dans la pile. Ainsi toutes les commandes scripts
générant un plan peuvent étre préfixées par « NomPlan = commande...» pour indiquer que le
résultat de la commande va étre affecté au plan « NomPlan » (resp. @n ou n est le numéro du
plan, @1 étant le plan du bas de la pile). Si celui-ci existe déja, la précédente « valeur » de ce
plan sera remplacée, sinon il sera créé sur le haut de la pile.

Exemple : Affectation au plan « Monlmage » d’une image

DSS/ESO de M1:
MonImage = get ESO(DSS1l) M1

Cette méthode s’avere particulierement pratique et puissante lorsque les commandes scripts
concernent les opérations arithmétiques sur les images (additions, soustraction, multiplication,
soustraction, normalisation, convolution...)
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Exemple : Différence de 2 images en couleur J et F :
A = get Aladin(J) M1
B = get Aladin(F) M1
Diff = A - B

7.2 Lancement d’Aladin en ligne de commande

Comme toute application Java, Aladin doit étre exécutée au moyen d’une machine virtuelle Java.
La commande en ligne a passer dans une console suit la syntaxe suivante :

java [options java] —-Jjar Aladin.jar [options Aladin]
Exemple : java —-Xmx2g —-jar Aladin.jar theme=classic image.fits

L’option Java la plus courante est « -XmxNg » ou « N » représente le nombre de Go qu’utilisera
la machine virtuelle. Suivant votre configuration matérielle, choisissez une valeur de 1 a 2.

Les options propres a Aladin sont les suivantes :

Usage: Aladin [options...] [filenames...]
Aladin -hipsgen ...
Aladin -mocgen ...
Aladin -help
Aladin -version

Options:
-help: display this help
-version: display the Aladin release number
-local: without Internet test access
-theme=dark|classic: interface theme
-location=x,y,w,h: window position & size
-treewidth=w: default tree panel width (©=closed)
-screen="full|cinema|preview": starts Aladin in full screen
cinema mode or in a simple preview window
-script="cmd1l;cmd2...": script commands passed by parameter
-nogui: no graphical interface (for script mode only)
=> noplugin, nobookmarks, nohub
-noreleasetest: no Aladin new release test
-nosamp: no usage of the internal SAMP hub
-noplugin: no plugin support
-[no]log: with/without anonymous statistic reports
-[no]beta: with/without new features in beta test
-[no]lplanet: with/without planetary data
-0ld: obsoleted facilities re-activated (without any warranty)
-trace: trace mode for debugging purpose
-debug: debug mode (very verbose)

-hipsgen: build HiPS by script (see -hipsgen -h for help)
-mocgen: build MOC by script (see -mocgen -h for help)

The files specified in the command line can be :
- images: FITS (gzipped,bzipped,RICE,MEF,...), HEALPix maps, IJPEG,GIF,PNG
- tables: FITS, XML/VOTable, CSV, TSV, S-extractor, IPAC-TBL, Skycat or ASCII tables
- properties: propertie record list for populating the data discovery tree
- graphics: Aladin or IDL or DS9 regions, MOCs
- directories: HiPS
- Aladin backup : ".aj" extension
- Aladin scripts : ".ajs" extension
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7.3 Extension d’Aladin : les « plugins »

Menu : Outil => Plugins...

Aladin a été écrit dans le langage de programmation Java. Il est possible de développer des
extensions d’Aladin afin d’effectuer des traitements supplémentaires non prévus dans la version
de base. Ces extensions sont appelées « plugins » et doivent elles-mémes étre écrites en Java.

Installation de plugins

L’installation et la gestion des plugins se fait depuis le « gestionnaire de plugins » via le menu
« Outil => Plugins => Gestionnaire de plugins... ». Cette fenétre permet de visualiser d’un coup

d’ceil les plugins déja installés, et d’accéder vj & Getormaresepigns. - ooxy
disponibles sur le site officiel d’Aladin. acisinantes pas Alein. Ton oo 614 sdvesooeds pas des utirisscenrs
d'Aladin et non pas par 1'éguipe du €DS. Ces codes sont fournis sans
aucune garantis.
Les plugins doivent étre installés, sous forme|:ii 2oy Tl o oo iommersy mmnes sommeees ‘
« .aladin/Plugins » présent dans votre répertOi Votre répertoire & plugins | C:Jsers\Pierre\ aladin\Plugins Re-charge!
. N . Image creation with a calibration SEDPlugin
yourName sous Windows). Apres les avoir T —— ... T
. . Version : w20 - 15/06/2012 - Aladin v7.510
cliquer sur le bouton « Re-charge » pour qu’ils so oty .
-y
les glisser/déposer depuis votre environnement (Specteal Tnezgy Distzibucacn) from imeses 4|
plugins >>. loaded in Aladin.
Built spectrums can be exported in
several formats [ASCII, XML, VOTable) or
they can be sent to SAMP compatible
ECI‘itUI‘e d,un plugin ;iii:t?nm (i.e. VOSpec, Splat-VO, s
Sciptng :  sedPlugin
Threaded @ false
L’écriture d’un Plugin nécessite une connaiss s (L [
« d’étendre » la classe d’objet « AladinPlugin » ¢ £ ;
de la pile’ des images’ et des Catalogues. Charger... Déposer... Ajout local. .. Suppression. .. Plus dinfo... Fermer

A noter : Un plugin est une extension java d’Aladin. Il a donc acces aux structures de données
internes avec la méme rapidité que le code natif d’Aladin, et sans avoir a les dupliquer.

La documentation technique pour réaliser un plugin est disponible a 1’adresse suivante :

http://aladin.u-strasbg.fr/java/FAQ.htx#plugins. Le moyen le plus siir pour débuter et de

s’inspirer d’exemples fournis sur le site officiel d’Aladin.

7.4 Les interfaces VOApp & VOObserver

Aladin peut étre « piloté » par une autre application Java a travers deux interfaces Java dédiées
nommeées VOApp et VOObserver. Ces deux interfaces de programmation sont symétriques, elles
peuvent étre implantées dans les deux applications afin de régir les interactions possibles. 1l est
par exemple possible pour I’une des applications d’envoyer une table a 1’autre application, et si
I’utilisateur sélectionne dans cette derniere une ligne de cette table, recevoir un « callback »
propre a la ligne sélectionnée, et agir en fonction.
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Ces interfaces sont définies formellement dans les classes abstraites « VOApp » et
« VOObserver » du package source cds.tools d’Aladin. Elles sont téléchargeables
individuellement depuis le site Web du CDS."

Note : VOApp est issu d'une collaboration CDS/VOIndia débutée en 2004 afin de gérer les
interactions entre Aladin et VOPlot. Par la suite, 'TVOA s'est inspiré de cette interface pour
élaborer le standard PLASTIC, rebaptisé par la suite SAMP et également supporté par Aladin.
Vous retrouverez logiquement les mémes fonctions d'interaction. Il faut cependant garder a
l'esprit que les interactions via VOApp sont de 100 a 1000 fois plus rapides. D’un autre coté,
SAMP élargit le domaine d'utilisation pour des applications ne partageant pas la méme machine
virtuelle Java, voire méme avec un navigateur Web sous protocole http (WebSAMP). Ces deux
méthodes sont donc complémentaires. A vous de choisir laquelle est la plus appropriée suivant le
contexte de votre développement.

VOApp

L’interface VOApp comporte 9 signatures de méthodes que vous pouvez implanter dans votre
application. Aladin implantant cette interface, ces 9 méthodes sont déja implantées dans Aladin.

Les 4 premieres méthodes gérent 1’envoi ou la réception d’un catalogue au format VOTable,
respectivement d’une image au format FITS :

String putVOTable (VOApp app, InputStream in,String label);
InputStream getVOTable (String datalD);

String putFITS (InputStream in,String label);

InputStream getFITS (String datalD);

void showVOTableObject (String oid[]);

void selectVOTableObject (String oid[])

VVVVYY

Les 3 autres méthodes gerent respectivement 1’affichage de 1’application, I’exécution d’une
commande propre a 1’application, et enfin 1’ajout d’un « listener » VOObserver interagissant
avec un clic souris (cf. paragraphe suivant) :

» void setVisible (boolean flag);

» String execCommand (String cmd) ;

» void addObserver (VOObserver app,int eventMasq) ;

A savoir : Cette technique est utilisée par le logiciel ~ 5 " »u = o = [T ST
« GuideCam » de DP’ESO pour la préparation des "~ ... ..,: 5 5
observations des télescopes européens (le VLT par ' -/ L >
exemple), ainsi que par « APT » 1’équivalent NASA 57 Ll R G-

pour le télescope Hubble et le télescope JWST. :

VOObserver

L’interface VOObserver vient compléter VOApp dans un contexte spécifique de manipulation
d’images astronomiques. Elle offre la possibilité d’inscrire son application comme « listener »
d’un clic souris dans Aladin afin de recevoir la position et/ou la valeur du pixel correspondante.

Elle ne comporte que 2 signature de méthodes :
» void position(double raJ2000,double deJ2000);
» void pixel (double pixValue);

15

http://aladin.cds.unistra.fr/java/VOApp.java, http://aladin.cds.unistra.fr/java/VOOQObserver.java
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Lancement d’Aladin

L’instanciation d’Aladin depuis votre application peut se faire de la fagon suivante :

VOApp aladin = cds.aladin.Aladin.launch();

Exemple d’utilisation

import cds.tools.*;
public class mytool implements VOObserver {
public void startAladin() {
// Instantiate Aladin
VOApp aladin = cds.aladin.Aladin.launch();
// Register me for Position and Pixel events
aladin.addObserver (this, VOApp.POSITION|VOApp.PIXEL) ;
}
// VOObserver callback method for coordinate positions
public void position (double raJd2000,double deJ2000) {
System.out.println ("The current Aladin coordinates are: "+rad2000+" "+deJd2000);
}
// VOObserver callback method for pixel value
public void pixel (double pixValue) {
System.out.println ("The current Aladin pixel value is: "+pixValue);

}

7.5 Interactions IDL / Aladin

IDL (Interactive Data Language) est a la fois un langage et un moteur de calcul de traitement
d’images. 1l est largement utilisé dans la communauté astronomique. Vous trouverez a 1’adresse
suivante : http://aladin.cds.unistra.fr/java/idl aladin interface.tar.gz un ensemble de fonctions
IDL (fichier d’extension « .pro ») permettant d’accéder a Aladin depuis 1’environnement IDL. Il
vous sera des lors possible d’échanger des images, des tables, des tables de couleurs, etc.

Pour plus d’informations sur 1’usage de la librairie Aladin pour IDL, veuillez-vous référer au
FAQ a I’adresses suivante : http://aladin.cds.unistra.fr/java/FAQ.htx#IDL.
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8 Bon a savoir

Aladin, a travers ses versions successives, est un logiciel de plus de 20 ans d’age... c’est déja un
bon cru. Vous trouverez de nombreuses informations techniques et pratiques dans la FAQ
disponible a 1’adresse suivante : http://aladin.cds.unistra.fr/java/FAQ.htx. Ce document est
continuellement remis a jour en fonction des nouvelles versions, n’hésitez pas a y jeter de temps
en temps un coup d’ceil pour repérer les nouveautés. Il existe aussi quelques « tutoriaux en
ligne », c’est-a-dire des travaux pratiques qui permettent d’expérimenter Aladin sur des cas
d’études astronomiques. Vous pouvez également regarder des vidéos de présentations. Ces
supports sont fournis soit par le CDS
(http://aladin.cds.unistra.fr/AladinDesktop/#Documentation), soit par des collaborateurs ou
utilisateurs externes réutilisant Aladin a leurs propres fins (les moteurs de recherche du Web vous
y conduiront rapidement).

Les sections qui suivent présentent quelques notes techniques qui peuvent éclairer la pratique
d’Aladin. Pour plus d’informations, référez-vous a la FAQ citée ci-dessus.

8.1 Les types de donneées supporteés

Aladin supporte la plupart des formats utilisés en astronomie que ce soit pour les images, pour les
catalogues ou pour les « groupements » de données. D’autre part, il prend en compte les
algorithmes de compression les plus répandus.

Format Type de données Logo Commentaires

FITS Image [+ WCS] E Pas de limite de taille

JPEG Image couleur [+WCS] FSW =Y <100 Megapixels'®

GIF Image couleur E

PNG Image couleur [+WCS] E

HCOMP Compression image FITS E frﬁﬂﬁgielﬁ tsur les images FITS

FITS- RGB Tmage [+WCS] =3

FITS-CUBE Cube d’images [+WCS] 23  <1024x512x512

FITS-RICE Compression image FITS F=3 frﬁzﬁgfﬂﬁ tsur les images FITS

FITS-GZIP Compression image FITS E frﬁzﬁgiﬂﬁ:ur les images FITS

ha . o Pré-standards et standard IVOA

HiPS image Relevé progressif image - (support tuiles FITS,JPEG,PNG)

PDS Image planétaire E Entéte incluse et sans compression
Prédécesseur de VOTable,

ASTRORES Catalogue EH (supporté pour compatibilité)
Standard IVOA totalement

VOTABLE Catalogue B supporté (base64, BINARY?2,

FITS, ...)
<1 million de sources

'“Sur la base d’une machine disposant d’1Gigaoctets de RAM
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TBL

HiPS catalogue
FITS-ST
FITS-SB

TSV

CSv

BSV
SEXTRACTOR
HiPS cube

MOC 1.0a 2.1

HEALPix map

MultiOrder skymap

MEF
Al
AJS

FoV

DS9 regions
IDL regions

IDHA

SIA, SIA2
SSA

TAP, ObsTAP,
EpnTAP

Datalink
GLU
properties

GZIP

Catalogue

Relevé progressif
catalogue

Catalogue
Catalogue

Catalogue

Catalogue

Catalogue

Catalogue

Relevé progressif cube
Couverture (spatiale et
temporelle)

Carte céleste

Carte céleste de
probabilité
Données multiples
Pile Aladin

Script Aladin

Champ de vue

Surcharges graphiques
Surcharges graphiques

Liste d’images

Liste d’images [+WCS]
Liste de spectres

Résultat interrogation
Base de données VO

Liste de liens

Liste descriptions
serveurs

Liste descriptions
collections

Compression

DOCORMCCD OE ECEODCOCCED

Format IPAC
<1 million de sources

Standard IVOA (tuile TSV)

Table FITS en ASCII

<1 million de sources

Table FITS en binaire

<1 million de sources

“Tab separated value”

<1 million de sources
“Character separated value”
(tableurs classiques)

<1 million de sources

“Blank separated value”

<1 million de sources

Format par défaut de S-extractor
Pré-standards et standard IVOA
(tuile FITS,JPEG,PNG)

Standard IVOA + support JSON

FITS MFITS dédiés aux maps
HEALPix (support RING &
NESTED)

FITS MFITS dédies aux cartes de
probabilité (VIRGO/LIGO)

FITS multiples extensions
Sauvegarde de la pile

Fichier de commandes scripts
Description de champs de vue
instrumental (note IVOA)
Surcharges graphiques a la DS9
Surcharges graphiques a la IDL
Concurrent de SIA, (supporté pour
compatibilité)

Standard IVOA

Standard IVOA

Standards IVOA (basé sur
VOTable)

Standards IVOA (basé sur
VOTable)

Format CDS

Extension format HiPS properties

Applicable sur tous les autres
formats
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Aladin reconnait automatiquement la nature des données en se basant sur le contenu : I’extension
du nom de fichier ou la présence d’un « Content-type » pour un flux http n’ont pas d’incidence
sur la reconnaissance du fichier.

Exception : Le format 4JS (script Aladin) est une exception car sa nature ne peut étre reconnue
de facon automatique sans risque de confusion. Pour lever 1’ambiguité, Aladin se basera sur
I’extension de fichier « .ajs » et/ou sur la présence en premiere ligne du commentaire suivant :
«#AJS ».

8.2 Standard FITS et calibration astrométrique

Pour la calibration astrométrique, Aladin suit le standard FITS officiel : le premier pixel en bas a
gauche est numéroté (1,1) et la position céleste correspondante est centrée sur le pixel.
Concretement, la coordonnée en bas a gauche du premier pixel est donc (0.5,0.5).

A noter : IDL ne suit pas le standard FITS officiel, la coordonnée en bas a gauche du premier
pixel est (0,0).

Aladin reconnait plusieurs méthodes de calibrations : WCS standard, ancienne méthode DSS1,
... ainsi que la plupart des projections courantes.

8.3 Performances et contraintes techniques

Le développement d’Aladin suit deux regles :
1. Garantir la meilleure compatibilité possible avec le matériel et les systemes d’exploitation
existants ;
2. Offrir les meilleures performances possibles dans ce contexte.

Pour répondre a ces deux contraintes, Aladin tire le meilleur parti du langage de programmation
« Java ». Les applications « java » nécessitent la présence d’un « moteur java » installé sur votre
ordinateur. La plupart des systéemes d’exploitation ont déja un moteur java installé par défaut. Si
ce n'est pas le cas, il est possible de [D’installer gratuitement depuis le site
http://www.java.com/download.

Un compteur situé en bas a droite de la fenétre indique la quantité de mémoire utilisée par
Aladin. En maintenant la souris sur ce compteur, une mini fenétre détaille cette valeur et indique
le montant mémoire maximum exploitable. Cette limite dépend de la maniere dont la machine
java a été initialisée lors du démarrage d’Aladin. Pour accroitre cette valeur veuillez-vous référer
a la section correspondante dans le FAQ (http://aladin.cds.unistra.fr/java/FAQ.htx#huge).

| 138 selected sources, 1036 sources, 5 plans, 1 view, 10Ma used [1016ME available |

8.3.1 Gestion des images

Aladin sait gérer n’importe quelle taille d’images. Suivant votre configuration matérielle et la
mémoire allouée a la machine virtuelle Java, Aladin pourra choisir différentes stratégies plus ou
moins rapides :

» Pour les images de quelques mégaoctets, I’image est chargée totalement en mémoire ;
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» Pour les images de quelques centaines de mégaoctets, Aladin va utiliser un espace
disque pour économiser la mémoire vive. L’impact sur la fluidité de manipulation est
trés peu sensible ;

» Pour les images de plusieurs gigaoctets, Aladin mettra en ceuvre un accés en deux
temps : un premier affichage immédiat en basse résolution, puis lorsque le facteur de
zoom est compatible avec votre capacité mémoire, un deuxiéme affichage en haute
résolution pour la portion de 1’image visible. La méthode pour lire 1’image basse
résolution a été optimisée pour limiter les acces disques ce qui permet d’obtenir une
premiére vue en quelques secondes quel que soit la taille de I’image. Cette stratégie en
deux niveaux de résolution est plus contraignante (temps d’attente du chargement des
pixels hautes résolutions lors des déplacements) mais permet de manipuler n’importe
quelle taille d’image tant qu’elle peut étre stockée sur un disque dur.

» Pour les relevés progressifs (HiPS), Aladin ne charge que les tuiles nécessaires en
fonction du champ de vue. Ces tuiles sont sauvegardées dans un cache interne
($HOME/.aladin/Cache/HPX) afin de pouvoir étre rapidement rechargées si
nécessaire. I’affichage des tuiles est un compromis entre vitesse de tracé et limitation
des déformations. Le principe repose sur un découpage de chaque tuile a dessiner
dans la projection courante en autant de sous-éléments nécessaires pour éviter le
phénomeéne de cisaillement qui peut apparaitre si la tuile est particuliérement étirée
(tracé par approximation bilinéaire). Si le relevé progressif est visualisé en vraies
valeurs des pixels, Aladin ne charge pas pour autant celles-ci en mémoire vive, mais
travaille sur une copie interne de chaque tuile réduite a 256 niveaux. Au besoin, il ira
rechercher la valeur du pixel sous la souris directement dans le cache disque. Un
changement de la plage des valeurs des pixels entrainera un rechargement complet
depuis le cache des tuiles visualisées.

8.3.2 Gestion des catalogues

La manipulation des catalogues classiques se fait par un chargement complet en mémoire vive. Il
faut compter approximativement 300 octets par sources ce qui donne une limite autour de 1.5
million d’objets manipulables avec un ordinateur disposant de 1 Gigaoctet de RAM. En pratique
la limite se situe plutdt autour de 1 million d’objets afin de laisser de la mémoire vive pour les
images et pour les applications.

En revanche, dans le cas d’un HiPS catalogue, I’impact sur la mémoire vive est peu sensible
puisque Aladin ne visualisera que les tuiles dans le champ courant et a la résolution courante.
Tout comme pour les HiPS images, Aladin conservera les tuiles déja chargées dans un cache
interne afin de pouvoir les recharger rapidement si nécessaire.

8.3.3 Filtrage des collections via le MocServer

Aladin, a partir de sa version 10, offre un acces intégré a un trés grand nombre de collections de
données issues du CDS et des serveurs compatibles avec les protocoles de I’Observatoire Virtuel.
Cette fonctionnalité est notamment illustré par 1’arbre des collections et les outils associés
(sélection, filtrage, etc).

La librairie utilisée par Aladin pour I’acces, le stockage et la manipulation des propriétés et des
MOC de ces collections a été développée par le CDS. Elle est implantée, en premier lieu, sur un
serveur distant géré par le CDS nommeé MocServer
(http://alasky.cds.unistra.fr/MocServer/query). Celui-ci prend en charge les filtrages spatiaux
basés sur les MOC. Ceux-ci représentent un trop gros volume (plusieurs Go de meta-données)
pour étre rapatriés sur le client Aladin. En revanche, 1'ensemble des propriétés des collections ne
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représente qu'un petit volume d'information (quelques Mo). Ainsi cette méme librairie est
également implantée dans le client Aladin qui a la charge du filtrage des propriétés. Ces deux
implémentations simultanées sont transparentes pour l'utilisateur (tant qu'il dispose d'un acces
internet). A noter qu'au démarrage Aladin va synchroniser les propriétés dont il dispose avec
celles du MocServer. Celles-ci sont conservées dans le cache local (SHOME/.aladin/Cache sous
la forme d'un fichier unique « Multiprop.bin ».
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9 Raccourcis clavier

Acces aux collections de données

Images

Bases de données
Catalogues et tables
Recherche d’une collection
Acceés aux fichiers locaux
Sélecteur de serveurs

Manipulation de la vue

Outils

Zoom avant

Zoom arriére

Zoom pointé
Glisser/déplacer la vue
Image suivante

1 vue

4 vues

9 vues

16 vues

Génération 1 vue par image
Copier la position du réticule
Uniformiser 1’échelle

Unif. I’échelle et 1’orientation
Nord vers le haut

Imprimer

Activation de la loupe
Activation de la grille de coord.
Activation de la grille HEALPix
Activation info sur image
Affichage constellations
Mesure de distances

Manipulation des plans

Propriétés
Affichage en-téte FITS

Manipulations des sources

Sélection de toutes les sources
Désélection
Chercher par expressions

Fenétres

Nouvelle fenétre Aladin
Ouvrir le controle des pixels

Ctrl+I

Ctrl+D
Ctrl+T
Ctrl+E
Ctrl+O
Ctrl+L

F2 ou molette souris
F3 ou molette souris
F4

Alt+Z

Tab

Maj+F1

Maj+F2

Maj+F3

Maj+F4

F9

Ctrl+W

Alt+S

Alt+Q

Alt+X

Ctrl+P
Ctrl+G
Alt+G
Alt+W
Alt+O
Alt+C
Alt+D

Alt+Entrée
Alt+H

Ctrl+A
Ctrl+U
Ctrl+F

Alt+N
Ctrl+M
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Autres

Fenétre de sauvegarde
Fenétre de I’historique
Console des commandes
Plein écran

Visualisation simple fenétre
Fin plein écran/simple fenétre

Copier

Coller

Sauvegarder

Supprimer la sélection

Tout supprimer

Aide des commandes scripts
Visite guidée

Ctrl+S
Ctrl+H
F5

F11
F12
Echap

Ctrl+C
Ctl+Vv
Crel+S
Suppr
Maj+Suprr
Ctrl+F5

F1
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Glossaire

ADQL

AJ
AITOFF

Langage dédié a I’interrogation de bases de données astronomiques, dérivé de SQL.
Standard de I’IVOA http://www.ivoa.net/documents/latest/ ADQL.html (voir TAP).
Format de fichier propre a Aladin pour sauvegarder la pile.

Projection géométrique représentant la totalité de la spheére sous forme d’une ellipse
aplatie.

ASTRORES Prédécesseur de VOTable (voir ci-dessous).

B1950
BITPIX
BSCALE
BZERO
Cache
CADC
CASSIS
CDS
(S)CS
DSS
DS9

ECL
ESAC

ESO
FITS

FK4
FK5
Gaia
GAL
GZIP
HCOMP
HDR

Référentiel spatial équatorial systéeme FK4, équinoxe 1950.

Codage propre au format FITS. Définit le mode de mémorisation d’une valeur de
pixel (voir ci-dessous) en spécifiant le nombre d’éléments binaire (bits) ainsi que la
représentation de la valeur (entiére ou réelle).

Facteur multiplicatif propre au format FITS permettant la conversion d’une valeur de
pixel stockée dans un fichier FITS en son équivalent physique.

Constante propre au format FITS permettant la conversion d’une valeur de pixel
stockée dans un fichier FITS en son équivalent physique.

Meécanisme de stockage sur le disque local des données consultées afin d’éviter leur
rechargement ultérieur.

(Canadian Astronomy Data Centre) Centre canadien de données astronomiques. Base
de données associée.

Logiciel de manipulation de spectres astronomiques. Développé par I’Institut de
Recherche en Astrophysique et Planétologie.

Centre de Données astronomiques de Strasbourg.

(Simple Cone Search) Protocole d’accés a une liste de sources astronomiques
localisées dans un cercle sur la sphere céleste. Standard de I'TVOA
http://www.ivoa.net/documents/latest/ConeSearch.html

(Digitized Sky Survey) Relevé céleste historique de référence, digitalisé a partir de
collections de plaques photos issues de télescopes Schmidt.

Logiciel de visualisation et de manipulation d’images astronomiques FITS.
Développé par le Smithsonian Astrophysical Observatory.

Référentiel spatial écliptique.

(European Space Astronomy Centre) Centre des données satellitaires de 1’agence
spatiale européenne (ESA).

(European Organisation for Astronomical Research in the Southern Hemisphere)
Organisation intergouvernementale pour l'astronomie en Europe.

(Flexible Image Transfert Support) Format de fichiers dédié au stockage d’images ou
de tables astronomiques.

Référentiel spatial équatorial. Précurseur de FK5 (voir B1950)

Référentiel spatial équatorial. Précurseur de ICRS (voir J2000)

Satellite européen de mesures astrométriques. Données associées.

Référentiel spatial galactique.

Format de compression de fichiers, générique et sans perte.

Format de compression d’images, avec perte.

(High Dynamic Resolution) Mode d’affichage d’Aladin pour la visualisation des
images astronomiques. Prend en compte la totalité des valeurs des pixels.

HEASARC (High Energy Astrophysics Science Archive Research Center) Centre de Données

NASA des données hautes énergies (voir SkyView).

HEALPix Systeme de découpage et d’indexation hiérarchique de la sphére en cellules de

surface égale. Notamment utilisé dans les relevés progressifs (HiPS) et les
couvertures (MOC).

115


http://www.ivoa.net/documents/latest/ConeSearch.html
http://www.ivoa.net/documents/latest/ADQL.html

HiPS

ICRS

IDL
J2000
Java
JRE
JVM

IVOA

JAXA
JPEG
MAST
MOC

(Hierarchical Progressive Survey) Infrastructure de stockage et de description d’une
collection de données localisées sur la sphere (image, cube ou catalogue), permettant
un acces hiérarchique par tuilage HEALPix. Standard de I'TVOA :
http://ivoa.net/documents/HiPS

(International Celestial Reference System) Référentiel spatial équatorial couramment
utilisé depuis la mission Hipparcos (1997). Permet une localisation a la milliseconde
d’arc.

Logiciel commercial et langage associé de manipulation de données scientifiques.
Référentiel spatial équatorial. Systéme FK5 équinoxe 2000.

Langage de programmation, notamment utilisé pour écrire Aladin (voir JVM).

Voir JVM.

(Java Virtual Machine) Environnement logiciel permettant 1’exécution d’un
programme écrit en langage Java tel qu’Aladin.

(International Virtual Observatory Alliance) Instance internationale dont la principale
motivation est la production de standards d’interopérabilité dédiés aux données
astronomiques.

(Japan Aerospace Exploration Agency) Agence d'exploration aérospatiale japonaise.
Format d’images, généraliste, compressé avec perte, sans gestion de transparence.
(Mikulski Archive for Space Telescopes) Archive NASA de données astronomiques.
(Multi-Order Coverage map) Format de données et fichier associé. Décrit une
couverture spatiale, temporelle, ou mixte. Souvent utilisé pour décrire la couverture
d’une collection de données. MOC est un standard de ’'TVOA :
http://ivoa.net/documents/MOC

MocServer Serveur du CDS. Service d’annuaire de collections indexées spatialement et

temporellement.

NASA (National Aeronautics and Space Administration) Organisation gouvernementale
chargée des programmes spatiaux des Etats-Unis.

NED (NASA/IPAC Extragalactic Database) Base de données NASA d’objets
astronomiques. Référence mondiale.

ov (Observatoire Virtuel) voir IVOA.

Pixel Plus petit élément d’une image, généralement carré, codant la couleur ou le niveau de
mesure correspondant a son emplacement.

PMRA,PMDEC Valeurs caractérisant le mouvement propre d’un objet astronomique sur la
voute céleste. Variations en RA et en DEC.

PNG Format d’images, généraliste, compressé sans perte, supportant un canal de
transparence.

RA (Right Ascension) Premiere composante d’une coordonnée astronomique
correspondant a la longitude dans un référentiel équatorial. S’exprime en degrés
décimaux ou sexagésimaux (voir DEC).

RICE Format de compression d’images FITS, sans perte.

SAMP (Simple Application Message Protocol) Protocole régissant les interactions entre 2 ou
plusieurs applications compatibles. Standard de ’'TVOA :
http://ivoa.net/documents/SAMP

Sesame  Service et serveur du CDS. Dédié a la résolution de noms d’objets astronomiques en

coordonnées célestes.

Sexagésimale Représentation de coordonnées sphériques sous forme de deux triplets (heures,

SIA

Simbad

minutes, secondes) et (degrés, minutes, secondes) .

(Simple Image Access) Protocole d’acces a une liste d’images. Standard de ’IVOA
http://ivoa.net/documents/SIA

Service et base de données du CDS. Dédié aux objets astronomiques étudiés dans la
littérature scientifique. Référence mondiale (voir Sesame).
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SkyView
SDSS
SSA
TAP
TOPcat
TSV

[8]@3D)

VizieR
VO

VOADpp
VOTable

WCS

Service de génération d’images ’HEASARC.

(Sloan Digital Sky Survey) Relevé astronomique en proche infrarouge.

(Simple Spectra Access) Protocole d’acceés a une liste de spectres. Standard de
I’IVOA http://ivoa.net/documents/SSA

(Table Access Protocol) Protocole d’interrogation d’une base de données. Standard de
I’IVOA http://ivoa.net/documents/TAP

Logiciel de référence pour la manipulation de tables astronomiques. Université de
Bristol.

(Tab Separated Value) Format de fichier ASCII dédié aux tables dont les éléments
sont séparés par une tabulation.

(Unified Content Descriptor) Caractéristique physique. Mot-clé issu d’une liste de
termes couvrant 1’ensemble des grandeurs physiques utilisées dans les catalogues
astronomiques. Généralement utilisé pour caractériser une colonne d’une table
astronomique. Standard de I’'TVOA :
http://www.ivoa.net/documents/latest/UCDIlist.html

Service et serveur du CDS. Base de données de catalogues astronomiques. Référence
mondiale.

(Virtual Observatory) voir IVOA.

Interface Java permettant d’interagir programmatiquement avec Aladin.

Format de fichier. Dédié au stockage et au transfert de tables de données et des méta
données associées (nom des colonnes, unités, UCD, liens, ...) codé sous forme XML.
Standard de I’IVOA : http://ivoa.net/documents/VOTable.

(World Coordinate System) Mécanisme de codage de la fonction de conversion de
coordonnées images X,Y en leur correspondance long,lat sur la sphere céleste.
Généralement stocké dans 1’entéte d’une image FITS.
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CDS/PIDSS2/color CDSIP/HSTIV CDS/P/skymapper-color

10.01°

xcatdb/PIXMM/PN/color CDS/PIGALEXGRE/AIS/color CDS/PHSTIB

10.01"

CDS/PIZMASS/color CDS/IPISPITZER/color

-
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